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Introduction1

The following sections provide details for this topic.

Welcome to your printer
This topic explains the concepts involved in this subject.

Your printer is a color inkjet printer designed for printing high-quality images on paper up to 610 mm (24 
in) or 1118 mm (44 in) wide. Some major features of the printer are shown below:

● Print resolution of up to 2400 ˟ 1200 optimized dpi, from a 1200 ˟ 1200 dpi input, using the Best 
print-quality option, the Maximum Detail option and photo paper

● The printer can be controlled from its front panel or from a remote computer using 
the Embedded Web Server, HP DesignJet Utility, or HP Click Printing Software (see 
http://www.hp.com/go/designjetclick).

● Touch-sensitive front panel in color, with an intuitive graphical user interface

● Job previews in the front panel

● Job previews on remote computers

● Includes Web-connected features such as automatic firmware updates, HP ePrint, and Mobile 
Printing

● Driverless printing: Files in common graphical formats can be printed directly without needing a 
printer driver. Just insert a USB flash drive or use HP Click Printing Software.

● Paper flexibility and automatic easy load, see Paper handling on page 27, with information and 
presets accessible from the front panel and the HP DesignJet Utility

● Handles cut-sheet and roll paper

● Six-ink system (Z6) or nine-ink system (Z9 +)

● Accurate and consistent color reproduction with automatic color calibration

● Economode for printing economically

● Two rolls loaded at once (Z6dr and Z9+dr only) provide fast and easy switching between different 
rolls, or long runs of unattended printing

● Maximize unattended printing and be more productive with the optional take-up reel on the 44-inch 
models.

● High productivity features such as job previewing and nesting using HP Click Printing Software

● Ink and paper usage information available from the Embedded Web Server, see Embedded Web 
Server on page 16

● Automatically trim your documents with the embedded vertical trimmer in the Z6dr and Z9+dr.
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● Access to the online HP Support Center (see HP Support Center on page 208)

Safety precautions
Read these safety precautions before using your printer. Also read your local Environmental, Health, and 
Safety regulations.

This equipment is not suitable for use in locations where children are likely to be present.

For any maintenance or part replacement, follow the instructions provided in HP documentation to 
minimize safety risks and to avoid damaging the printer.

General safety guidelines
There are no operator-serviceable parts inside the printer except those covered by HP's Customer Self 
Repair program. Refer servicing of other parts to qualified service personnel.

See http://www.hp.com/go/selfrepair

Turn off the printer and call your service representative in any of the following cases:

● The power cord or plug is damaged.

● The printer has been damaged by an impact.

● There is any mechanical or enclosure damage.

● Liquid has entered the printer.

● There is smoke or an unusual smell coming from the printer.

● The printer has been dropped.

● The printer is not operating normally.

Turn off the printer in either of the following cases:

● During a thunderstorm

● During a power failure

Take special care with zones marked with warning labels.

Ventilation measures for your location, whether office, copy room, or printer room, should meet local 
environmental health and safety (EHS) guidelines and regulations.

Electrical shock hazard
This topic explains the concepts involved in this subject.

WARNING! The internal circuits of the built-in power supplies and power inlet operate at hazardous 
voltages capable of causing death or serious personal injury.

Unplug the printer's power cord before servicing the printer.

The printer requires a building installation circuit breaker, which must meet the requirements of the 
printer and should be in accordance with the Electrical Code requirements of the local jurisdiction of the 
country in which the equipment is installed.
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To avoid the risk of electric shock:

● The printer should be connected to earthed mains outlets only.

● Avoid overloading the printer's electrical outlet with multiple devices.

● Do not remove or open any closed system covers or plugs.

● Do not insert objects through slots in the printer.

● Take care not to trip over the cables when walking behind the printer.

● Insert the power cord securely and completely into the wall socket and printer inlet.

● Never handle the power cord with wet hands.

Fire hazard
This topic explains the concepts involved in this subject.

To avoid the risk of fire, take the following precautions:

● The customer is responsible for meeting the printer's requirements and the Electrical Code 
requirements according to the local jurisdiction of the country where the printer is installed. Use 
the power supply voltage specified on the nameplate.

● Use only the power cord supplied by HP with the printer. Do not use a damaged power cord. Do not 
use the power cord with other products.

● Do not insert objects through slots in the printer.

● Take care not to spill liquid on the printer. After cleaning, make sure all components are dry before 
using the printer again.

● Do not use aerosol products that contain flammable gases inside or around the printer. Do not 
operate the printer in an explosive atmosphere.

● Do not block or cover the openings of the printer.

Mechanical hazard
This topic explains the concepts involved in this subject.

The printer has moving parts that could cause injury. To avoid personal injury, take the following 
precautions when working close to the printer.

● Keep your clothing and all parts of your body away from moving parts.

● Avoid wearing necklaces, bracelets, and other hanging objects.

● If your hair is long, try to secure it so that it will not fall into the printer.

● Take care that sleeves or gloves do not get caught in moving parts.

● Do not operate the printer with covers bypassed.

● If you need to replace the cutter assembly, take care not to cut yourself on the sharp cutting edge.

● Internal fan blades are hazardous moving parts. Disconnect the printer before servicing.
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● Never insert your hands into the printer while it is printing, due to the moving parts inside.

Heavy paper hazard
This topic explains the concepts involved in this subject.

Special care must be taken to avoid personal injury when handling heavy papers.

● Handling heavy paper rolls may require more than one person. Care must be taken to avoid back 
strain and/or injury.

● When handling heavy paper rolls, wear personal protective equipment, including boots and gloves.

● Follow your local Environmental Health and Safety regulations for handling heavy paper rolls.

Ink handling
HP recommends that you wear gloves when handling ink supplies.

Warnings and cautions
The following symbols are used in this manual to ensure the proper use of the printer and to prevent the 
printer from being damaged. Follow the instructions marked with these symbols.

WARNING! Failure to follow the guidelines marked with this symbol could result in serious personal 
injury or death.

CAUTION: Failure to follow the guidelines marked with this symbol could result in minor personal 
injury or damage to the printer.

Warning labels
This topic provides a full set of reference information for this subject.

Table 1-1 Warning Labels

Label Explanation

Electric shock hazard. Hazardous voltages inside the electrical 
box. Disconnect the power cord before servicing. Before 
starting, read and follow the operating and safety instructions.

Moving part. Keep your fingers and hands away from the 
moving paper system.
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Table 1-1 Warning Labels (continued)

Label Explanation

Moving fan blade. While servicing, keep your fingers and hands 
away from the blades.

Sharp edges. Avoid handling the cutting system.

When replacing the cutter assembly, handle with care and 
follow the safety instructions.

Risk of inlet damage. Maintain the end stoppers always 
assembled. Only disassemble if needed for printer relocation.

NOTE: The final label position and its size on the printer may vary slightly, but labels should always be 
visible and close to the potential risk area.

USA Safety for Products containing Button Cell or Coin Batteries

1. Remove and immediately recycle or dispose of used batteries according to local regulations and 
keep away from children. Do NOT dispose of batteries in household trash or incinerate.

2. Even used batteries may cause severe injury or death.

3. Call a local poison control center for treatment information.

4. Battery type CR2032 / DL2032.

5. 3VDC battery nominal voltage.
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6. Non-rechargeable batteries are not to be recharged.

7. Do not force discharge, recharge, disassemble, heat above 100ºC (212ºF) or incinerate. Doing so 
may result in injury due to venting, leakage or explosion resulting in chemical burns.

8. The product contains non-replaceable batteries.

Main components
The following front and rear views of the printer illustrate the main components.

Front view
The following steps provide the complete procedure for this topic.

1. Window

2. Printhead carriage

3. Printhead

4. Front panel
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5. Ink cartridge slot

6. Ink cartridge

7. Output platen

8. Paper alignment lines

9. Basket

10. Ink cartridge slot (Z9+ printers only)

11. Vertical trimmer (Z6dr and Z9+dr printers only)

Rear view
The following steps provide the complete procedure for this topic.

NOTE: This illustration shows the Z6dr/Z9+dr.

1. Gigabit Ethernet port

2. Communication port
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3. Power socket

4. Roll cover

5. Paper roll

NOTE: The upper roll is roll 1 and the lower roll is roll 2.

6. Spindle stop

7. Spindle

Rear view (Z9+ single roll)
The following steps provide the complete procedure for this topic.

NOTE: This model has an input tray in place of the second roll.

1. Gigabit Ethernet port

2. Communication port

3. Power socket
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4. Roll cover

5. Paper roll

6. Spindle stop

7. Spindle

8. Input tray

Communication ports
The following steps provide the complete procedure for this topic.

1. Power socket

2. Gigabit Ethernet port, to connect to a network

3. Communication port

4. Diagnostic LEDs, to be used by service engineers

The Hi-Speed USB host port is on the other side of the printer, beside the front panel.

Wall spacers (some models only)
If you place the printer close to a wall, ensure that there is some space between the printer and the wall. 
Otherwise, you may experience paper advance problems. If your model has wall spacers, lower them to 
ensure a minimum distance.
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Turn the printer on and off
This topic provides a full set of reference information for this subject.

TIP: The printer can be left powered on without wasting energy. Leaving it on improves response time 
and overall system reliability. When the printer has not been used for a certain period of time (the 
default time is determined by Energy Star), it saves power by going into sleep mode. However, any 
interaction with the printer's front-panel display, or sending a new job to print, returns it to active mode, 
and it can resume printing immediately. To change the sleep mode time, see Change system options on 
page 14.

NOTE: In sleep mode, the printer performs maintenance service to the printheads from time to time. 
This avoids long preparation times after long idle periods. Therefore, it is strongly recommended to 
leave the printer powered on or in sleep mode to avoid wasting ink and time.

If you want to turn the printer on or off or reset the printer, the normal and recommended method is to 
use the power key beside the front panel.
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However, if you plan to store the printer for a long period or the power key does not seem to work, you are 
recommended to unplug the power cord at the rear.

To turn it back on, plug in the power cord.

When the printer is powered back on, it takes about three minutes to initialize and check and prepare the 
printheads. Preparing the printheads takes about 75 seconds. However, if the printer has been off for six 
weeks or more, preparing the printheads could take up to 45 minutes.

Front panel
The front panel is a touch-sensitive screen with a graphical user interface, located on the front right of 
the printer.

It gives you complete control of your printer: from the front panel, you can view information about the 
printer, change printer settings, monitor printer status, and perform tasks such as supplies replacement 
and calibrations. The front panel displays alerts (warning and error messages) when necessary.
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It includes the following components:

1. A Hi-Speed USB host port, intended for connecting a USB flash drive, which can provide files to be 
printed. When a USB flash drive is inserted, a USB icon  is displayed on the front panel's 
all-apps page.

2. The front panel itself: a 4.3 inch, full-color, touch-sensitive screen with a graphical user interface.

3. The power key, with which you can turn the printer on or off, or wake up from sleep mode.

The front panel has a large central area to display dynamic information and icons.

Left fixed icons

● Tap  to return to the home page.

● Tap  to view help about the current page.

● Tap  to go back to the previous page. This does not discard any changes made to the current 
page.

Home pages

There are three top-level pages that you can move between by sliding your finger across the screen:

● The all-apps page displays a list of all apps available in your printer, and the status of each of them.

● If you swipe left to the widget page, you can see at a glance the status of ink and paper supplies.

12 Chapter 1  Introduction



● At the top of the all-apps page there is a dashboard that displays alerts related to the main 
functions of the printer. Swipe down the dashboard to access the Status Center.

Dim mode
After some time with no activity (5 minutes by default), the printer goes to dim mode, which reduces the 
brightness of the front panel by 25%. Any activity, such as the use of the front panel or the arrival of a 
print job, ends dim mode and restores normal brightness. After some time in dim mode (15 minutes by 
default), the printer changes to sleep mode. The time periods can be changed from the front panel.

Sleep mode
Sleep mode puts the printer into a reduced power state after a period of inactivity, turning off some 
elements to save energy. Printer features can be enabled from this mode, and the printer maintains 
network connectivity, waking up only as necessary.

The printer can be woken from sleep mode any of the following ways:

● By pressing the power button

● By opening a door

● By sending a print job

The printer wakes up in several seconds, more quickly than if it is completely turned off. While in sleep 
mode, the power button blinks.

To change the time that elapses before sleep mode, see Change system options on page 14.

Printer Monitoring (with the Print Spooler) and Remote Printer Management with the HP Utility and Web 
JetAdmin continue to be available during sleep mode. Some remote management tasks offer the option 
of remotely waking up the printer if needed to perform the task.
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Change the language of the front-panel display
There are two possible ways to change the language of the front-panel menus and messages.

● If you can understand the current front-panel display language, tap , then System > 

Language.

● If you cannot understand the current front-panel display language, start with the printer powered 
off. Press the power key to turn it on. When you see icons appear on the front panel, tap  and 

then . The front panel acknowledges this sequence by turning the icons on and off rapidly.

Whichever method you used, the language selection menu should now appear on the front-panel 
display. Tap your preferred language.

The available languages are English, Portuguese, Spanish, Catalan, French, Dutch, Italian, German, 
Polish, Russian, Simplified Chinese, Traditional Chinese, Korean, and Japanese.

Change system options
This topic explains the concepts involved in this subject.

You can change various printer system options from the front panel. Tap , then System.

● Date and time options to view or set the printer's date and time.

You can also change the date and time options in the Settings pane of the Embedded Web Server.

● Speaker volume to change the volume of the printer's loudspeaker. Select Off, Low, or High.

● Front panel brightness to change the brightness of the front-panel display. The default brightness is 
50.

● Power options > Printer sleep to change the length of time the printer waits before going into sleep 
mode (see Sleep mode on page 13). You can set the time from 5 to 240 minutes. The default time is 
20 minutes (total time including 5 minutes in dim mode).

You can also change the printer sleep option in the Settings pane of the Embedded Web Server.

● Power options > Auto-off due to inactivity to turn off the printer automatically after 120 minutes of 
inactivity.

● Unit selection to change the units of measurement in the front-panel display. Select English or 
Metric. By default, units are set to Metric.

● Restore factory settings to restore the printer settings to their original values as set in the factory. 
This option restores all of the printer settings except the administrator password and the paper 
presets.

● Language

● Firmware update to configure the automatic firmware update.
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HP Utility
The HP Utility enables you to manage your printer from a computer with a TCP/IP connection.

NOTE: The HP Utility under macOS and the HP DesignJet Utility under Windows have similar 
functions and are sometimes referred to collectively as the HP Utility in this guide.

You can install the HP Utility from http://www.hp.com/go/Z6/drivers (if you have a Z6) or 
http://www.hp.com/go/Z9/drivers (if you have a Z9+).

How to launch the HP Utility

● Under Windows, start the HP DesignJet Utility from the  icon on your taskbar or from the Start 
menu, then HP > HP DesignJet Utility. This launches the HP DesignJet Utility, showing the printers 
installed on your computer. When you open the HP DesignJet Utility for the first time, it may offer you 
an automatic update with enhanced functionality that we recommend you to accept.

● Under macOS, start the HP Utility from your Dock shortcut or by clicking Applications > HP > 
HP Utility. This launches the HP Utility, showing the printers installed on your computer.

When you select your printer in the left pane, everything that appears in the right pane is specific to 
that printer.

HP Print Preview
The HP Print Preview application enables you to see a basic preliminary preview of how your job will be 
printed.

This application is available only under Windows. You can install the HP Print Preview by downloading the 
integrated installer from http://www.hp.com/go/Z6/drivers or http://www.hp.com/go/Z9/drivers.
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Embedded Web Server
To use the Embedded Web Server on any computer, open your Web browser and enter the printer's IP 
address in the browser's address bar.

You can find your printer's IP address in the printer's front panel: tap  and then Network. See 

Configure your printer on page 17.

The following browsers are known to be compatible with the Embedded Web Server:

● Microsoft Internet Explorer 11 and later for Windows 7 and later

● Apple Safari 8 and later for OS X 10.10 and later

● Mozilla Firefox (latest version)

● Google Chrome (latest version)

NOTE: Your browser may display a security warning when you enter the IP address. If you have 
entered the correct address, it is safe to ignore the warning and continue to access the Embedded 
Web Server.

The Embedded Web Server window displays a menu used to access all the supported functionality. It 
supports the following languages: English, Portuguese, Spanish, Catalan, French, Dutch, Italian, German, 
Polish, Russian, Simplified Chinese, Traditional Chinese, Korean, Japanese. It uses the language that you 
specified in your Web browser options. If you specify a language that it cannot support, it is displayed in 
the language selected in the printer, or else in English.

To change the language, change your Web browser's language setting. To complete the change, close 
and reopen your Web browser.

Demo prints
The demo prints give various kinds of information about your printer. They can be requested from the 
front panel.

Before requesting a demo print, check that the printer and the paper are ready for printing.
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● The loaded paper should be at least A3 landscape—419 mm ( (16.53 in)) wide—otherwise the print 
may be clipped.

● The front panel should be displaying the Ready message.

To print a demo print, tap , then scroll down and tap Internal prints, then Demo prints, and select a 

print. The following prints are available:

● Render

● CAD black & white

● GIS

Configure your printer
The following sections provide details for this topic.

Connect the printer to your network
The printer is able to configure itself automatically for most networks, in a similar way to any computer in 
the same network. The first time you connect it to a network, this process may take a few minutes.

Once the printer has a working network configuration, you can check its network address from the front 

panel: tap .

TIP: Consider making a note of the printer's IP address, because you may need it during the setup 
process of connecting your Windows or macOS computer clients.

Modify network configuration
To modify the current network configuration, go to the front panel.

Tap  , then  , then Network > Gigabit Ethernet. From here it is possible, though not normally 

necessary, to change the settings manually; this can also be done remotely using the Embedded Web 
Server.

For full details of the available connectivity settings, see Networking on page 56.
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If you accidentally misconfigure the printer's network settings, you can restore the network settings to 

their factory values from the front panel: tap  , then Network > Restore factory settings. Then you 

must restart the printer. This automatically provides a working network configuration for most networks. 
The printer's other settings remain unchanged.

Install your printer under Windows
The following steps provide the complete procedure for this topic.

The following instructions apply if you intend to print from software applications using a printer driver. 
See Printing on page 65 for alternative ways of printing.

Before you begin, check your equipment:

● The printer should be set up and on.

● The Ethernet switch or router should be on and functioning correctly.

● The printer and the computer should be connected to the network (see Connect the printer to your 
network on page 17).

Now you can proceed to install the printer software and connect to your printer.

1. Make a note of the printer’s host name and IP address from the front panel (see Connect the printer 
to your network on page 17).

2. Install the printer software from http://www.hp.com/go/Z6/drivers (if you have a Z6) or 
http://www.hp.com/go/Z9/drivers (if you have a Z9+), following the software installation instructions. 
By default, the following driver is installed:

● The raster driver—best for CAD, GIS, and office applications

● With Windows 7 or Windows Server 2008R2: The PostScript driver

● With Windows 8, Windows Server 2012, or later: The PDF driver

3. Once downloaded, open it, and follow on-screen steps.

If your computer fails to find any printers on the network, the Printer Not Found window is displayed, 
which helps you to try to find your printer. If you have a firewall in operation; you may have to disable 
it temporarily in order to find the printer. You also have the options of searching for the printer by its 
hostname, IP address or MAC address.

Uninstall the printer software under Windows
Use the Control Panel to uninstall the software, in the same way as you can uninstall any other software.

Install your printer under macOS
The following steps provide the complete procedure for this topic.
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You can connect your printer to a network under macOS by using the following methods:

● Bonjour

● TCP/IP (important: select HP Jetdirect-Socket)

NOTE: The printer does not support AppleTalk.

The following instructions apply if you intend to print from software applications using a printer driver. 
See Printing on page 65 for alternative ways of printing.

Before you begin, check your equipment:

● The printer should be set up and on.

● The Ethernet switch or router should be on and functioning correctly.

● The printer and the computer should be connected to the network (see Connect the printer to your 
network on page 17).

Now you can proceed to install the printer software and connect to your printer.

1. Go to the front panel and tap , then Network, and note the IP address of your printer. If you 

intend to connect with Bonjour, click the network card and note the Bonjour name.

2. Install the printer software from http://www.hp.com/go/Z6/drivers (if you have a Z6) or 
http://www.hp.com/go/Z9/drivers (if you have a Z9+).

3. Select Windows or macOS software, and choose which specific software you want to install (by 
default, all of it).

NOTE: You can download HP Click with the other software.

4. Double-click the HP DesignJet Installer icon. You will be guided through the steps to install the HP 
software for your printer.

5. When the software has been installed, the HP Utility Setup Assistant starts automatically, to set up 
a connection to your printer.

6. In the Setup Assistant, look for your printer's Bonjour name or IP address (which you noted in step 1) 
in the table.

● If you find the right name, scroll sideways if necessary to see the Connection column, and 
check that it shows Bonjour. Then highlight that line. Otherwise, continue searching further 
down the list.

● If you cannot find your printer's name, just click Continue and do the setup manually. Access 
System Preferences, and in Printers and Scanners select the + sign at the bottom of the table. 
Then go to the IP tab, enter your IP address, and select the protocol HP Jetdirect-Socket.

Click Continue.

7. Follow the instructions on the screen.
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Uninstall the printer software under macOS
During the previous installation step, you have the option to install the HP Uninstaller application in your 
system. This should be available under HP in the system Applications folder.

IMPORTANT: The HP Uninstaller application will uninstall all HP Software installed in your system.

To delete the print queue only, select the Printers & Scanners dialog from the system preferences. Click 
the name of the printer and then click the – button.

Set up printer services
The following sections provide details for this topic.

You can set up the following services:

● Receive automatic firmware updates

● Enable email printing

● Participate in the Product Data Sharing Agreement

● Enable additional printer services

A network connection is required, so the printer will test its own connectivity. Remember to connect the 
network cable to the printer.

Each printer service can be enabled or disabled individually as explained below.

During initial printer setup, you are asked whether you want to enable additional printer services. That 

decision can be changed later by tapping , then , then Services > Printer Data Sharing 

Agreement.

If you are part of the HP Partner Link Pay-per-use service, you will have to participate in the Printer Data 

Sharing Agreement, if you have not done so already. Then tap , then Services  >  > Register 

new service in order to register the printer service.

The PrintOS service allows you to monitor the printer activity remotely and receive alerts in your mobile 
device, among other services. If you want to register, you will have to participate in the Printer Data 

Sharing Agreement, if you have not done so already. Then tap , then Services > PrintOS, and 

follow the steps shown on the front panel.

Verify printer connection to HP

You can check that the printer is able to connect to HP services by tapping  and viewing the 

status there. You can see detailed information by clicking the Network or Service card.
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If there is any problem connecting to HP, you will be provided with a description of the problem and some 
possible solutions.

Enable email printing with HP ePrint
The HP Connected service makes it easy to send jobs to your printer by attaching them to an email 
message.

You must accept the Printer Data Sharing Agreement in order to use HP Connected.

To configure the email printing configuration, tap , then Services. Scroll down until you find the HP 

ePrint card, which will display your printer’s email address, which can be used to send jobs to the printer. 
Double-click the HP ePrint card to access the printer's code and other configuration details.

If you are the printer administrator, log in at HP Connected (http://www.hpconnected.com) to customize 
your printer's email address or manage printer security for remote printing.

You must also visit http://www.hpconnected.com to register yourself and your printer (using the printer 
code).

Configure your HP ePrint connection

By default, the jobs sent by email are directly printed. To change the settings, tap , then  at the 

right top corner of the page, then Services > HP Connected > HP ePrint jobs > On hold.

You can disable the connection to HP ePrint if required for security. At the front panel, tap , 

then  at the right top corner of the page, then Services > HP Connected > HP ePrint connectivity > 
Disable.

Disable just puts the remote printing function on hold. If you want to resume using it, you just need to 
re-enable it in the same menu. No more setup steps are required.

If you want to disable remote printing permanently, tap Remove. To use remote printing again, you will 
need to set it up again from scratch.

Configure firmware updates
You can choose from the Embedded Web Server or from the front panel whether and how to download 
firmware updates.

NOTE: If an administrator password has been set, it will be required to change these settings.
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● In the Embedded Web Server: Click About printer > Firmware update.

● Using the front panel: Tap , then System > Firmware update.

The following settings are available:

● Download new firmware automatically: If you select Automatically (the default setting), the printer 
will automatically download new firmware whenever it becomes available. Deactivate this option to 
download new firmware manually.

NOTE: Downloading the firmware does not mean that you have installed it in your printer. To install 
the new firmware, you must confirm the installation manually.

Control access to the printer
The following sections provide details for this topic.

Manage printer security with HP Connected
When you have set up Web Services, the printer is in unlock mode. In unlock mode, anyone who knows 
your printer's email address can print to your printer just by sending a file to it. Although HP provides a 
spam filtering service, you should be careful about giving out your printer's email address, as everything 
sent to that address may be printed on your printer.

If you are the printer administrator, you can manage printer security or change your printer status 
to lock mode by visiting HP Connected at http://www.hpconnected.com. You can also customize your 
printer's email address and manage print jobs from there. At your first visit, you will need to create an 
account at HP Connected using the printer's code.

Embedded Web Server security settings
From the Embedded Web Server menu, you can click Security and then Administrator password to 
control access to the printer by specifying an administrator account to control access to the Embedded 
Web Server and the printer’s front panel.

The administrator can also define other types of permissions in the control panel through the Access 
control menu option. In this section, the administrator can create new printer user accounts and assign 
them specific permissions depending on their role.

Other security settings are available under the Security settings menu option, which apply to all users.

Front-panel security settings
This topic explains the concepts involved in this subject.

From the front panel, you can tap , then Security, to control some of the features of the printer:

● User sessions: Enable or disable automatic log-out after 1, 3, or 5 minutes.

● Embedded Web Server: Enable or disable the Embedded Web Server.

● Printing & management Web services: Enable or disable Web services that are used by printing and 
management tools such as the HP Utility, HP Click, and SDK for RIPs.
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If an administrator password has been set, it must be given in order to perform the following operations:

● Change the security settings (including the administrator password itself)

● Change the configuration of the Internet connection

● Change the Automatic Firmware Update configuration

● Enable or disable automatic downloading and/or installation of automatic firmware updates

● Restore an earlier firmware version

● Reset factory defaults

NOTE: The administrator password can contain only characters that appear on the front panel's on-
screen keyboard. If you set a new password with the Embedded Web Server, it will reject characters 
that do not appear in that limited character set.

Require account ID
If you want to keep records of printer usage by different users, you can set your printer to require an 

account ID for each job. At the front panel, tap , then Job management > Job queue > Account ID.

If this setting is turned on, the account ID field will be mandatory and jobs with no account ID will be kept 
"on hold for accounting".

The account ID can be set in the printer driver when sending the job. If the job is set "on hold for 
accounting" by the printer, you can introduce the account ID in the driver or front panel, by going to the 
job queue and clicking the job that is on hold. A window with a text box is displayed and you can enter the 
account ID into it.

Drivers
You may wish to install one or several drivers according to your needs.

There are various different drivers for your printer; which is best for you depends on your circumstances:

● Your operating system

● The type of applications from which you print

● The number of printers you have

● The output accessories you have

You can find the latest driver software at http://www.hp.com/go/Z6/drivers (if you have a Z6) or 
http://www.hp.com/go/Z9/drivers (if you have a Z9+).

Specific Windows drivers
This topic explains the concepts involved in this subject.
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The following drivers are recommended:

● The raster driver—best for CAD, GIS, and office applications

● The PostScript driver with Windows 7 or Windows Server 2008R2—best for photos, and applications 
that require accurate color

● The PDF driver with Windows 8, Windows Server 2012, or later—best for photos, and applications 
that require accurate color

HP DesignJet Universal Print Driver for Windows
The Universal Print Driver (UPD) is recommended if you have a fleet of HP DesignJet and PageWide XL 
printers: it facilitates installation and queue management.

HP Universal Print Driver configuration tool

The HP UPD configuration tool is a utility that allows you to personalize DesignJet and PageWide UPDs 
by modifying the default settings or locking some of them, preventing users from changing them. This 
tool is intended for IT administrators.

To install the tool, go to http://www.hp.com/go/Z6/support (if you have a Z6) or 
http://www.hp.com/go/Z9/support (if you have a Z9+) and click Software and drivers > Software – Utility > 
UPD configuration tool > Download.

For information about how to install and use the tool, go to 
https://support.hp.com/us-en/document/c05658213.

macOS drivers
This topic explains the concepts involved in this subject.

Raster driver

● Specifically for macOS 10.9, 10.10, 10.11, 10.12, and 10.13

● Best for CAD, GIS, and office applications

PostScript driver

● Specifically for macOS 10.9, 10.10, 10.11, 10:12, and 10.13

● Best for applications requiring accurate color

Set Windows driver preferences
You can change some default settings in your printer driver according to your own preferences, for 
instance to set color or paper-saving options. To do this, click the Start or Search button on your 
computer's screen (depending on your version of Windows), then click Devices and Settings or Devices 
and Printers. In the next window, right-click your printer's icon, and click Printing Preferences. Any 
settings you change in the Printing Preferences window will be saved as default values for the current 
user.

To set the default values for all users of your system, right-click the printer's icon, click Printer Properties, 
go to the Advanced tab, and click Printing Defaults. Any settings you change in the printing defaults will 
be saved for all users.
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Change the graphic language setting

You can change the graphic language setting from the front panel. Tap , then Default printing 

configuration > Graphics language.

Then select one of the following options:

● Select Automatic to let the printer determine which type of file it is receiving. This is the default 
setting; it works for most software applications. You should not normally need to change it.

● Select HP-GL/2 only if you are sending a file of that type directly to the printer, without going through 
a printer driver.

● Select PDF only if you are sending a file of that type directly to the printer, without going through a 
printer driver.

● Select PostScript only if you are sending a file of that type directly to the printer, without going 
through a printer driver.

● Select TIFF only if you are sending a file of that type directly to the printer, without going through a 
printer driver.

● Select JPEG only if you are sending a file of that type directly to the printer, without going through a 
printer driver.

Mobile printing
With HP Mobile Printing Solutions you can print straight from your smartphone or tablet in just a few 
simple steps wherever you are; using your mobile device OS or sending an email to your printer with PDF, 
TIFF, or JPEG attachments.

● Apple iOS printing is enabled through AirPrint, which comes pre-installed in iOS devices.

● For Android printing, install the HP Print Service App from Google Play. If you have have 
already installed it, check that it is up to date. You can obtain the latest version from 
https://play.google.com/store/apps/details?id=com.hp.android.printservice.

● You can also download the HP Smart App to enhance your printing capabilities from a smartphone 
or tablet.

– Latest iOS version from https://itunes.apple.com/app/id469284907

– Latest Android version from 
https://play.google.com/store/apps/details?id=com.hp.printercontrol

● To enable email printing, ensure that the service is enabled, and retrieve the printer's email address 
from the front panel.

For more detailed information, see http://www.hp.com/go/designjetmobility.

Accessibility
The following sections provide details for this topic.
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Front panel
If required, the front-panel display brightness and the loudspeaker volume can be changed.

See Change system options on page 14

Embedded Web Server
From the Embedded Web Server, you can see the status of the printer, and perform other actions 
without using the front panel.

For information about the accessibility features of the Embedded Web Server, click Support > 
Accessibility.

If your mouse is connected by USB, you can use the mouse wheel to enlarge the elements of the user 
interface.

See http://www.hp.com/hpinfo/abouthp/accessibility/ for information about the HP Accessibility 
Program, and HP's commitment to making its products and services accessible to people with 
disabilities.

Other sources of information
This topic explains the concepts involved in this subject.

The following documents can be downloaded from http://www.hp.com/go/Z6/manuals (if you have a Z6) 
or http://www.hp.com/go/Z9/manuals (if you have a Z9+):

● Introductory information

● User guide

● Legal information

● Limited warranty
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Paper handling2

The following sections provide details for this topic.

General advice
This topic provides a full set of reference information for this subject.

CAUTION: Before starting a paper loading process, ensure you have enough room around the printer, 
both in front and behind.

CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the 
printer from moving.
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CAUTION: All paper must be 280 mm (11 in) or longer. A4 and letter paper cannot be loaded in 
landscape orientation.

TIP: For photo paper wear cotton gloves to avoid transferring oils onto the paper.

CAUTION: Keep the basket closed throughout the loading process.

Load a roll onto the spindle
The following steps provide the complete procedure for this topic.

1. Open the roll cover.

2. Remove the black end of the spindle from the printer, then the blue end.

CAUTION: Be sure to remove the black end first. Removing the blue end first could damage the 
black end.

WARNING! Do not insert your fingers into the spindle supports during the removal process.
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3. The spindle has a stop at each end to keep the roll in position. The blue stop can be removed to 
mount a new roll; it slides along the spindle to hold rolls of different widths. Remove the blue paper 
stop from the end of the spindle.

NOTE: If the new roll core has a three-inch internal diameter, ensure that the core adapters have 
been installed. See .

4. If the roll is long; rest the spindle horizontally on a table and load the roll on the table.

TIP: You may need two people to handle a large roll.

5. Slide the new roll onto the spindle. Make sure the paper type is oriented as shown (the black stop 
shows the correct orientation of the paper). If it is not, remove the roll, turn it 180 degrees and slide 
it back on to the spindle. There are labels on the spindle showing the correct orientation.

NOTE: The illustrations show the printer as viewed from the front. However, if you load the paper 
while standing behind the printer, the blue stop is inserted into the right-side holder.
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Ensure that the end of the roll is as close to the spindle stop as possible.

6. Put the blue paper stop on to the open end of the spindle, and push it towards the end of the roll.

7. Ensure the blue paper stop is pushed in as far as it goes; until both ends are against the stoppers.
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If you are a regular user of different paper types, you can change rolls more quickly if you preload rolls of 
different paper types on different spindles. Extra spindles are available for purchase, see .

Load a roll into the printer
The following steps provide the complete procedure for this topic.

To start this procedure, you must have a roll loaded on the spindle. See .

TIP: If your printer accepts two rolls, do not try to open both roll covers at once; this may cause 
problems. Always close one cover before opening the other.

NOTE: The first three steps below are optional: you can start with step 4. However, in this case the 
printer will not keep track of the length of the roll, and will print no barcode on the roll when it is next 
unloaded. So you are recommended to follow all the steps, starting with step 1, unless you have turned 
off the Printing paper info option. See .

1. On the front panel, tap , then the roll icon, then Load.

If the roll you have selected is already loaded, you have to wait while it is automatically unloaded.

You should stand behind the printer when loading the lower roll (roll 2). You may stand behind or in 
front of the printer when loading the upper roll (roll 1).

CAUTION: If your height is less than 1.6 m (5 ft 3 in), loading a roll while standing in front of the 
printer may cause back pain or other physical problems.

2. Z6dr/Z9+dr only: If you start to load roll 1 while roll 2 is already loaded, roll 2 is withdrawn to the 
standby position, so that it can be printed on again without reloading whenever required.

NOTE: If at any time you open a roll cover while that roll is in the standby position, the roll is 
unloaded, and you will have to reload it the next time you want to print on it.

3. Open the roll cover, if it is not already open.

4. Rest the spindle's black end on the right roll holder (as seen from the front). Do not put the end 
completely into the roll holder.
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5. Rest the blue end of the spindle on the left roll holder.

6. With both hands, push the spindle into both roll holders at the same time.

7. If the edge of the roll is not straight or torn (sometimes due to tape used to hold end of the roll), pull 
the paper slightly and cut a straight edge.

8. Insert the edge of the paper into the printer.

WARNING! Do not push your fingers inside the printer's paper path.

TIP: When loading the upper roll, avoid inserting roll paper into the cut-sheet slot. If you do so, the 
printer beeps and the front panel asks you to remove the paper.
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9. Roll the paper into the printer until you feel resistance and the paper flexes slightly. When the 
printer detects the paper, it beeps, then feeds it in automatically.

10. If the leading edge of the paper has a barcode, the printer reads and then cuts off the barcode; you 
should remove and discard the cut strip of paper.

11. If the leading edge of the paper has no barcode, the front panel prompts you to select the paper 
category and type.

TIP: If you have loaded a paper type whose name does not appear in the paper list, see .

12. If the Printing paper info option is enabled, the front panel may ask you to specify the length of the 
roll. See .

13. The printer checks the alignment and measures the width, then the front panel prompts you to 
close the roll cover.

If the paper is not correctly aligned, the printer automatically proceeds to realign it.

NOTE: If you have an unexpected issue at any stage of the paper loading process, see .

Unload a roll
Before unloading a roll, check whether there is paper on the roll or if the roll is out of paper, and follow the 
appropriate procedure as described below.
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Quick procedure with paper on the roll
If there is paper on the roll, just open the roll cover, and the roll is unloaded automatically—unless the roll 
is uncuttable; in which case.

See .

NOTE: When the roll is unloaded in this way, no barcode is printed on it, so the printer will not know the 
length of the roll when it is next loaded. See .

NOTE: If you open the cover of any roll while a sheet is loaded, the sheet is also unloaded.

Front panel procedure with paper on the roll
The following steps provide the complete procedure for this topic.

If there is paper on the roll, you can unload it from the front panel.

1. Tap , then the roll icon, then Unload.

2. You may need to open the roll cover.

3. If the roll is uncuttable, see .

Roll out of paper procedure
If the end of the paper is no longer attached to the core, pull out the paper from the printer.

Pull from wherever the paper is accessible; the rear of the printer is recommended. You may need to 
open the roll cover.

Manual unload procedure
Paper types that cannot be cut by the automatic cutter must be unloaded manually:

1. Open the roll cover.

2. If necessary, rewind the paper by turning the spindle manually, until the paper is removed from the 
printer.

3. Close the roll cover.

Load a single sheet
Z9+ single-roll models have an input tray at the rear of the printer, and the front panel will recommend 
using this path to load the sheet. However, if you prefer, you can use the cut-sheet slot on the top of the 
printer. If there is no input tray, you must use the cut-sheet slot on the top.

Cut-sheet slot at the top
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Input tray at the rear

Using the cut-sheet slot at the top
The following steps provide the complete procedure for this topic.

1. Ensure that all roll covers are closed. If any cover is opened while a sheet is loaded, the sheet will be 
immediately unloaded.

2. On the front panel, tap  , then Sheet > Load.

3. Select your paper category and type.

TIP: If you have loaded a paper type whose name does not appear in the paper list, see Paper 
type is not in the driver, HP Utility, or front panel on page 162.

4. Z6dr/Z9+dr only: If a roll is already loaded, you have to wait while it is withdrawn to the standby 
position; it can be printed on again without reloading as soon as the sheet paper has been 
unloaded.

NOTE: On dual-roll models, if at any time you open a roll cover while that roll is in the standby 
position, the roll will be automatically unloaded, and you will have to reload it the next time you want 
to print on it.
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5. When prompted by the front panel, insert the sheet into the cut-sheet slot on the right-hand side of 
the printer. The side to be printed is facing us in the illustrations; it will be facing up within the printer.

6. Load your sheet aligned with the load line and insert it until the paper will not continue; with thicker 
sheets, you feel resistance.

WARNING! Do not push your fingers inside the printer's paper path.

7. Tap the OK key on the front panel to feed the paper into the printer. Guide the sheet into the printer; 
this is especially important with thicker papers.

8. The printer checks the alignment and measures the sheet.

NOTE: Depending on the length of the sheet, it feeds out the front of the printer.

9. If the sheet is not correctly aligned, you may be asked to reload it. Follow the instructions on the 
front-panel display.

NOTE: If you have an unexpected problem at any stage of the paper loading process, see Paper 
cannot be loaded successfully on page 160

Using the input tray at the rear (Z9+ single-roll models)
The following steps provide the complete procedure for this topic.

NOTE: If you have an unexpected problem at any stage of the paper loading process, see Paper 
cannot be loaded successfully on page 160.

1. Ensure that all roll covers are closed. If any cover is opened while a sheet is loaded, the sheet will be 
immediately unloaded.

2. On the front panel, tap , then Sheet > Load.
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3. Select your paper category and type.

TIP: If you have loaded a paper type whose name does not appear in the paper list, see Paper 
type is not in the driver, HP Utility, or front panel on page 162.

4. When prompted by the front panel, insert the sheet into the input tray at the rear of the printer. The 
side to be printed is facing us in the illustrations; it will be facing up within the printer.

5. Load your sheet aligned with the load line and insert it until the paper will not continue; with thicker 
sheets, you feel resistance.

WARNING! Do not push your fingers inside the printer's paper path.

6. Tap the OK key on the front panel to feed the paper into the printer. Guide the sheet into the printer; 
this is especially important with thicker papers.

7. The printer checks the alignment and measures the sheet.

NOTE: Depending on the length of the sheet, it feeds out the front of the printer.
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8. If the sheet is not correctly aligned, you may be asked to reload it. Follow the instructions on the 
front-panel display.

Unload a single sheet
To unload a single sheet after printing, you can simply pull the sheet free from the front of the printer.

To unload a sheet without printing, go to the front panel and tap , then the sheet card, then 

Unload.

The sheet unloads out of the front of the printer; either catch it manually or allow it to fall into the basket.

Sensitive-paper mode (Z6dr and Z9+dr only)
The printer’s sensitive-paper mode is designed to ensure the highest-quality prints on paper particularly 
vulnerable to deformations or scratches, such as film. By default, for some categories of vulnerable 
paper, the printer will ask whether you want to load it as sensitive paper.

If you want the printer to ask you every time you load a roll, go to the front panel and tap , then , 

then Paper source > Ask how to load.

When loading paper in sensitive-paper mode, the front panel guides you through a step-by-step process. 
At the end, you are asked to keep the roll cover open while sensitive-paper mode is active. Apart from 
that, you can print as usual.

CAUTION: Do not put your fingers into the printer's roll-paper input path and gear system.

NOTE: While it is active, it is indicated with an icon on the front panel’s paper information screen.

Notes

● Sensitive-paper mode remains active until the roll is unloaded. While it is active, it is indicated with 
an icon on the front panel’s paper information screen.

● When a roll is loaded or treated as sensitive paper, it cannot be parked by the printer. This means 
that no other paper will be available for printing as long as sensitive-paper mode is active. Thus, in 
this mode the printer works like a single-roll printer.

● If a second roll is loaded while sensitive-paper mode is active, the sensitive roll is automatically 
unloaded.
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View information about the paper

To view the loaded paper information, tap , then the roll icon.

The following information is displayed on the front panel:

● Paper type you have selected

● Roll or sheet status

● Width of the paper in millimeters (estimated)

● Length of the paper in millimeters (estimated)

● Calibration status

If no paper is loaded, the message Out of paper is displayed.

The same information is displayed in the HP DesignJet Utility for Windows (Overview tab > Supplies tab), 
the HP Utility for macOS (Information group: Printer Status > Supplies Status) and the Embedded Web 
Server (Paper tab > Paper Source, then click the card for the loaded paper to see the extra details of 
calibration and length).

Paper presets
Each supported paper type has its own characteristics. For optimum print quality, the printer changes 
the way it prints on each different paper type. For example, some may need more ink and some may 
require a longer drying time. So the printer must be given a description of the requirements of each 
paper type. This description is called the paper preset. The paper preset contains the ICC profile, which 
describes the color characteristics of the paper; it also contains information on other characteristics 
and requirements of the paper that are not directly related to color. Existing paper presets for your 
printer are already installed in the printer's software.

However, as it is inconvenient to scroll through a list of all paper types available, your printer contains 
paper presets only for the most commonly used paper types. If you have a paper type for which your 
printer has no preset, you cannot select that paper type in the front-panel display.

You can download additional paper presets from the Web and install them: see To install a downloaded 
paper preset on page 39.

To install a downloaded paper preset
The following steps provide the complete procedure for this topic.

1. After finding the right paper preset at https://hp.globalbmg.com/paperpresets, or the paper 
manufacturer's website, click the Download Now button and save the paper preset (an .oms file) on 
your computer.

NOTE: If you do not find the paper preset you want on the Web, you may find that it has been 
added to the latest firmware for your printer. You can check the firmware release notes for 
information, see Update the firmware on page 150.

2. Before starting to install the new preset, make sure that the printer is idle and the print queue is 
stopped. Installing a new paper preset will interrupt any printing that is in progress.
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3. Start the HP DesignJet Utility or the Embedded Web Server.

● In the HP DesignJet Utility for Windows, select the Color Center and then Import Paper Preset.

● In the HP Utility for macOS, select All Settings > Import Paper Preset.

● In the Embedded Web Server, click the Paper tab. In the Paper Management section, click the 
Paper preset tab.

4. On the Import page, select the paper preset file that you downloaded in step 1.

5. Click the Import button and wait for the update process to finish. It may take some time.

6. Check that the new paper type appears in the Additional paper or Custom paper category in your 
printer's front panel.

7. Synchronize the new paper type with the driver by opening the HP Utility. Select your printer, then 
Paper Preset Management  and Synchronize Paper Presets  (  button).

NOTE: This is possible only if you have installed the driver for your printer.

Now that you have imported the paper preset, you can select the paper type from the front panel and 
from the driver. The paper preset for the new paper type is ready to use by your application.

To create your own paper preset
Before using a custom paper type with your printer, you should add a paper preset for the new paper.

You can create a new paper preset using the Color Center in the HP Utility.

The paper preset name will appear in the printer driver and the front panel.

To create a paper preset, you can follow this simple procedure:

1. Go to the Color Center tab in the HP Utility for Windows, or to the Paper Preset Management group 
in the HP Utility for macOS.

2. Click Create Paper Preset under Windows, or the + icon under macOS.

3. Select a paper category from the drop-down menu. The paper category determines the amount of 
ink used and other basic printing parameters. For more information about the printing parameters, 
see Paper type is not in the driver, HP Utility, or front panel on page 162.

4. Enter your paper's name.

TIP: The paper's commercial name is likely to be the most understandable for other users of the 
printer.

5. Select the appropriate settings: drying time, horizontal cutter, and so on.

6. Click Next or Done under Windows (depending on your printer model), Continue under macOS.

7. You will find the paper name in the Custom paper category in the front panel and HP Utility. If you 
have a Z9+ printer, you will be prompted to profile the paper. See Create your own profile (Z9+ only) 
on page 97.

8. To profile your paper, go to the section "Profile management" of the Color Center in the HP Utility. 
Choose the ICC profile name.
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Now that you have created the paper preset, you will be able to select the paper type from the front 
panel and from the driver under the Custom paper category.

You can export the new paper preset to your computer and use it on other HP DesignJet Z series 
printers:

● Using the HP Utility: In the Color Center, click Paper Preset Management , select the paper preset, 
and click  at the bottom of the page. Then follow the instructions on the screen.

● Using the Embedded Web Server: From the Paper tab, click Paper Management > Export Paper 
Preset. Select a paper preset and click the Export button. A OMS package with the paper preset will 
be downloaded.

NOTE: This page shows only the custom paper presets that you can export.

To install the preset on another printer, see To install a downloaded paper preset on page 39.

Printing paper info
Enable the Printing paper info option to record the printer’s estimate of the remaining roll length, paper 
width and type. The information is a combination of barcode and text that is printed on the leading edge 
of the roll when the paper is unloaded from the printer.

NOTE: The paper-length estimate is available only if the printer registered the amount of paper that 
was on the roll when you loaded it. To provide this information to the printer, specify the roll length on 
the front panel when loading the paper, or load a roll that has the paper-data barcode printed on it.

NOTE: The barcode and text are printed on the roll only when the loading and unloading processes 
are started from the front panel's Paper menu.

NOTE: This option can be expected to work only with papers that are completely opaque: it may fail 
with transparent or translucent papers.

To enable the Printing paper info  option, go to the front panel and tap , then Paper source > 

Printing paper info > Enable.

NOTE: Enabling this option slightly changes the paper loading and unloading procedures.
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Move the paper
If the printer is idle (ready to print), you can move the paper forwards or backwards from the front panel. 
You may want to do this in order to have more or less white space between the last print and the next 
one.

To move the paper, tap , then Paper source > Move paper. Then tap the up arrow to advance the 

paper or the down arrow to rewind it.

Alternatively, if you have a Z9+ printer, you can move the paper by tapping the  icon on the home 

screen or in the status center.

Feed and cut the paper
This topic provides a full set of reference information for this subject.

There are two ways to feed and cut the paper from the front panel:

● Tap , then Paper source > Form feed and cut.

● In the Status Center, tap the  icon.

The printer then advances the paper and makes a straight cut across the front edge. There are several 
possible reasons why you might want to do this:

● To trim the leading edge of the paper if it is damaged or not straight.

● To feed and cut the paper when the automatic cutter has been disabled.

● To cancel the waiting time and print the available pages immediately, if the printer is waiting to nest 
more pages.

NOTE: The printheads are serviced after each print, and the paper cannot be cut until the process 
completes, so you may notice a delay.

NOTE: Some papers cannot be cut by the automatic cutter. In this case, the printer advances the 
paper without trying to cut it.

CAUTION: Remove the cut piece from the output tray. If strips or short prints are left in the output tray 
the printer could jam.
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NOTE: Photo and coated paper requires careful handling, see Print is scuffed or scratched on page 
181.

TIP: To move the paper without cutting it, see Move the paper on page 42.

Maintain paper
This topic explains the concepts involved in this subject.

To maintain paper quality, follow the recommendations below:

● Store rolls covered by another piece of paper or cloth

● Store cut sheets covered and clean or brush them before loading them in the printer

● Clean input and output platens

● Always keep the window of your printer closed

NOTE: Photo and coated paper requires careful handling, see Print is scuffed or scratched on page 
181.

Change the drying time
You may wish to change the drying time setting to suit special printing conditions such as multiple prints 
where time is of higher importance or when you need to be sure ink is dry before handling.

Tap , then Default printing configuration > Print retrieval > Drying time. You can select:

● Extended, to set a longer than recommended time to ensure ink is completely dry

● Optimal, to set the default and recommended time for your selected paper (this is the default 
setting)

● Reduced, to set a shorter than recommended time when quality is of lower importance
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● None, to disable the drying time and remove your print as soon as it finishes printing

CAUTION: If the ink is not dry when the print is removed it could leave ink in the output tray and marks 
on the print.

NOTE: If you cancel the drying time during a print, the printer may not feed and cut the paper right 
away due to the printhead maintenance, which runs in parallel. If the dry time is zero, the printer cuts 
the paper and then performs the printhead maintenance. However, if the dry time is greater than zero, 
the printer does not cut the paper until after the printhead maintenance has completed.

Turn the automatic horizontal cutter on and off

To turn the printer's horizontal cutter on or off, go to the front panel and tap , then Default printing 

configuration > Cutter > Horizontal cutter, and change the cutter option.

The default setting is On.

IMPORTANT: When printing with HP Click, enable and disable the setting on the front panel.

NOTE: If the cutter is turned off, it will not cut the paper between jobs, but it will continue to cut the 
paper on loading, unloading and switching between rolls.

TIP: To cut roll paper while the automatic cutter is disabled, see Feed and cut the paper on page 42.

Turn the automatic vertical trimmer on and off (Z6dr and Z9+dr 
only)

If you have a Z6dr or Z9+dr printer, it has an embedded vertical trimmer that cuts the left and right edges 
of the paper.

To turn the printer's vertical trimmer on or off, go to the front panel and tap , then Default printing 

configuration > Cutter > Vertical trimmer, and change the trimmer option.

The default setting is On.

IMPORTANT: When printing with HP Click, enable and disable the setting on the front panel.

Use the take-up reel
The take-up reel enables busy design professionals and print service providers to be more productive by 
maximising unattended printing—even overnight—and delivering neatly collected prints.

The take-up reel can collect paper in two ways: face in and face out.

Follow the assembly instructions to install the take-up reel assembly for use with the printer.
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The first time you use the take-up reel, activate it by tapping , then Output options , then , then 

Install accessory, then select Attach take-up reel on the take-up reel card.

NOTE: On some paper types, such as banners, the take-up reel will work better if you remove the 
Variable Front Tension Kit. The removal of the kit will improve the final shape of the roll and avoid empty 
spaces between the turns. See Paper types tested with the take-up reel on page 50.

Attach paper to the take-up reel
The following steps provide the complete procedure for this topic.

1. On the printer’s front panel, tap , then Output options, then select Attach on the take-up reel 

card. Choose the roll to be used.

Instructions are displayed on the front panel.

NOTE: If you decide to use the take-up reel during printing, familiarize yourself with the procedural 
steps before tapping the Enable button. Attaching the take-up reel during printing requires you to 
complete the procedure while the printer is feeding and printing paper. Attaching the take-up reel 
during printing saves approximately 1.5 m (4.9 ft) of paper.

TIP: You are recommended to keep the take-up reel winding-direction switch in the off position 
(see Unload the take-up reel on page 52) to avoid unwanted movements when attaching the take-
up reel while printing. Once you have the leading edge of the paper attached to the core, and the 
paper is straight, switch the winding-direction switch to position 1 or 2, as you prefer. Setting 1 winds 
the paper so that the printed image faces in, setting 2 winds the paper so that the printed image 
faces out.

The following steps assume that you have decided to attach immediately. If you decide to attach 
later, during printing, you must complete the same operations without guidance from the front 
panel.

2. Remove the tension bar.
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3. Unlock the take-up reel by pushing its lever to the highest position.

4. Remove the take-up reel.

5. Lift the lever to unlock the paper stop from the take-up reel and put it aside.

6. Slide the core onto the take-up reel. The core should be at least as wide as the paper.

7. Put the paper stop back onto the take-up reel, and lock it with the lever.
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8. Load the take-up reel into the printer by pushing firmly on both ends.

WARNING! Take care not to get your fingers trapped.

9. Ensure that the lever of the take-up reel is at the lowest position.

Attach paper to the take-up reel 47



10. Advance the paper by tapping the Advance/Rewind buttons on the front panel.

11. Pull down the center of the paper's leading edge to straighten the paper. Do not  attempt to pull 
more paper out of the printer.

NOTE: If you are attaching the take-up reel during  printing, you do not need to pull the paper taut. 
Tape the paper to the core when an adequate length of paper has fed from the printer after printing 
begins.

12. Adjust the position of the core on the take-up reel so that it is aligned with the paper.

13. Tape the leading edge of the paper to the core in the center, then at each side. Make sure that the 
paper is straight.

NOTE: Depending on whether you want to print the images facing in or out, place the tape 
accordingly.

14. Tap the button on the front panel to advance the paper, creating a loop.
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15. Press the blue up-arrow on the take-up reel motor to rotate the reel one full turn. This will help to 
support the weight of the tension bar.

16. Press the button to advance the paper again. The paper should advance until it almost touches the 
ground.

17. Carefully insert the tension bar. This is essential: the take-up reel will not function correctly without 
it.

18. Fit the tension bar into the supports at either side.

WARNING! Take care not to get your fingers trapped.
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19. Use the winding-direction switch on the take-up reel motor to select the winding direction. Setting 
1 winds the paper so that the printed image faces in. Setting 2 winds the paper so that the printed 
image faces out.

NOTE: You need to have taped the leading edge appropriately for the winding direction you intend 
to use. See step 13.

NOTE: Depending on the paper type, you may need to use the Variable Front Tension Kit.

With some papers, such as banners, the removal of the Variable Front Tension Kit will improve the 
final shape of the roll and avoid empty spaces between the turns.

20. Tap the Next icon on the front panel. The printer advances and calibrates the paper.

21. The following image shows how the printer looks when it is operating. As paper is fed from the 
printer, it drops down to the tension bar, over the diverter, then down again to the take-up reel.

NOTE: When the take-up reel is in use, the paper is not automatically cut after each print.

NOTE: If the take-up reel is loaded during printing, recalibrate the paper advance for optimal print 

quality. At the front panel, tap , then Paper advance calibration > Calibrate paper advance.

Paper types tested with the take-up reel
This topic provides a full set of reference information for this subject.
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Table 2-1 Paper types

Family Paper type Variable Front Tension Kit 
recommended?

Photo paper HP Premium Instant-dry Gloss Photo Paper No

HP Premium Instant-dry Satin Photo Paper No

HP Everyday Instant-dry Gloss Photo Paper No

HP Everyday Instant-dry Satin Photo Paper No

HP Universal Instant-dry Gloss Photo Paper No

HP Universal Instant-dry Satin Photo Paper No

HP Premium Matte Photo Paper No

HP Production Matte Poster Paper No

HP Production Satin Poster Paper No

Photo Gloss/Semi-Gloss/Satin Paper No

Photo Gloss/Semi-Gloss/Satin Paper (less ink) No

Photo Gloss/Semi-Gloss/Satin Paper (more ink) No

Photo Matte Paper No

Backlit material HP Premium Vivid Color Backlit Film No

Backlit Material No

Self-adhesive material HP Everyday Adhesive Matte Polypropylene No

HP Universal Adhesive Vinyl No

HP ColorFast Adhesive Vinyl No

HP Everyday Adhesive Gloss Polypropylene No

Adhesive Polypropylene Matte No

Banner and sign material HP Opaque Scrim Banner No

Scrim Banner No

HP Premium Matte Polypropylene No

HP Everyday Matte Polypropylene No

HP Durable Semi-gloss Display Film No

HP Durable Banner (w/o Tyvek) No

HP Durable Banner with Dupont Tyvek No
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Table 2-1 Paper types (continued)

Family Paper type Variable Front Tension Kit 
recommended?

Bond and coated paper HP Super Heavyweight Plus Matte Paper No

HP Universal Bond Paper Yes

HP Bright White Inkjet Paper Yes

HP Premium Bond (3 in core) Yes

HP Coated Paper Yes

HP Universal Heavyweight Coated Paper No

HP Heavyweight Coated Paper No

Plain Paper Yes

Coated Paper Yes

Heavyweight Coated Paper No

Super Heavyweight Coated Paper No

Fine art material HP Artist Matte Canvas No

HP Matte Litho-realistic Paper No

HP Professional Matte Canvas No

Canvas No

Canvas (less ink) No

Unload the take-up reel
The following steps provide the complete procedure for this topic.

WARNING! Take care not to get your fingers trapped.

1. On the printer's front panel, tap , then Output options > Take-up reel > Detach.

2. Switch the winding-direction switch to the off position. The switch is in the off position when it is 
centered (in other words, when the switch is neither in position 1 nor position 2).

3. Cut the paper: select Automatic or Manual on the front panel.

4. While holding the paper, use the winding button on the take-up reel motor to wind the remainder of 
the paper around the take-up reel.

5. Unlock the take-up reel by pushing its lever to the uppermost position.
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6. Remove the take-up reel from the printer.
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Working with two rolls (Z6dr/Z9+dr only)3

The following sections provide details for this topic.

Advantages of a multiroll printer
A multiroll printer can be useful in several different ways:

● The printer can automatically switch between different paper types according to your needs.

● The printer can automatically switch between different paper widths according to your needs. This 
enables you to save paper by printing smaller images on narrower paper.

● If you load two identical rolls into the printer, you can leave it printing unattended for a long time, 
because it can switch from one roll to the other automatically when the first is exhausted. See 
Unattended printing/overnight printing on page 81.

The current status of both rolls is shown on the front panel if you tap .

NOTE: Bear in mind that a protected roll is protected from use unless the roll number or its paper type 
are specifically requested. See Protect a paper type on page 81.

NOTE: If you use a paper not supported by your printer, you may find that automatic switching is 
disabled, in which case jobs sent to the standby roll are put on hold until the roll is manually unloaded.

NOTE: When you print from a USB flash drive, multiroll printing is considerably simplified: either you 
specify manually which roll you want to use, or you can select Save paper, in which case the printer 
chooses the narrowest roll on which the print will fit. You cannot specify the paper type.

How the printer allocates jobs to paper rolls
When you submit a print job from the printer driver, you can specify (using the Paper type or Type is 
option) that you want it to be printed on a particular paper type; you can even specify (using the Paper 
source, Source is or Paper Feed option) that you want it to be printed on a particular roll (1 or 2). The 
printer will try to satisfy these requirements, and it will also look for a paper roll large enough to print the 
image without clipping.

● If both rolls are suitable for the job, the roll will be chosen according to the roll switching policy. See 
Roll policies on page 89.

● If just one of the rolls is suitable for the job, it will be printed on that roll.

● If neither roll is suitable for the job, it will be put on hold for paper, or printed on an unsuitable roll, 
depending on the paper mismatch action. See Solve paper mismatch on page 89.

The printer driver for Windows will tell you which paper types and widths are currently loaded in the 
printer, and on which rolls.
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Here are some settings that may be used in typical situations.

NOTE: The Type is and Paper source settings are in the printer driver; the Roll switching policy is set in 
the front panel.

● With different paper types loaded:

– Type is: select the paper type you require

– Paper source: Use printer settings

– Roll switching policy: doesn't matter

● With different paper widths loaded:

– Type is: Use Printer Settings

– Paper source: Use printer settings

– Roll switching policy: Minimize paper waste

TIP: You can also save paper in some cases by rotating or nesting your images. See Use paper 
economically on page 77.

● With identical rolls loaded:

– Type is: Use Printer Settings

– Paper source: Use printer settings

– Roll switching policy: Minimize roll changes
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Networking4

The following sections provide details for this topic.

Introduction
The printer provides a single RJ-45 connector port for a network connection. In order to meet Class B 
limits, the use of shielded I/O cables is required.

The embedded Jetdirect print server supports connection to IEEE 802.3 10Base-T Ethernet, IEEE 
802.3u 100Base-TX Fast Ethernet and 802.3ab 1000Base-T Gigabit Ethernet compliant networks. When 
connected and powered on, the printer auto-negotiates with your network to operate with a link speed 
of 10, 100, or 1000 Mbps, and to communicate using full- or half-duplex mode. However, you can manually 
configure the link using the printer's front panel, or through other configuration tools once network 
communication is established.

The printer can support multiple network protocols simultaneously, including TCP/IPv4 and TCP/IPv6. For 
security, it includes features to control IP traffic to and from the printer and supports configuration of IP 
Security (IPsec) protocols.

Control network protocols
The printer can simultaneously support multiple network communication protocols. This allows network 
computers that may be using different protocols to communicate with the same printer.

Each protocol may require some configuration before the printer can communicate on the network. 
For some protocols, required parameters are automatically sensed and user-specified settings are not 
needed. However, for other protocols, there may be many parameters to configure.

Enable or disable network protocols
If a network protocol is enabled, the printer may actively transmit on the network even when there are 
no computers on the network that use the protocol. This may increase network traffic. To eliminate 
unnecessary traffic, you can disable unused protocols. Disabling unused protocols lets you:

● Reduce network traffic by eliminating broadcast messages from unused protocols

● Provide better control over who prints to the printer by eliminating users from other networks who 
might route print jobs to this printer

● Display protocol-specific error conditions for enabled protocols only

To disable unused protocols through the device’s control panel menu, see Front-panel menu items on 
page 57. For other tools, such as system command access to the embedded Telnet server, see the 
HP Jetdirect Print Server Administrator’s Guide  for your print server model.
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Front-panel menu items

To access the printer network configuration settings, go to the front panel and tap , then , then 

Network > Gigabit Ethernet > Modify Configuration.

Table 4-1 Front-panel menu items

Menu item Sub-menu item Sub-menu item Values and description

Information Print Sec 
Report

- Yes: Prints a report.

No (default): Does not print a report.

TCP/IP Host Name - An alphanumeric string, up to 32 characters, used to identify the device. This name 
is listed on the HP Jetdirect configuration page. The default host name is NPIxxxxxx, 
where xxxxxx is the last six digits of the LAN hardware (MAC) address.

- IPv4 Settings Config Method Specifies the method that TCP/IPv4 parameters will be configured on the HP Jetdirect 
print server.

Bootp: Use BootP (Bootstrap Protocol) for automatic configuration from a BootP server.

DHCP (default): Use DHCP (Dynamic Host Configuration Protocol) for automatic 
configuration from a DHCPv4 server. If selected and a DHCP lease exists, DHCP 
Release and DHCP Renew menus are available to set DHCP lease options.

Auto IP: Use automatic link-local IPv4 addressing. An address in the form 169.254.x.x is 
assigned automatically.

Manual: Use the Manual Settings menu to configure TCP/IPv4 parameters.

- - DHCP Release This menu appears if Config Method was set to DHCP and a DHCP lease for the print 
server exists.

No (default): The current DHCP lease is saved.

Yes: The current DHCP lease and the leased IP address are released.

- - DHCP Renew This menu appears if Config Method was set to DHCP and a DHCP lease for the print 
server exists.

No (default): The print server does not request to renew the DHCP lease.

Yes: The print server requests to renew the current DHCP lease.

- - Manual 
Settings

(Available only if Config Method is set to Manual) Configure parameters directly from 
the printer control panel:

IP Address: The unique IP address of the printer (n.n.n.n).

Subnet Mask: The subnet mask for the printer (n.n.n.n).

Syslog Server: The IP address of the syslog server (n.n.n.n) used to receive and log 
syslog messages.

Default Gateway: The IP address (n.n.n.n) of the gateway or router used for 
communications with other networks.

Idle Timeout: The time period, in seconds, after which an idle TCP print data connection 
is closed (default is 270 seconds, 0 disables the timeout).
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Table 4-1 Front-panel menu items (continued)

Menu item Sub-menu item Sub-menu item Values and description

- - Default IP Specify the IP address to default to when the print server is unable to obtain an IP 
address from the network during a forced TCP/IP reconfiguration (for example, when 
manually configured to use BootP or DHCP).

Auto IP: A link-local IP address 169.254.x.x is set.

Legacy: The address 192.0.0.192 is set, consistent with older HP Jetdirect devices.

- - Primary DNS Specify the IP address (n.n.n.n) of a Primary DNS Server.

NOTE: This item appears only if Manual configuration is a higher priority than DHCP in 
the Config Preference table, configured through the embedded Web server.

- - Secondary 
DNS

Specify the IP address (n.n.n.n) of a Secondary Domain Name System (DNS) Server.

NOTE: This item appears only if Manual configuration is a higher priority than DHCP in 
the Config Preference table, configured through the embedded Web server.

- IPv6 Settings Enable Use this item to enable or disable IPv6 operation on the print server.

Off: IPv6 is disabled.

On: IPv6 is enabled.

- - Address Use this item to manually configure an IPv6 address.

Manual Settings: Use the Manual Settings menu to enable and manually configure a 
TCP/ IPv6 address.

Enable: Select this item and choose On to enable manual configuration, or Off to 
disable manual configuration.

Address: Use this item to type a 32 hexadecimal digit IPv6 node address that uses the 
colon hexadecimal syntax.

- - DHCPv6 Policy Router Specified: The stateful auto-configuration method to be used by the print server 
is determined by a router. The router specifies whether the print server obtains its 
address, its configuration information, or both from a DHCPv6 server.

Router Unavailable: If a router is not available, the print server should attempt to obtain 
its stateful configuration from a DHCPv6 server.

Always: Whether or not a router is available, the print server always attempts to obtain 
its stateful configuration from a DHCPv6 server.

- - Primary DNS Use this item to specify an IPv6 address for a primary DNS server that the print server 
should use.

NOTE: This item appears only if Manual configuration is a higher priority than DHCP in 
the Config Preference table, configured through the embedded Web server.

- - Secondary 
DNS

Use this item to specify an IPv6 address for a secondary DNS server that the print 
server should use.

NOTE: This item appears only if Manual configuration is a higher priority than DHCP in 
the Config Preference table, configured through the embedded Web server.
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Table 4-1 Front-panel menu items (continued)

Menu item Sub-menu item Sub-menu item Values and description

- Proxy Server - Specifies the proxy server to be used by embedded applications in the device. A proxy 
server is typically used by network clients for Internet access. It caches Web pages, 
and provides a degree of Internet security, for those clients.

To specify a proxy server, enter its IPv4 address or fully-qualified domain name. The 
name can be up to 255 octets.

For some networks, you may need to contact your Independent Service Provider (ISP) 
for the proxy server address.

Proxy Port - Type the port number used by the proxy server for client support. The port number 
identifies the port reserved for proxy activity on your network, and can be a value from 
0 to 65535.

Security Print Sec Page - Yes: Prints a page that contains the current IPsec security settings on the HP Jetdirect 
print server.

No (default): A security settings page is not printed.

Secure web - For configuration management, specify whether the embedded Web server will accept 
communications using HTTPS (Secure HTTP) only, or both HTTP and HTTPS.

HTTPS Required: For secure, encrypted communications, only HTTPS access is 
accepted. The print server will appear as a secure site.

HTTP/HTTPS Optional: Access using either HTTP or HTTPS is permitted.

NOTE: The factory default setting depends on the print server model.

IPSEC - Specify the IPsec or Firewall status on the print server.

Keep: IPsec/Firewall status remains the same as currently configured.

Disable: IPsec/Firewall operation on the print server is disabled.

802.1x - -

Enable Wipe - -

Reset Security - - Specify whether the current security settings on the print server will be saved or reset 
to factory defaults.

No (default): The current security settings are maintained.

Yes: Security settings are reset to factory defaults.
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Table 4-1 Front-panel menu items (continued)

Menu item Sub-menu item Sub-menu item Values and description

Link Speed - - The link speed and communication mode of the print server must match the network. 
The available settings depend on the device and installed print server. Select one of the 
following link configuration settings:

CAUTION: If you change the link setting, network communications with the print 
server and network device might be lost.

Auto (default): The print server uses auto-negotiation to configure itself with the 
highest link speed and communication mode allowed. If auto-negotiation fails, either 
100TX HALF or 10TX HALF is set depending on the detected link speed of the hub/
switch port. (A 1000T half-duplex selection is not supported.)

10T Half: 10 Mbps, half-duplex operation.

10T Full: 10 Mbps, Full-duplex operation.

100TX Half: 100 Mbps, half-duplex operation.

100TX Full: 100 Mbps, full-duplex operation.

100TX Auto: Limits auto-negotiation to a maximum link speed of 100 Mbps.

1000TX Full: 1000 Mbps, full-duplex operation.

Link configuration methods
The printer supports 10, 100, or 1000 Mbps network link speeds using full-duplex or half-duplex 
communication modes (a 1000T half-duplex selection is not supported). By default, it will attempt to 
auto-negotiate its link operation with the network.

When connecting to network hubs and switches that do not support auto-negotiation, the printer will 
configure itself for 10 Mbps or 100 Mbps half-duplex operation. For example, when connected to a non-
negotiating 10 Mbps hub, the print server will automatically set itself to operate at 10 Mbps half-duplex.

If the printer is not able to connect to the network through auto-negotiation, you can set the link setting 
by one of the following methods:

● The front panel

● The Embedded Web Server

● The Telnet interface, through a system command prompt

● A TFTP (Trivial File Transfer Protocol) configuration file that is downloaded, for example, from a BootP 
or DHCP server

● Network management tools such as HP Web Jetadmin

Troubleshooting

IO Configuration card
To verify correct operation:
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The IO Configuration card provides comprehensive print server status. The information provided is an 
important diagnostic tool, especially if network communication is not available. For a description of 
messages that may appear on the card, see the HP Jetdirect Print Servers Administrator’s Guide  for 
your print server model.

For detailed connectivity information, go to the Connectivity menu and click Network card or Services 
card to see all the information available.

The network card provides details about the network configuration and status. The services card 
provides information about the state of connections to HP services, such as HP ePrint.

1. On the network card, look for the status message I/O Card Ready.

2. If I/O Card Ready appears, the print server is operating properly. Proceed to the next section.

If a message other than I/O Card Ready appears, try the following:

a. Turn the printer off and then on again to re-initialize the print server.

b. Check that the status indicator lights (LEDs) are providing proper status.

See the HP Jetdirect Print Servers Administrator’s Guide  for your print server model to interpret and 
troubleshoot other messages.

Reset network parameters
If you accidentally misconfigured the printer’s network settings, they can be reset to factory default 

values by tapping , then , then Network > Restore connectivity factory settings.

CAUTION: A factory-installed HP Jetdirect X.509 certificate will be saved during reset to factory 
default values. However, a Certificate Authority (CA) certificate that has been installed by the user to 
validate a network authentication server will not be saved.

Link troubleshooting
The printer has status lights (LEDs) beside the network connector that indicate the link status and 
network activity.

● When the green light is on, the printer has successfully linked to the network.

● When the yellow light is blinking, there is network transmission activity.

If the printer does not successfully connect to the network:

● Both LEDs will be off.

● The alert No network cable connected will appear on the front panel.

If a link failure is indicated, try the following:

1. Check the cable connections at both ends.

2. Consider replacing the cables by known good ones.

3. Consider switching to another network connector in the network switch, hub, or device to which the 
printer is connected.
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4. Manually configure the link setting to match the port configuration of the network hub or switch. For 
manual configuration methods, see . Turn the printer off, then on again, to re-initialize the setting.

5. Print a Connectivity Configuration page and check link settings.

Table 4-2 Connectivity configuration settings

Item Description

Port Config If the printer is properly linked, this item has one of the following values:

● 10BASE-T HALF: 10 Mbps, half-duplex

● 10BASE-T FULL: 10 Mbps, full-duplex

● 100TX-HALF: 100 Mbps, half-duplex

● 100TX-FULL: 100 Mbps, full-duplex

● 1000TX FULL

If the printer is not properly linked, one of the following messages will appear:

● UNKNOWN: The printer is in an initialization state.

● DISCONNECTED: A network connection has not been detected. Check network cables. 
Reconfigure the link settings, or restart the printer.

Auto Negotiation Indicates whether auto-negotiation for link configuration is on or off.

● ON (default): The printer will attempt to automatically configure itself onto the network at the 
proper speed and communication mode.

● OFF: You must manually configure the link speed and communication mode using the front 
panel. Your settings must match those of the network for proper operation.

6. In case of doubt or misconfiguration of link settings, reset the network parameters to their factory 
settings. See .

Communication failures between computer and printer
This topic explains the concepts involved in this subject.

Some symptoms are:

● The front-panel display does not show the Received jobs message when you have sent jobs to the 
printer.

● Your computer displays an error message when you are trying to print.

● Your computer or printer hangs (stays idle), while communication is taking place.

● Print jobs get stuck in your computer’s print spooler.

● Your printed output shows random or inexplicable errors (misplaced lines, partial graphics, and so 
on).

To solve a communication problem:

● Ensure that you have selected the correct printer when sending your job.

● Ensure that the printer works correctly when printing from other applications.
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● If your printer is connected to your computer through any other intermediate devices, such as 
switch boxes, buffer boxes, cable adapters, or cable converters, try using it when connected directly 
to your computer.

● Try another network cable.

● Remember that very large prints may take some time to receive, process and print.

● If your printer displays warning or error messages that require action, take the required action 
before trying to print.

Cannot access the Embedded Web Server
The following steps provide the complete procedure for this topic.

1. If you have not done so already, read .

2. Make sure that Embdedded Web Server functionality is enabled in the printer: from the front panel, 

tap , then Security > Connectivity > Embedded Web Server (EWS) > On.

3. Check the proxy configuration in your Web browser in case it is preventing communication with the 
printer.

4. Ensure that the printer works correctly when printing or accessed from other applications.

5. If the printer displays warning or error messages that require further action, take the action to 
resolve the problems.

6. If all else fails, turn the printer off and on again with the power key on the front panel.

Cannot access the printer from the HP Utility
The following steps provide the complete procedure for this topic.

1. If you have not done so already, read HP Utility on page 15.

2. Make sure your printer is not in sleep mode.

3. Make sure your printer driver is available and working correctly for the HP Utility in Windows.

4. From the front panel, tap , then Security > Web services > Printing & management, and make 

sure that it is enabled. If it is disabled, some parts of the HP Utility may not work properly.

Print jobs take too much time to be received by the printer
This topic explains the concepts involved in this subject.

If you send a very large print to the printer, there will normally be some delay before it starts printing. 
However, if you think you are experiencing abnormally long delays, there are various things you could 
check:

● Make sure the network cable connected to the printer is rated at least Cat5e.

● Make sure that gigabit-speed networking equipment and cabling interconnects your computer client 
to the printer.
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● Make sure that there are no network link issues. See .

● Take into account that, in network deployments with IPSec security protocols enabled and 
configured in the printer, network performance may be reduced due to the use of cryptographic 
algorithms to protect network communications.

● Try resetting the network configuration to its factory settings in order to get default settings that are 
suitable for most standard network environments. See .

● You may also find it helpful to test connecting the computer to the printer directly, using a normal 
Ethernet (Cat5e or Cat6) cable point-to-point, without passing through an Ethernet switch or router. 
In this configuration, the printer and the computer should both automatically change their IPv4 
addresses to the form 169.254.x.x . In this point-to-point configuration you can discard any issues 
caused by other network equipment.
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Printing5

The following sections provide details for this topic.

Introduction
This topic explains the concepts involved in this subject.

There are various different ways in which you can choose to print, depending on your circumstances and 
preferences:

● Print a TIFF, JPEG, HP-GL/2, RTL, PDF, or PostScript file directly from a USB flash drive. See Print from 
a USB flash drive on page 65.

● Print a TIFF, JPEG, HP-GL/2, or PDF file directly from a computer connected to the printer, using 
HP Click Printing Software. See http://www.hp.com/go/DesignJetclick.

● Print any kind of file from a computer connected to the printer, using a software application that 
can open the file, and a printer driver supplied with your printer. See Print from a computer using a 
printer driver on page 67.

● Print from a smartphone or tablet. See Mobile printing on page 83.

Print from a USB flash drive
The following steps provide the complete procedure for this topic.

1. Insert a USB flash drive containing one or more TIFF, JPEG, HP-GL/2, RTL, PDF, or PostScript files 
into the printer's USB port.

NOTE: The use of USB flash drives with your printer may be disabled by the administrator.
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2. At the front panel, go to the home page and tap .

You can tap folders to browse their contents. Files are shown as document thumbnails, and you can 
preview a file by tapping the preview icon. When the preview is displayed, you can zoom in and out. 

Files that cannot be printed are indicated with . For more details, tap the information button.

3. Select a file to be printed. Multipage documents are supported only in PDF files; in this case, you 
can also select a page to print.

4. The list of print-from-USB quicksets is displayed. You can choose and/or edit one of the quicksets 
for the selected job.

NOTE: If you edit a quickset after selecting a job, the changed settings are applied only to the 
current job and are not saved permanently. You can change any of your own quicksets permanently 

by tapping  on the quicksets page, or by tapping  , then Quicksets.

NOTE: The factory quicksets cannot be modified.

The following settings are available:

● Quickset name allows you to name the quickset you are working with.

● Output scale allows you to resize the print in two different ways: to a percentage of its original 
size, or to fit a particular paper size. The default is 100% (its original size).

● Print quality allows you to set the print quality to Fast, Normal, or Best.

● Color options allows you to choose color or grayscale.

● Paper source allows you to specify printing on roll 1 or roll 2, or you can choose Save paper, 
which automatically chooses the narrowest roll on which the print will fit (if two rolls are loaded).

● Paper category allows you to choose the type of paper.

● Page order allows you to choose first page on top, or last page on top.

● Collate allows you to turn collation on or off.

● Rotation allows you to rotate the print by any multiple of 90°, or you can choose Automatic, 
which rotates the print automatically if that will save paper.

● Alignment allows you to align the printer to the left, center, or right of the roll.

● Printer margins allows you to change the default printer margins.

● Storage mode offers two options, print and delete (the job is not retained in the job queue) and 
print and store (the job is retained in the job queue).

5. When you are satisfied with the quickset settings, tap OK to continue.

6. A page with the following settings appears: Copies, Page order, and Collate. You can check and 
change them in this step, regardless of the settings in the quickset. Tap Print to continue.
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7. After printing, you can choose to print another file or go to the job queue. If you print another file 
immediately without returning to the home page, the temporary settings used for the previous file 
are used again.

Print from a computer using a printer driver
This is the traditional way of printing from a computer.

The correct printer driver must be installed on the computer (see Install your printer under Windows on 
page 18 or Install your printer under macOS on page 18), and the computer must be connected to the 
printer.

When the printer driver has been installed and the computer is connected to the printer, you can print 
from a software application by using the application's own Print command and selecting the correct 
printer.

Advanced print settings
The rest of this chapter explains the various print settings that you can use when printing with a printer 
driver or the front panel. These methods offer a relatively large number of settings in order to satisfy all 
requirements.

TIP: In general you are recommended to use the default settings unless you know that they do not 
meet your requirements.

TIP: If you intend to reuse a particular group of settings repeatedly, you can save those settings under 
a name of your own choice and recall them later. A saved group of settings is known as a 'quick set' in 
the Windows printer driver, and as a 'preset' in the macOS printer driver.

Select print quality
The printer has various print-quality options because best-quality printing requires some loss of speed, 
while fast printing implies some reduction in print quality.

Therefore, the standard print-quality selector is a slider that allows you to choose between quality and 
speed. With some paper types, you can choose a compromise position between the two.

Alternatively, you can select from the custom options: Best, Normal and Fast. If you select Fast, you can 
also select Economode, which uses a lower rendering resolution and consumes less ink. It therefore 
increases printing speed even further, but reduces print quality. Economode can be selected only from 
the custom options (not from the slider).

There are supplementary custom options that may have an effect on print quality: Maximum detail and 
More passes. See High-quality printing on page 76.

You can select print-quality options in the following ways:

● In the Windows driver dialog: Go to the Paper/Quality or Paper tab (depending on the driver version) 
and look at the Print Quality section. If you are using Standard Options, you will see a simple slider 
with which you can select speed or quality. If you select Custom Options or Advanced (depending on 
the driver version), you will see the more specific options described above.

Windows driver V3
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Windows driver V4

68 Chapter 5  Printing



● In the macOS Print driver dialog: Go to the Paper/Quality panel and look at the Quality Options 
section. If you select Standard quality options, you will see a simple slider with which you can 
select speed or quality. If you select Custom quality options, you will see the more specific options 
described above.
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● Using the front panel: Tap , then Default printing configuration > Print quality.

NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the 
front panel.

NOTE: You cannot change the print quality of pages that the printer is already receiving or has 
already received (even if they have not started to print yet).

Select paper size
The paper size can be specified in the following ways.

NOTE: The paper size specified here should be the paper size in which the document was created. It 
is possible to rescale the document to a different size for printing. See Rescale a print on page 73.

● In the Windows driver dialog: Select the Paper/Quality or Paper tab (depending on the driver 
version), then select your paper size from the Document Size list.

● In the macOS Printer Setup dialog: Select your printer from the Print settings list, then select your 
paper size from the Paper Size list.

NOTE: If you are printing with the V4 driver and from Adobe Acrobat, the page size and 
orientation are determined by the application.

NOTE: If your application offers no Page Setup dialog, use the Print dialog.

● Using the front panel: tap , then Default printing configuration > Paper options > Paper size.

NOTE: If the paper size is set from your computer, it overrides the paper size setting in the front 
panel.

Custom paper sizes
If you want to choose a paper size that is not included in the list of standard paper sizes, there are 
various different ways to specify it.

Use the Windows printer driver (version 3)

The following steps provide the complete procedure for this topic.

1. Click the Paper/Quality tab.

2. Click Custom.

3. Enter the name and dimensions of your new paper size.

4. Click OK. The new paper size is automatically selected.

Use the Windows printer driver (version 4)

The following steps provide the complete procedure for this topic.

1. Click the Paper tab.
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2. Click Document size.

3. Enter the dimensions of your new paper size into the two fields in the custom area.

4. Click the arrow button.

A custom paper size created with the printer driver has the following characteristics:

● The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.

● The paper size is local to the printer queue. It will not be seen from other printer queues in the same 
computer.

● In Domain server networks, the paper size is local to the computer. It will not be seen from other 
computers sharing the printer queue.

● In Workgroup networks, the paper size will be shared among all the computers sharing the printer 
queue.

If the printer queue is deleted, the paper size is deleted with it.

Use Windows forms

The following steps provide the complete procedure for this topic.

1. From the Start menu, or from the Control Panel, select Printers and Faxes.

2. From the File menu, select Server Properties.

3. In the Forms tab, check the Create a new form box.

4. Enter the name and dimensions of your new paper size. Leave the margins as 0.00.

5. Click the Save Form button.

6. Go to the printer driver, and select the Paper/Quality or Paper tab (depending on the driver version).

7. Select More… from the drop-down list of paper sizes.

8. Select your new paper size from the group of Custom sizes.

A custom paper size created with the printer driver has the following characteristics:

● The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.

● Restricted users cannot create paper forms. The “manage documents” role in the Windows Active 
Directory is the minimum required.

● The paper size is local to the computer. It will be seen in all the printer queues that have been 
created on the computer and that support paper of that size.

● If a printer queue is shared, this paper size will appear in all the client computers.

● If a printer queue is shared from another computer, this paper size will not appear on the driver´s 
document size list. A Windows form in a shared queue needs to be created in the server.

If the printer queue is deleted, the paper size is deleted with it.

Use the macOS printer driver

The following steps provide the complete procedure for this topic.
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1. Go to the Page Setup dialog.

NOTE: If your application offers no Page Setup dialog, use the Print dialog.

2. Select Paper Size > Manage Custom Sizes.

Select margin options
This topic explains the concepts involved in this subject.

By default, the printer leaves a 5 mm margin between the edges of your image and the edges of the 
paper (increased to 17 mm at the foot of cut-sheet paper). However, you can change this behavior in 
several ways:

● In the Windows V3 driver dialog: Select the Paper/Quality tab, and click the Margins/Cutter Settings 
button. In the Layout and Margins window, you can see the options described below.

● In the Windows V4 driver dialog: Select the Layout tab. In the Layout Mode area, you can see the 
options described below.

If you want to change the default cutter options, select the Output tab, and click Roll options.

● In the macOS Print dialog: In the Margins/Layout panel, you can see the options described below. 
However, the available options depend on the paper size selected. For instance, for borderless 
printing you must select a paper size name that includes the word “borderless”.

● Using the front panel: Tap , then Default printing configuration > Margins, to see the options 

described below.

You will see at least some of the following options.

With margins

● Use application settings (drivers)/Use standard (front panel). Your image will be printed on a page of 
the size you have selected, with a narrow margin between the edges of the image and the edges of 
the paper. The image should be small enough to fit between the margins.

● Oversize. Your image will be printed on a page slightly larger than the size you have selected. If you 
cut off the margins, you will be left with a page of the size you selected, with no margins remaining 
between your image and the edges of the paper.

● Clip contents by margins. Your image will be printed on a page of the size you have selected, with a 
narrow margin between the edges of the image and the edges of the paper. In this case, if the image 
is the same size as the page, the printer assumes that the extreme edges of the image are either 
white or unimportant, and do not need to be printed. This may be useful when your image already 
contains a border.

Without margins

● Borderless. Your image will be printed on a page of the size you have selected, with no margins.

The image is slightly enlarged to ensure that no margin is left between the edges of the image and 
the edges of the paper.
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By default, the Horizontal cutter box is checked. Uncheck it if you want to cut the paper manually.

If you have a dual-roll printer, you can check the Vertical trimmer box to cut the right and left edges 
of the paper. See Print a borderless job using the vertical trimmer on page 128.

Table 5-1 Supported paper type for borderless printing

HP DesignJet Paper types

Z6, Z9+ Photo, polypropylene, and backlit roll paper

Z6dr, Z9+dr All, except adhesive and third-party canvas

Print on loaded paper
This topic explains the concepts involved in this subject.

To print a job on whichever paper is loaded in the printer, choose the following Paper Type option in your 
printer driver:

● In the Windows driver dialog: Select the Paper/Quality or Paper tab (depending on the driver 
version), then select Use Printer Settings in the Paper Type drop-down list.

● In the macOS Print dialog: Select the Paper/Quality panel, then select Any in the Paper Type drop-
down list.

NOTE: Use Printer Settings (Windows) or Any (macOS) is the default Paper Type selection.

Rescale a print
You can send an image to the printer at a certain size but tell the printer to rescale it to a different size 
(normally larger).

Rescaling a print may be useful:

● If your software does not support large formats

● If your file is too large for the printer's memory—in this case, you can reduce the paper size in your 
software and then scale it up again using the front-panel option

You can rescale an image in the following ways:

● In the Windows driver dialog: Go to the Layout/Output or Paper tab (depending on the driver version) 
and look at the Resizing Options section.

– The Actual size option leaves the size of the image unchanged.

– The Fit to option adjusts the image size to the paper size you have selected. For example, if you 
have selected ISO A2 as the paper size and you print an A3-sized image, it is enlarged to fit the 
A2 paper. If the ISO A4 paper size is selected, the printer reduces a larger image to fit the A4 
size.
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– The % of actual size or Scale % option (depending on the driver version) enlarges the printable 
area of the original paper size (the page minus the margins) by the percentage indicated, then 
adds the margins to create the output paper size.

● In the macOS Print dialog: Click Paper handling, check the box Scale to fit paper size, and select the 
paper size to which you want to scale the image. For example, if you have selected ISO A2 as the 
paper size and you print an A3-sized image, it is enlarged to fit the A2 paper. If the ISO A4 paper size 
is selected, the printer reduces a larger image to fit the A4 size.

● Using the front panel: Tap , then Default printing configuration > Paper options > Resize.

If you are printing to a single sheet, you must ensure that the image can actually fit onto the sheet, 
otherwise the image will be clipped.

Change the treatment of overlapping lines
This topic explains the concepts involved in this subject.

NOTE: This topic applies only when printing an HP-GL/2 job.

The merge option controls the overlapping lines in an image. There are two settings:

● Off: Where the lines cross, only the color of the top line is printed. This is the default setting.

● On: Where the lines cross, the colors of the two lines merge.

To turn merge on, go to the front panel and tap , then Default printing configuration > HP-GL/2 

options > Merge. You can set the merge option from your software in some applications. Settings in your 
software override the front-panel settings.

Preview a print
Previewing a print on the screen allows you to check the layout of the print before printing, which may 
help you to avoid wasting paper and ink on a bad print.

● To preview a print under Windows, you have the following options:

– Use the HP Print Preview application:
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Check the Show preview before printing box, which you can find in the right bottom corner of 
the driver dialog. Click Print, then wait a few seconds for the HP Print Preview application to be 
launched.

Check that the preview of the job is what you wanted. If so, click Print, otherwise click Cancel; 
you can readjust the driver settings before trying again.

NOTE: The Show preview before printing box appears in the driver dialog only if HP Print 
Preview is installed in your computer. See HP Print Preview on page 15.

– Use your application's print preview option.

● To preview a print under macOS, you have the following options:

– Use your application's print preview option.

– There is no Preview button at the bottom of the Print dialog box in the latest versions of macOS. 
A print preview is always shown at the upper left of the Print dialog box for most applications.

– Choose the HP Print Preview option from the PDF menu at the bottom of the Print dialog box. The 
print preview is displayed by a separate HP Print Preview application.

Print a draft
This topic explains the concepts involved in this subject.

You can specify fast draft-quality printing in the following ways:

● In the Windows driver dialog: Go to the Paper/Quality or Paper tab (depending on the driver version) 
and look at the Print Quality section. Move the print-quality slider to the extreme left ('Speed').

● In the macOS Print dialog: Go to the Paper/Quality panel, click Standard in the quality options, and 
move the print-quality slider to the extreme left ('Speed').

● Using the front panel: Tap , then Default printing configuration > Print quality > Select quality 

level > Fast.

You can specify even faster draft-quality printing by using Economode, as follows. This is intended mainly 
for documents containing only text and line drawings.

● In the Windows driver dialog: Go to the Paper/Quality or Paper tab (depending on the driver version) 
and look at the Print Quality section. Select Custom Options or Advanced (depending on the driver 
version), then set the quality level to Fast and check the Economode box.

● In the macOS Print dialog: Go to the Paper/Quality panel and set the quality options to Custom, then 
set quality to Fast and check the Economode box.

● Using the front panel: Tap , then Default printing configuration > Print quality > Enable 

economode.

NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front 
panel.
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High-quality printing
The following sections provide details for this topic.

You can specify high-quality printing in the following ways:

● In the Windows driver dialog: Go to the Paper/Quality or Paper tab (depending on the driver version) 
and look at the Print Quality section. Move the print-quality slider to the extreme right ('Quality').

● In the macOS Print dialog: Go to the Paper/Quality panel, click Standard in the quality options, and 
move the print-quality slider to the extreme right ('Quality').

● Using the front panel: Tap , then Default printing configuration > Quality level > Best.

NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front 
panel.

If you have a high-resolution image
If your image has a resolution greater than the rendering resolution (which you can see in the Custom 
Print Quality Options box under Windows), print sharpness may be improved by selecting the Maximum 
detail option. This option is available only if you are printing on glossy paper and you have selected Best 
print quality.

● In the driver dialog (macOS Print dialog): Select Custom instead of Standard print-quality options, 
then click Best and check the Maximum detail box.

● Using the front panel: Tap , then Default printing configuration > Print quality > Enable 

maximum detail.

NOTE: The Maximum detail option results in slower printing with photo papers, but it does not 
increase the amount of ink used.

Print in gray shades
You can convert all colors in your image to shades of gray.

See Printing in grayscale on page 102.

Print with crop lines
Crop lines indicate where the paper should be cut to reduce it to your selected page size. You can print 
crop lines with individual jobs in the following ways:

● In the Windows V3 driver dialog: Select the Paper/Quality tab, then click the Margins/Cutter Settings 
button. Check the Draw cutting lines box in the Layout and Margins window.

● In the Windows V4 driver dialog: Select the Output tab, then check the Crop lines box.

● In the macOS Print dialog: Select the Finishing panel, then Crop lines.
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Alternatively, you can choose to print crop lines with all jobs by default:

● Using the front panel: Tap , then Default printing configuration > Paper options > Enable crop 

lines > On.

To print crop lines with nested jobs (see Nest jobs to save roll paper on page 78), you must select a 
different option:

● Using the front panel: Tap , then Job management > Nesting options > Enable crop lines > On.

Use paper economically
This topic explains the concepts involved in this subject.

Here are some recommendations for making economical use of paper:

● If you are printing relatively small images or document pages, you can use nesting to print them side 
by side instead of one after another. See Nest jobs to save roll paper on page 78.

● You may be able to save some roll paper by using the following options:

– In the Windows driver dialog:

○ With a version 3 driver: Click the Paper/Quality tab, then the Margins/Cutter Settings button, 
then check the box Remove blank areas.

○ With a version 4 driver: Click the Output tab, then Roll options, then check the box Remove 
blank areas.

You can also select the Layout/Output or Layout tab (depending on the driver version) and then 
select one of the Rotation options.

– In the macOS Print dialog: Select the Finishing panel, then Remove Blank Areas and/or Rotate.

● If you check the print preview on your computer before printing, you can sometimes avoid wasting 
paper on prints containing obvious mistakes. See Preview a print on page 74.

● You can adjust how much paper is wasted between jobs from the front panel: Tap , then 

Output options > Cutters > Perform a clean cut after end of job. The following options are available:

– Disable cut: The printer will not perform a clean cut at the end of a job

– Large cut: Default on Z6 printers

– Minimum cut: Dual-roll models only—default on Z9 +dr printers

● You can further adjust how much paper wasted between jobs from the front panel: Tap , then 

Output options > Cutters > Reduce paper feed on clean cut.
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Nest jobs to save roll paper
Nesting means automatically printing images or document pages side by side on the paper, rather than 
one after the other. This is done to avoid wasting paper.

1. Direction of paper flow

2. Nesting off

3. Nesting on

4. Paper saved by nesting

When does the printer try to nest pages?
This topic explains the concepts involved in this subject.

When both of the following are true:

● The printer is loaded with roll paper, not sheet paper.

● The printer's Nest option is turned on. See How to turn nesting on and off on page 79.

What pages can be nested?
All pages can be nested, unless they are so large that two of them cannot fit side by side on the roll, or 
unless there are too many of them to fit into the remaining length of the roll. A single group of nested 
pages cannot be split between two rolls.

Which pages qualify for nesting?
This topic explains the concepts involved in this subject.

In order to be in the same nest, the individual pages must be compatible in all of the following ways:

● All pages must have the same print quality setting (Economode, Fast, Normal or Best).

● The Maximum Detail setting must be the same on all pages.

● The Layout/Margins setting must be the same for all pages.
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● The Mirror Image setting must be the same for all pages.

● The Rendering Intent must be the same for all pages.

● The Cutter setting must be the same for all pages.

● Pages must be all color, or all grayscale: not some in color and some in grayscale.

● All pages must be in one or other of the following two groups (the two groups cannot be mixed in the 
same nest):

– PCL3, RTL, TIFF, JPEG

– PostScript, PDF

● JPEG and TIFF pages with resolutions greater than 300 dpi may not nest with other pages in some 
cases.

How to turn nesting on and off
To turn nesting on or off, first make sure that the start of printing is set to After Processing.

See Select when to print a job on page 88. Then go to the front panel and tap , then Job 

management > Nest options > Enable nesting

You will see the following options:

● In order: Pages are nested in the order in which they are sent to the printer (this is the default option). 
The nested pages are printed as soon as one of three conditions is met:

– The next page will not fit on the same row as the other pages already nested.

– No page has been sent to the printer during the specified wait time.

– The next page is incompatible with the pages already nested (see Nest jobs to save roll paper 
on page 78).

● Optimized order: Pages are not necessarily nested in the order in which they are sent to the printer. 
When it receives an incompatible page, the printer holds it and waits for compatible pages to 
complete the nest. The nested pages are printed as soon as one of three conditions is met:

– The next page will not fit on the same row as the other pages already nested.

– No page has been sent to the printer during the specified wait time.

– The incompatible-page queue is full. The printer can queue up to six incompatible pages while 
nesting compatible pages. If it receives a seventh incompatible page, the nest is printed as it is.

● Off: nesting is disabled.

TIP: Optimized order uses the minimum amount of paper; however, it may take longer to print 
because the printer waits for compatible pages to arrive.

How long does the printer wait for another file?
So that the printer can make the best nest possible, it waits after a file has been received to check 
whether a subsequent page will nest with it or with pages already in the queue. This waiting period is the 
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nest wait time; the factory default nest wait time is 2 minutes. This means that the printer waits for up 
to 2 minutes after the last file is received before printing the final nest. You can change this waiting time 

from the printer's front panel: tap , then Job management > Nest options, and select the wait time. 

The available range is 1 to 99 minutes.

While the printer is waiting for nesting to time out, it displays the remaining time on the front panel, and in 
the Embedded Web Server’s Job queue tab.

Manage nesting in the Embedded Web Server
You can manage the nesting of your jobs in the Embedded Web Server’s Job queue tab.

The Up next box shows the jobs that are waiting in the queue; the Now printing box shows the job or jobs 
that are currently printing.

In between them is the nesting box: 

If you click the  icon in the nesting box, the jobs in the Up next box will be nested; and the nesting box 
will display a countdown to the time when they will start printing. You can adjust this time: see How long 
does the printer wait for another file? on page 79.

When the printer is printing nested jobs, the Now printing box has a Cancel button to cancel all the 
nested jobs that are currently printing.

Use ink economically
This topic explains the concepts involved in this subject.

Here are some recommendations for making economical use of ink:

● For draft prints, use plain paper and move the print-quality slider to the left end of the scale ('Speed'). 
For further economy, select custom print quality options, then select Fast and Economode.

● Clean the printheads only when needed, and clean only those printheads that need cleaning. 
Cleaning the printheads can be useful, but it uses a small amount of ink.

● Leave the printer permanently turned on so that it can maintain the printheads in good condition 
automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not 
done, the printer may need to use much more ink later to restore the health of the printheads.

● Wide prints make more efficient use of ink than narrow prints, because printhead maintenance uses 
some ink, and its frequency is related to the number of passes made by the printheads. Therefore, 
nesting jobs can save ink as well as saving paper (see Nest jobs to save roll paper on page 78).
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Protect a paper type
You can protect selected paper types to avoid printing on them unintentionally. A protected paper type 
will be printed on only when the paper type is explicitly specified in the job.

To protect a paper type, go to the front panel and tap , then Job management > Roll policies > 

Protected paper types, then select the paper type that you want to protect.

When a paper type is protected, the  icon appears before the paper name.

To print on a protected paper category, just select the paper type explicitly when submitting the job from 
a printer driver or other job submission software.

NOTE: If a protected paper type is not explicitly selected, and no other paper types are available, an 
out-of-paper message will appear.

Unattended printing/overnight printing
The printer is well suited to long, unattended print jobs, having multiple rolls plus robust and consistent 
image quality.

Here are some recommendations to help you deal with a long queue of printing jobs.

● If feasible, use brand-new long rolls of paper.

● If you want to print on partly-used rolls, you can check the paper type and the remaining length in the 
Embedded Web Server or in the front panel, to confirm that you have enough paper to print all your 
jobs.

NOTE: Information on the remaining length is available only if you told the printer the length of the 
roll when you loaded it, or if the printer read the length of the roll from the barcode printed on it.

● Load two rolls of paper suitable for your jobs. If the printer finishes one roll, it will automatically 
switch to the other.

● HP recommends the use of papers approved for your printer. See Accessories - HP DesignJet 
Z6/Z9+ on page 153.

● Check that you have paper wide enough to print all of your jobs. Any jobs that are too wide may 
be put on hold for paper if the paper mismatch action is set to Pause and ask (see Solve paper 
mismatch on page 89).

● Check the ink levels remaining in your ink cartridges.

● When you have submitted your print jobs, you can use the Embedded Web Server from a remote 
location to monitor their status.

● Drying time should be set to Optimal.

● Tap , then Job management > Roll policies > Use most depleted roll > On.

We recommend the following settings, depending on the paper type and what kind of prints you are 
making.
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Table 5-2 Recommended settings for unattended printing

Print type Print mode Maximum detail Drying time Paper types

Lines Normal Off Optimal Coated, Bond, Heavyweight 
Coated, Glossy

Lines and fills Normal Off Optimal Coated, Bond, Heavyweight 
Coated, Glossy

Maps Best Off Optimal Coated, Heavyweight Coated, 
Glossy

Renderings, photographs Best Off Optimal Coated, Heavyweight Coated, 
Glossy
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Mobile printing6

The following sections provide details for this topic.

Mobile printing
You can print to your printer from many mobile devices and from almost any location. There are two main 
methods of mobile printing:

● Direct printing by connection to the same network

● Printing by email

Your printer can be connected to the Web, providing various benefits:

● Automatic firmware updates (see Update the firmware on page 150)

● Print on HP printers from almost anywhere

● Print on HP printers from almost any device, including smartphones, tablets, and laptops

See http://www.hp.com/go/designjetmobility for more detailed information.

You can enable Web Services when setting up the printer: see Set up printer services on page 20 or the 
Assembly Instructions  for more information.

IMPORTANT: The printer must be connected to a network with Internet access: connect an Ethernet 
cable. See Connect the printer to your network on page 17.

Print from in-OS
The following sections provide details for this topic.

NOTE: Printing is available only from applications that implement printing or sharing facilities.

iOS (iPhone, iPad) with AirPrint
Printing with AirPrint is simple, all you have to do is make sure your device and printer are operating on 
the same network and follow the steps below:

1. Choose your content. Open the document or photo you want to print, tap the share button.

2. Select the print icon. Swipe the screen to reveal the print button at the bottom, then tap the print 
icon.

3. Confirm that the correct printer and print setting are selected. Tap Print and collect your printed 
documents.

Android with HP Print Service Plugin
Printing with an Android device is simple.
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Ensure that you have downloaded the HP Print Service Plugin from the Google Play store: 
https://play.google.com/store/apps/details?id=com.hp.android.printservice. Ensure that the plugin is 
updated to the latest version. Also ensure that your device and printer are operating on the same 
network, and follow the steps below:

1. Choose your content. Open the document or photo you want to print, tap the menu icon and select 
Print.

If the content type is a JPEG, PNG, or PDF file, you can alternatively tap the Share button and select 
the HP Print Service Plugin icon.

2. Choose your printer. Select from the list of printers that appears.

3. Confirm that the correct printer and print setting are selected. Tap Print and collect your printed 
documents.

Chrome OS with HP Print for Chrome
Printing from Chrome OS devices is as easy as installing the HP Print for Chrome extension from the 
Chrome Web Store.

https://chrome.google.com/webstore/detail/hp-print-for-chrome/cjanmonomjogheabiocdamfpknlpdehm.

Ensure that your device and printer are operating on the same network, and follow the steps below:

1. Choose your content. Open the document or photo you want to print, tap the menu icon and select 
Print.

2. Choose your printer. Select from the list of printers that appears.

3. Confirm that the correct printer and print setting are selected. Tap Print and collect your printed 
documents.

NOTE: Printing will be available only from applications that offer printing or sharing.

Print by email (HP ePrint)
This topic explains the concepts involved in this subject.

IMPORTANT: To enable email printing, see Enable email printing with HP ePrint on page 21.

If you can email it, you can print it. Simply attach a PDF or other print-ready file to an email message, and 
send it to your printer’s dedicated address.

In this way, you can print from anywhere with an Internet connection, without needing any printer driver. 
There are a few limitations that you should bear in mind:

● The attached files to be printed must be in PDF, JPEG, or TIFF formats.

● The maximum file size is 10 MB, but your email server may have a lower limit.

● Files are printed in the original document size (at 100% scale), in normal quality, in color, and 
normally in portrait orientation (some printers may offer autorotation).
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Print and share from the HP Smart App
Make sure your device and printer are operating on the same network, and follow the steps below:

Use the screen on your mobile device to control the printer and print. Print PDF files, photos, email 
attachments, and more from virtually anywhere.

Download the HP Smart App:

● For Android: https://play.google.com/store/apps/details?id=com.hp.printercontrol

● For iOS: https://itunes.apple.com/app/id469284907

1. Open the HP Smart App and select your printer.

2. Select whether you want to print documents or photos from your local device or link to your Google 
Drive, Dropbox, or Facebook accounts to access your content there.

3. Use the edit options to adjust quality, color and other settings, if there are any adjustments that you 
wish to make.

4. Tap Print and collect your printed documents.

Mobile specifications
This topic explains the concepts involved in this subject.

● Mobile devices must have an Internet connection and email capability.

● Print, scan, and copy control requires the mobile device and printer to be on the same network.

● Printing by email also requires the printer to be connected to the Internet.

● iOS 7.0 and above, or Android KitKat4.4 and above, is required.
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Job queue management7

The following sections provide details for this topic.

Job queue in the front panel
The print queue includes jobs that are being received, parsed, rendered, printed, already printed, and so 
on.

Tap  on the home screen to view the job queue on the front panel.

Tap the name of the job to see all the job details, including information about status, pages, copies, total, 
and preview.

In an active queue, the job you are printing appears in the middle of the queue, with printed jobs below 
and jobs to be printed above. You can scroll up and down. Once scrolled, the queue remains static and 
does not move automatically.

Jobs in the left pane are divided into four categories (Up next, Now printing, On hold, and History) in 
chronological order starting from the top. On hold is shown only when there are one or more jobs on 
hold. Below the job name, you can see its status:

Up next

● Waiting to process: The job has been received by the printer and is waiting to be rendered.

● Processing: The printer is parsing and rendering the job.
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● Waiting to print or Paused: The job is processed and waiting for the print engine to be ready to 
proceed with printing.

Now printing

The job is being printed.

● Paused: The job is paused.

NOTE: Sometimes, while printing, you may see a Self-servicing status, which means that the printer is 
performing some task such as paper type change or print mode change between pages of the same 
job.

On hold

The job will not be printed until you take some action. You should respond in one of the following ways:

● On hold: Private job: Enter the PIN required to print the job. The job will be deleted from the queue 
after printing.

● Oh hold: Personal job: The job is not automatically printed: you must select it from the queue. No 
details can be seen.

● On hold to preview: The job is not automatically printed: you must select it from the queue.

● On hold for paper mismatch: Load the paper required by the job.

● On hold for accounting: Enter an account ID to be used for the job.

● On hold: Recovered job: After a printer recovery, some jobs that were not printed are kept on hold.

History

● Printed: In chronological order, divided into today, yesterday, last week, and so on.

● Canceled: Canceled by the user.

● Failed: The job has failed for one or more reasons.

Job queue actions
Some of the actions in the job queue are determined by the settings selected. Some default settings 
may be worth changing, depending on your environment.

To do so, tap  in the home screen, then Job management . Alternatively, in the job queue app, 

tap  at the top right, then Settings.
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Pause the job queue

You can pause the job queue by tapping  and resume by tapping . The pause takes effect at 

the end of the page that is currently printing.

Reprint
In the History section, tap the job you want to reprint. On the details screen, tap the Printer button. On the 
next screen, you can select the number of copies, the source, and the destination.

Print next
If you want to change the position of a job in the queue to be printed immediately after the currently 
printing job, select the desired job and tap the Print next button.

Select when to print a job
This topic explains the concepts involved in this subject.

NOTE: The When To Start Printing options cannot be used with PostScript jobs.

You can select at what point you want to print a job in the queue. Tap , then Job management > 

When to start printing.

There are three options you can select:

● When After Processing is selected, the printer waits until the whole page has been processed and 
then it starts to print. This is the slowest setting but ensures the best print quality in large or complex 
prints.

● When Immediately is selected, the printer prints the page as it is processed. This is the quickest 
setting, but the printer may stop halfway through a print to process data. This setting is not 
recommended for complex images with dense color.

● When Optimized is selected (this is the default setting), the printer calculates the best time to begin 
printing the page. It is usually the best compromise between the After Processing and Immediately 
settings.

See job details
Tap the name of the job to show its details, including information about status, pages, copies, total, and 
preview. Scroll down as necessary to see all of the information.

By tapping the thumbnail, you can navigate over all pages of the job. Tap  to show or hide the toolbar. 
From there you can zoom in and out and see more information about each page.
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In an active queue, the job you are printing appears in the middle of the queue, with printed jobs below 
and jobs to be printed above.

Roll policies
If two rolls are loaded, both of which are suitable for the job, the roll is chosen according to your 
preferences.

At the front panel, tap , then , then .

Alternatively, tap , then Job management > Roll policies.

● Increase productivity: To increase the productivity of the printer.

– Job autorotation: The printer can rotate a job automatically in order to save paper.

● Automatic roll selection: When the job arrives with the roll not defined, the printer selects the rolls 
according to the following settings.

– Roll width selection: The printer can be more or less restrictive when selecting the roll width on 
which to print. You can select to print on the same width only (each page prints on a roll with 
same width as the page) or to print on the same width or wider (each page prints on roll with 
same width as the page or wider).

– Avoid printing on a wider roll: Avoid switching to a wider roll when the defined rolls are depleted. 
Only applies when Roll width selection is Print on same width or wider.

– Use most depleted roll (Z6dr/Z9+dr only): When there are two or more rolls with the same paper 
type and width, the roll selected is the roll with less paper.

– Paper type protection (Z6dr/Z9+dr only): You can avoid printing accidentally on special paper 
types by protecting them. Protected types are eligible for printing only when paper type or roll 
are specified in the job.

See also Protect a paper type on page 81.

Solve paper mismatch
If the paper currently loaded in the printer is not suitable for a particular job or page, the printer can 
automatically solve the conflict or give a number of choices depending on the printer policies.

Such a conflict may be caused by a job sent to the printer with no specific roll or paper type assigned to 
it, or by a roll coming to its end during printing. The following options are available in the paper mismatch 
settings menu; you can reach this menu from the job queue by tapping  , then  , then Mismatch 

actions  > Paper mismatch ; or by tapping  , then Job management > Mismatch actions > Paper 

mismatch.
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● Pause and ask (the most restrictive option): Printing stops until the correct paper is loaded. This 
option is recommended when the printer is attended. A message appears, asking what you want to 
do: cancel the job, print anyway, put on hold, or load paper. These options are also available in the job 
queue.

● Hold job and continue with next: Put mismatched jobs on hold until the correct paper is loaded, and 
continue printing the rest of the job queue. The printer sends an alert whenever a job is put on hold. 
This option is recommended when the printer is unattended, even though the integrity of a job may 
be disrupted, to avoid stopping the queue. Once the paper required for the job is loaded, the job or 
pages are automatically resumed.

● Print anyway (the least restrictive option): Print on whatever paper is loaded. The printer will choose 
the roll to print according to the following criteria: first where the page fits and then the same paper 
type. This option will never select a paper type that has been protected.

Solve output mismatch
This topic explains the concepts involved in this subject.

The selected output for a particular job is not available for some reason: output disconnected, detached, 
full, not empty for a job that requires it to be empty, or size/type/length not supported by that output. 
The following options are available in the paper mismatch settings menu; you can reach this menu 

by tapping , then , then Mismatch actions ; or by tapping , then Job management > 

Mismatch actions > Output mismatch.

● Pause and ask: Printing stops until the correct output is available. This option is recommended when 
the printer is attended. A message will appear asking what you want to do: cancel the job, print 
anyway, put on hold, or load paper.

● Hold job and continue with next: Put mismatched jobs on hold until the correct output is available, 
and continue printing the rest of the job queue. The printer sends an alert whenever a job is put on 
hold. This option is recommended when the printer is unattended, to avoid stopping the queue.

Job queue options

To change the job queue options, tap , then Job management > Job queue.

You can select the maximum number of printed jobs to have in the queue, when to delete printed jobs, 
and whether to delete jobs on hold after a specified time.
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Default printing preferences

At the front panel, tap , then Default Printing configuration to define the default properties of jobs 

sent to your printer from remote locations.

You can define settings in the following areas: Print quality, Color, Paper, Margins, HP-GL/2, PostScript, 
Print retrieval.

Job deletion
If the printer runs out of storage space for new jobs, the oldest printed jobs are automatically deleted 
from the queue.

You can request that printed jobs should be automatically deleted from the queue when the total 
number of printed jobs exceeds a specified limit (the maximum number in the history setting), or when 
the jobs were printed more than a specified time ago (clear history settings).

To delete jobs on hold, the setting Delete jobs on hold allows you to define the time after which these 
jobs will be removed (2–48 h).

To delete a job manually, select the job and tap Delete  in the  menu. To delete all jobs, tap Delete all 
jobs  in the  menu; the whole job queue will be deleted.

The Delete option deletes the job from the queue, while the Cancel option cancels the job but leaves it in 
the queue, marked as Canceled by the user in the history category.

To cancel a job while printing, tap X. To cancel a job from the Up Next category, tap the job name on the 
list and then tap Cancel job on the bottom right.

NOTE: If you tap X, you cancel the currently printing job only.

Job queue in the Embedded Web Server or HP DesignJet Utility
The HP DesignJet Utility provides a different way of accessing the Embedded Web Server's job 
management facilities, but the facilities are exactly the same whether you use the Embedded Web 
Server or the HP DesignJet Utility.

To see the queue in the Embedded Web Server, select the Main menu, then Job queue.

To see the queue in the HP Utility, select the printer, then Admin, then the Job Center.

Job queue page
By default, access to the job queue is open to all users. An administrator can set a password so that 
users are required to enter a password to access the page.

The job queue page shows all jobs that are available in the print queue. The print queue includes jobs 
that are being received, parsed, rendered, printed and already printed.

The Embedded Web Server displays the following information for each print job:

● File name: The name of the job

● Status: The current status of the job

● Pages: The number of pages in the job
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● Copies: The number of copies printed

● Total: The total number of pages (including copies)

● Sent by: The username

● Account ID: The account ID for the job

● Date: The date and time attached to the job that was received by the printer, shown in the locale of 
the Embedded Web Server

● File source: The application from which the job was sent to print

● Paper destination: The output option selected for the printed job

Jobs in the queue can be sorted by any of the information items (except Preview) by clicking on the title 
of the corresponding column. You can perform the following operations on one or all jobs in the queue:

● Cancel: Cancels the selected jobs. You are asked to confirm before the job is canceled. The job 
remains stored in the printer, but will not be printed unless you click Reprint.

● Hold: Holds the select jobs until you click Continue to print.

● Resume: All selected jobs, which are on hold, continue printing.

● Reprint: Prints more copies of a job.

● Next print: Sends all selected jobs to the top of the job queue.

● Print anyway: The printer will try to print the job even if there is some problem with it.

● Delete: Deletes selected jobs from the job queue. You are asked to confirm before the job is deleted.

Prioritize a job in the queue
You can select any job in the queue and make it the next one to be printed. After selecting the job, click 
Move to front.

If nesting is turned on, the prioritized job may still be nested with others. If you want this job to be printed 
next, without waiting to finish the nesting countdown, click the Start print button in the nesting section.

In the following cases, the Next print button is not displayed:

● The job is already at the front of the queue.

● The job is on hold—in this case the Resume printing button is displayed instead.

● The job has finished—in this case the Reprint button is displayed instead.

● The job has some error condition.

Delete a job from the queue
Under normal circumstances, there is no need to delete a job from the queue after printing it, as it will 
just fall off the end of the queue as more files are sent. However, if you have sent a file in error, and want 
to avoid printing it, you can simply select the job and then click Delete.

In the same way, you can delete a job that has not been printed yet.

If the job is currently being printed (its status is printing), you can click Cancel and then Delete.
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Reprint a job in the queue
To reprint an already-printed job, select the job from the queue, then click Reprint. When reprinting a print 
job, you cannot change the print settings, because the job has already been rasterized.

Job status messages
The following sections provide details for this topic.

These are the possible job status messages, approximately in the order in which they may be seen:

● Downloading: The printer is receiving the job from the computer.

● Processing: The printer is parsing and rendering the job.

● Waiting to print: The job is waiting for the print engine to become free to proceed with printing.

● Nested: The printer is set up with Nesting=On and is waiting for other jobs in order to complete the 
nest and proceed with printing.

● Preparing to print: The printer is performing writing system checks before printing the job.

● On hold for preview: The job was sent with the on hold for preview option.

NOTE: If the printer hangs up while printing a job, and the queue facility is turned on, the partially 
printed job will appear in the queue as on hold when the printer is next turned on. When you resume 
the job, it will start printing at the page at which it was interrupted.

● On hold for paper: The job cannot be printed because the right paper is not loaded in the printer. 
Load the required paper, see Paper handling on page 27, and click Continue to resume the job.

● On hold for accounting: The job cannot be printed because the printer requires all jobs to have an 
account ID: enter the account ID and then click Continue to resume the job.

TIP: To set an account ID, see Require account ID on page 23.

● Printing

● Drying

● Cutting paper

● Ejecting page

● Canceling: The job is being canceled, but will remain in the printer job queue.

● Deleting: The job is being deleted from the printer.

● Printed

● Canceled: The job has been canceled by the printer.

● Canceled by user

● Empty job: The job does not contain anything to print.

Reactivate a job on hold
When the printer puts a job on hold you receive an alert.
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See Alerts on page 206, which explains why the job is on hold. Follow the instructions on the screen to 
remove the hold and continue printing.

94 Chapter 7  Job queue management



Color management8

The following sections provide details for this topic.

Introduction
Color management is performed using a set of software tools that allow you to reproduce a color as 
accurately as possible on any display or printing device.

In addition, your printer has been engineered with advanced hardware and software features to ensure 
predictable and dependable results.

● Color calibration for consistent colors

● The Photo Black ink provides pure blacks when printing on photo papers

How colors are represented
Color is usually represented as an array of numbers: three numbers in the RGB color model or four in the 
CMYK color model. These numbers are a measure of the base colors used in a mixture to create a given 
color. RGB means that we are using a mixture of Red, Green, and Blue to create any specific color. In the 
case of CMYK, the mixture is of Cyan, Magenta, Yellow, and Key (where Key means black, for historical 
reasons).

Most monitors use the RGB color model, while most printers use the CMYK color model.

An image can be converted from one color model to another, but in general the conversion is not 
perfect. Your printer uses the RGB color model: the same color model that is used by your monitor.

This simplifies but does not completely solve the problem of matching colors. Each device represents 
colors a little differently from another device, even if they use the same color model. However, color 
management software can adjust the colors in an image according to the characteristics of the 
particular device, using a color profile of the device, in order to achieve correct colors.

A summary of the color management process
The following steps provide the complete procedure for this topic.

To get the accurate and consistent colors that you want, you should follow these steps for each paper 
type that you use.

1. Color-calibrate the paper type, for consistent colors. Calibration should be repeated every now and 
then (see Color calibration on page 96). In addition, you may wish to calibrate immediately before a 
particularly important print job for which color consistency is vital.

2. When printing, select the correct paper preset for the paper type you are using. The paper preset 
contains the color profile as well as various other characteristics of the paper. See Paper presets 
on page 39.
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Color calibration
The following steps provide the complete procedure for this topic.

Color calibration enables your printer to produce consistent colors with the particular printheads, inks 
and paper type that you are using, and under your particular environmental conditions. After color 
calibration, you can expect to get similar prints from any two different printers situated in different 
geographical locations.

Some paper types cannot be calibrated. For all other paper types, calibration should be done in any of 
the following circumstances:

● Whenever a printhead is replaced

● Whenever a new paper type is introduced that has not yet been calibrated with the current set of 
printheads

● Whenever the environmental conditions (temperature and humidity) change significantly

You can check the color calibration status of the currently loaded paper at any time by going to the 

front panel and tapping , then , then Color calibration status. The status may be one of the 

following:

● Recommended: The paper has not been calibrated.

NOTE: Whenever you update the printer's firmware, the color calibration status of all papers is 
reset to Recommended.

● Obsolete: The paper has been calibrated, but the calibration is now out of date because a printhead 
has been replaced, and should be repeated.

● Done: The paper has been calibrated, and the calibration is up to date.

● Disabled: This paper cannot be calibrated.

NOTE: Color calibration cannot be performed on plain paper, nor on any kind of transparent 
material.

You can start color calibration in the following ways:

● From the HP DesignJet Utility for Windows: Click Color Center > Calibrate paper, and choose the 
paper to be calibrated.

● From the HP Utility for macOS: Click Paper Preset Management, choose the paper to be calibrated, 
press the button, and click Calibrate paper.

● From the front panel: Tap , then Color calibration.

The calibration process is fully automatic and can be performed unattended after you have loaded 
paper of the type you wish to calibrate—which should be wider than 355 mm (14 in). If you have more than 
one roll loaded, the printer will ask which roll you want to use for the calibration.

The process takes about 10 minutes and consists of the following steps.
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1. A calibration chart is printed, which contains patches of each ink used in your printer.

Figure 8-1 Z6 example chart

Figure 8-2 Z9+ example chart

2. The chart is allowed to dry for a period of time that depends on the paper type, so that the colors 
have time to stabilize.

3. The chart is scanned and measured.

4. From the measurements, the printer calculates the necessary correction factors to apply for 
consistent color printing on that paper type. It also calculates the maximum amount of each ink 
that can be applied to the paper.

Color profiling
Color calibration provides consistent colors, but consistent colors are not necessarily accurate. For 
instance, if your printer prints all colors as black, its colors may be consistent but they are not accurate. 
In order to print accurate colors, it is necessary to convert the color values in your files to the color 
values that will produce the correct colors from your printer, your inks, and your paper. An ICC color 
profile is a description of a printer, ink, and paper combination that contains all the information needed 
for these color conversions.

Create your own profile (Z9+ only)
You can create a color profile easily using the HP Utility. The process takes about 15–20 minutes and 
consists of the following steps:
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1. Load paper into the printer: see Load a roll into the printer on page 31 or Load a single sheet on 
page 34. You will find the paper name in the paper or custom paper category in the front panel 
and the HP Utility. If you cannot find the paper name, you can create your own paper preset: see To 
create your own paper preset on page 40.

IMPORTANT: When loading the paper, make sure to select the correct paper type. Loading the 
paper with an incorrect paper type specified could cause errors in the profile.

NOTE: The paper must be calibrated before profiling.

2. Go to the HP Utility.

● Under Windows: Click Profile paper.

● Under macOS: click Paper management , then  at the bottom of the window, then Profile 
paper.

3. The printer asks you about the process to be used. Print target and ICC profile is the standard 
option and suitable for most cases.

If you would like to use a longer drying time, you can ask the HP Utility to create the chart without 
going on to create a profile (Windows: Print target only. Create ICC profile later; macOS: Print ICC 
profiling chart). Then, later, when the chart is completely dry, you can use the HP Utility’s Color 
Center to create a profile using the chart you have already created (Windows: Create ICC profile 
from a target that has already been printed; macOS: Scan ICC profiling chart and create ICC 
profile). In this case the spectrophotometer takes a while to warm up before it is ready to scan.

4. Enter the name of your new profile.

5. The HP Utility may prompt you to calibrate the paper.

6. A profiling chart is printed. Unlike a calibration chart, most of the patches contain combinations of 
more than one ink. The printer automatically chooses the profiling chart for the paper size loaded.

Figure 8-3 An A3 or B format for cut sheets
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Figure 8-4 A roll-paper format that minimizes paper use by printing across the full width of the roll

7. The chart is allowed to dry for a period of time that depends on the paper type, so that the colors 
have time to stabilize.

8. The chart is scanned, and measured by the HP Embedded Spectrophotometer.

9. From the measurements made by the spectrophotometer, the printer calculates the ICC profile for 
your printer, inks, and paper type.

10. The new ICC profile is stored in the following folder on your computer:

● C:\Windows\System32\spool\drivers\color (Windows)

● /Library/ColorSync/Profiles/HP DesignJet (macOS)

11. The profile is also stored in the printer, so that other computers connected to the same printer 
can copy it. The HP Utility will notify you if your printer has profiles that are not yet stored on your 
computer.

NOTE: Some applications may need to be closed and restarted in order to use a profile that has just 
been created.

Install a color profile
If you have obtained an ICC profile through other means than using the HP Utility, for instance from the 
Internet or from a third-party profiling software package, you can still install it for use with your printer 
and paper.

Windows procedure
The following steps provide the complete procedure for this topic.

1. Go to the Color Center in the HP Utility, and click Profile Management.

2. Select the paper type that you will use with the ICC profile, and click  at the bottom of the dialog 
box.

3. Select the file containing the ICC profile.

NOTE: ICC profile file names have the extension ".icc" (for International Color Consortium) or 
".icm" (for Image Color Matching).

4. Check the ICC profile name, then click Next.

5. The ICC profile is installed in your computer and will be available to use in your applications.

macOS procedure
The following steps provide the complete procedure for this topic.

1. Go to Paper Preset Management in the HP Utility and select the ICC profile to be installed.

2. Click  at the bottom of the window, then Install profile.
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3. Check the ICC profile name, then click Continue.

Export a color profile
An ICC profile associated with a paper type can be exported, enabling it to be used on a different printer 
or with a different paper preset..

Windows procedure
The following steps provide the complete procedure for this topic.

1. Go to the Color Center in the HP Printer Utility, and click Profile Management.

2. Select the paper type and the ICC profile to be exported, then click  at the bottom of the window.

3. Choose the pathname of the folder in which the ICC profile will be saved in your computer.

4. The ICC profile file is saved in the specified folder.

macOS procedure
The following steps provide the complete procedure for this topic.

1. Go to Paper Preset Management in the HP Utility and select the paper type and ICC profile to be 
exported.

2. Click  at the bottom of the window, then Export ICC profile.

3. Choose the pathname of the folder in which the ICC profile will be saved in your computer, then 
click Continue.

Restore an original color profile
The ICC profile settings in a paper preset can be restored to their original values. This will remove any 
ICC profile that you have associated with the selected paper and restore the default ICC profile provided 
by HP.

Windows procedure
The following steps provide the complete procedure for this topic.

1. Go to the Color Center in the HP Printer Utility, and click Profile Management.

2. Select the paper type whose ICC profile you want to restore. Click Restore.

macOS procedure
The following steps provide the complete procedure for this topic.

1. Go to Paper Preset Management in the HP Utility and select the ICC profile.

2. Click  at the bottom of the window, then Restory factory ICC profile.

100 Chapter 8  Color management



Color management from printer drivers

Color management options
The aim of color management is to reproduce colors as accurately as possible on all devices: so that, 
when you print an image, you see very similar colors as when you view the same image on your monitor.

There are two basic approaches to color management for your printer:

● Printer-Managed Colors: In this case your application program sends your image to the printer 
without any color conversion, and the printer converts the colors to its own color space. The details 
of this process depend on the graphics language that you are using. HP recommends this setting 
for the best experience and results.

– PostScript: The PostScript and PDF interpreter modules perform the color conversion using the 
profiles stored in the printer and any additional profiles sent with the PostScript job. This kind of 
color management is done when you are using the PostScript or PDF driver.

– Non-PostScript (PCL3): The color management is done using a set of stored color tables. ICC 
profiles are not used. This method is somewhat less versatile than the alternatives, but is a little 
simpler and faster, and can produce good results with standard HP paper types.

NOTE: In non-PostScript printing, the printer can convert to sRGB if you are using Windows, 
or to Adobe RGB if you are using macOS.

● Application-Managed Colors: In this case your application program must convert the colors of your 
image to the color space of your printer and paper type, using the ICC profile embedded in the 
image and the ICC profile of your printer and paper type. To use this option, your printer’s ICC 
profiles must be installed in your computer.

IMPORTANT: Make sure to select matching settings in the driver and in the application.

You are recommended to consult the HP Support Center (see HP Support Center on page 208) to see 
how to use the color management options of your particular application. See also Print a document with 
the correct colors on page 111.

To choose between Application-Managed Colors and Printer-Managed Colors:

● In the Windows driver dialog: Select the Color tab.

● In the macOS Print dialog: Select the Color Matching panel. Vendor Matching or In Printer 
corresponds to Printer-Managed Colors mode. ColorSync should be used only if you cannot choose 
Application-Managed Colors in your application print dialog.

● In some applications: You can make this choice in the application.

Color options

Printing in color
The printer prints in color by default.
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You can select color printing explicitly in the following ways:

● In your application program: Many programs provide this option.

● In the Windows driver dialog: Go to the Color tab and look at the Output Color or Color Options 
section (whichever is available in your driver). Select Print in color.

● In the macOS Print dialog: Go to the Color Options panel and select Color from the Mode drop-down 
list.

Printing in grayscale

You can convert all colors in your image to shades of gray in the following ways:

● In your application program: Many programs provide this option.

● In the Windows driver dialog: Go to the Color tab and look at the Output Color or Color Options 
section (whichever is available in your driver). Select Print in grayscale.

● In the macOS Print dialog: Go to the Color Options panel and select Grayscale from the Mode 
drop-down list.

HP Professional PANTONE Emulation
When you use a named PANTONE color in an image, your application will normally send to the printer a 
CMYK or RGB approximation to that color. But the application does not take the printer or the paper type 
into account, it merely produces a generic approximation of the PANTONE color, which will look different 
on different printers and on different papers.

HP Professional PANTONE Emulation can do a much better job by taking into account the characteristics 
of the printer and the paper type. The results look as similar to the original PANTONE colors as is 
possible on a given printer using a given paper type. This technology is designed to produce emulations 
similar to those set up manually by prepress professionals.

To use HP Professional PANTONE Emulation, all you have to do is to turn it on. In fact, it is normally on by 
default.

● In the Windows PostScript/PDF driver dialog: Go to the Color tab and select HP Professional 
PANTONE Emulation.

● In the macOS Print dialog: Go to the Color Options panel and select HP Professional PANTONE 
Emulation.

● From the front panel: Tap , then Printing preferences > Color options > HP Pantone Emulation.

HP Professional PANTONE Emulation not only provides the closest match that can be achieved on your 
printer; it also gives clear information on how close the emulation is to the original spot color.

PANTONE emulation in the Embedded Web Server
The HP Professional Pantone Emulation page allows the user to navigate through several PANTONE 
formulas using tabs. Inside these tabs, you can select whichever strips you want and then print them.
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The page shows all the available PANTONE formulas in named tabs. Inside each tab, a virtual repeater 
holds all the strips, represented by several elements: a checkbox to select the strip, the strip colors with 
the name, and the name of the strip at the bottom. When you select at least one strip, the Print button is 
enabled.

When you click the Print button, a pop-up opens that lets you select the type of paper that will be used to 
print the selected PANTONE strips, and review the selected strips.
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The paper-source drop-down list shows first the papers that are already loaded in any of the in-trays, 
then the rest of the available papers. If you select a paper that is not already loaded, the job will be held 
in the printer until the paper is loaded.

The Print button is not enabled until you select a paper from the paper-source drop-down list.
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Default color spaces
When a document or image does not specify the working color space in which the content is originally 
described, the user can choose among different standards. That is, the user can determine how data 
should be interpreted by the color management system during the rendering process.

You can set source profiles in the following ways:

● In the Windows PostScript/PDF driver dialog: Select the Color tab, and Printer Managed Colors.

● In the macOS Print dialog: Select the Color Option panel, then select Adobe RGB or SRGB as the 
source profile.

The standard way of encapsulating such information is in ICC profiles. As part of the solution, we provide 
the most common standards for the different devices.

The options are as follows.

Default RGB source profiles
This topic explains the concepts involved in this subject.

Your printer is provided with the following color profiles:

● None (Native): For use when the color conversion is done by the application or operating system, 
and therefore the data arrive at the printer already color-managed. Available for PostScript and PDF 
drivers only.

● sRGB IEC61966-2.1 is the standard followed by typical PC monitors. This standard space is endorsed 
by many hardware and software manufacturers, and is becoming the default color space for many 
scanners, printers, and software applications.

● ColorMatch RGB is the standard followed by Radius Pressview monitors. This space provides a 
smaller gamut alternative to Adobe RGB (1998) for print production work. Available for PostScript 
and PDF drivers only.
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● Apple RGB is the standard followed by typical Apple monitors, and is used by a variety of desktop 
publishing applications. Use this space for files that you plan to display on Apple monitors, or for 
working with old desktop publishing files. Available for PostScript and PDF drivers only.

● Adobe RGB (1998) provides a fairly large gamut of RGB colors. Use this space if you need to do print 
production work with a broad range of colors.

Default CMYK source profiles
You can choose from a selection of CMYK source profiles recognized by the printer. The default CMYK 
profile is ISO Coated V2 (ECI), available for PostScript and PDF drivers only.

Color management from the front panel
You can color-calibrate the loaded paper type from the front panel by tapping , then Color 

calibration.

See Color calibration on page 96.

The other color options in the front panel can all be found by tapping , then Default printing 

configuration > Color options (they can also be found under Advanced printing preferences).

NOTE: If color options are set in the driver, they override the front-panel settings.

All jobs

● Color

● Grayscale

● Select RGB source profile: You can choose from a selection of RGB source profiles recognized by 
the printer. Default: sRGB IEC 1966-2.1.

PostScript and PDF jobs only

● Select CMYK source profile: You can choose from a selection of CMYK source profiles recognized 
by the printer. Default: US Coated SWOP v2.

● Select rendering intent: You can select the rendering intent. Default: Perceptual.

● Black point compensation: You can turn black point compensation on or off. Default: On.

● HP Professional PANTONE Emulation: You can turn HP Professional PANTONE Emulation on or off. 
Default: On.
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Practical printing examples9

The following sections provide details for this topic.

Print a draft for revision with the correct scale
This section demonstrates how to print a draft for revision with the correct scale from Adobe Acrobat.

Using Adobe Acrobat
The following steps provide the complete procedure for this topic.

1. In the Acrobat window, bring the mouse cursor to the bottom left corner of the document pane to 
check the page size.

2. Select File > Print and ensure that Page Sizing & Handling is set to Actual size.

NOTE: The page size will not be automatically selected according to the drawing size.

3. Click the Properties button and then select the Paper/Quality tab.
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4. Choose whatever Document Size and Print Quality you want to use. If you want to define a new 
custom paper size, click the Custom button.

5. Select the Layout/Output or Layout tab (depending on the driver version), then Autorotate.

6. Click OK, and check that the print preview in the Print dialog box seems correct.

Print a PDF multipage job from Adobe Acrobat Reader or Adobe 
Acrobat Pro

Using a raster driver
The following steps provide the complete procedure for this topic.

1. Open a multipage job in Adobe Acrobat Reader or Adobe Acrobat Pro (HP recommends always 
using the latest version).

2. Click File > Print.

3. Select the printer and driver.
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4. Check the Choose paper source by PDF page size box.

5. Adjust other properties in the driver properties window, as required.

6. Click the Print button.

The pages will be printed on the standard page size closest to the page size in the original document.

Using a PostScript driver
The following steps provide the complete procedure for this topic.

1. Open a multipage job in Adobe Acrobat Reader or Adobe Acrobat Pro (HP recommends always 
using the latest version).

2. Click File > Print.

3. Select the printer and driver.
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4. Check the Choose paper source by PDF page size and Use custom paper size when needed boxes.

5. Adjust other properties in the driver properties window, as required.

6. Click the Print button.

If you checked the Use custom paper size when needed box, the pages will be printed on paper sizes 
corresponding to the page sizes in the original document.

Using a PDF driver
With the latest versions of Adobe Acrobat Pro or Adobe Acrobat Reader, this is managed by the 
application, and the pages will be printed on paper sizes corresponding to the page sizes in the original 
document.
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Print a document with the correct colors
This section demonstrates how to print a document from Adobe Acrobat and Adobe Photoshop, with the 
emphasis on color management.

Using Adobe Acrobat Reader
The printing process is very simple.

Acrobat Reader is the most basic application for PDF files; several color management tools common in 
more sophisticated applications are not explicitly present, and work by default with presets that cannot 
be changed. For example, there is no way to select a working color space; a default color space, most 
likely sRGB, is applied. This color space is used for screen display, for example. Also, as an alternative 
color profile when no other is specified by a file, as will be explained later.

1. Click File > Print.
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2. Select the printer and driver from the Printer drop-down menu in the Print dialog box. Driver 
settings can be adjusted by clicking the Properties button.

3. Adjust the color settings in the driver properties window. Click the Properties button in the Print 
dialog and set the Color option in the Color tab. If you have a V4 driver, check the box Printer 
Managed Colors, and select the most convenient source profile. Click OK.
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4. If you have a V3 driver, click the Advanced button in the Print dialog box to set color management 
options. Check the box Let printer determine colors.

NOTE: If you are using the PDF driver, you can skip this step.

5. If the document contains several color profiles and you are not sure what the result will be, you 
can flatten the document first and print it as seen on the screen. To do this, check the box Print 
As Image in the Advanced Print Setup dialog box. In this case, the rasterization is performed by 
Acrobat Reader before calling the driver; whereas, if you do not check this box, the rasterization is 
performed by the driver. So checking the box may have a visible effect on the look of the printed 
document.

Using Adobe Acrobat Pro
Acrobat Pro is a professional application that allows full color management. This section briefly 
describes the options to select a working color space, convert images to a desired color space, and 
print.
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1. PDF files may not contain a color profile. In the absence of a color profile, Acrobat uses a working 
color space by default. To choose a working color space, first click Edit > Preferences.

2. In the Preferences dialog box, you can choose RGB, CMYK, and grayscale working color spaces.

3. PDF files can contain elements with different color profiles. Some may have color profiles, some 
may not. The working color space will affect only those without a color profile. If you want to attach 
a specific color profile to the document, you must convert the contents of the document as follows. 
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First, select Convert Colors from View > Tools > Print Production or by clicking the icon in the status 
bar.

4. Select the elements you want to convert by specifying matching criteria (object type and/or color 
type) and then the conversion attributes. If you want to change the embedded color profile, you 
can select Any Object and Any Colorspace in the Matching Criteria section. In the Conversion 
Attributes section you can choose, for example, to embed an Adobe RGB (1998) profile by selecting 
it as the Conversion Profile, checking the Embed box, clicking the OK button, and saving the file to 
keep the changes. The saved file will have an embedded Adobe RGB color profile.

5. To print the document, choose a printer from the Print dialog box, click the Properties button, and 
set the color options in the Color tab.

IMPORTANT: Select Print in color and Printer managed colors.

If you have the V4 driver, you can also select a default color profile, which will be used for any 
elements that lack a color profile. HP suggests:

● RGB

● CMYK: Choose Coated FOGRA39 or US Web Coated (SWOP) v2.
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6. If you have the V3 driver, click the Advanced button in the Print dialog box, set Color Handling to 
Printer Color Management, and click OK.

NOTE: If you are using the PDF driver, you can skip this step.
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7. In the Print dialog box, click the Print button to print the document.

Using Adobe Photoshop
The following steps provide the complete procedure for this topic.

1. In Photoshop, click File > Print, then select your printer.

2. In the Color Management section, set the Color Handling option to Printer Manages Colors.

3. In the driver’s Color tab, ensure that the color management option is Printer managed colors. This 
is the correct option because you have already selected Printer Manages Colors in Photoshop.
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Print a project
This section demonstrates how to print a project from AutoCAD.

Using Autodesk AutoCAD
The AutoCAD window can show a model or layout.

1. Normally a layout is printed rather than the model.

2. Click the Plot icon at the top of the window.

3. The Plot window opens.
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4. You can see further options by clicking the circular button in the lower right corner of the window.

NOTE: The Quality option here does not refer to the final print quality but to the quality of 
AutoCAD viewport objects that are sent for printing.

5. Select your printer and click the Properties button.

6. Select the Device and Document Settings tab, and click the Custom Properties button.
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7. In the Paper/Quality or Paper tab (depending on the driver version), select the paper type that you 
intend to use.

NOTE: If you select neither the paper source nor the paper type, the printer will not print on any 
protected roll (see Protect a paper type on page 81).

8. Select the print quality (your own choice between speed and quality of printing).

9. If you intend to print on roll paper, you must decide where the printer should cut the paper.

● With the Windows V3 driver: Select the Paper/Quality tab, then click the Margins/Cutter 
Settings button, then Clip content by margins.

● With the Windows V4 driver: Select the Layout tab, then in the Layout Mode area click With 
margins > Clip content by margins.

You can also adjust the crop lines, which indicate where to cut the paper after printing. See Print 
with crop lines on page 76.

If you have a Z6dr or Z9+dr, you can enable the vertical trimmer and cut the left and right edges of 
the paper.

10. Select the Layout/Output tab, then select the Autorotate option. Autorotation can help to avoid 
wasting paper.

11. Click the OK button and save your configuration changes to a PC3 file.

12. When you have clicked the OK button in the Plot window, the printer will construct a print preview.

Using clip contents by margins
You can select this margins option from Advanced settings > Paper > Layout/Margins > Print with 
margins > Layout > Clip contents by margins.
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Use this option when the contents to be printed have white borders and a size equal to that of the paper 
you have selected. The printer will use the white border for its margins and you will get a page of size 
equal to that which is selected in the driver.

Print a presentation
This section demonstrates how to print a presentation from AutoCAD and from Photoshop.

Using Autodesk AutoCAD
The following steps provide the complete procedure for this topic.

1. Open the AutoCAD file and select a layout.

2. Click the Plot icon at the top of the window.

3. Ensure that the correct printer is selected, then click the Properties button.
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4. Select the Device and Document Settings tab, and click the Custom Properties button.

5. In the Paper/Quality tab, select the paper type that you intend to use.

NOTE: If you select neither the paper source nor the paper type, the printer will not print on any 
protected roll (see Protect a paper type on page 81).

6. Select the print quality (your own choice between speed and quality of printing).

7. If you intend to print on roll paper, you must decide where the printer should cut the paper.

● With the Windows V3 driver: Select the Paper/Quality tab, then click the Margins/Cutter 
Settings button, then Clip content by margins.

● With the Windows V4 driver: Select the Layout tab, then in the Layout Mode area click With 
margins > Clip content by margins.

If you have a Z6dr or Z9+dr, you can enable the vertical trimmer and cut the left and right edges of 
the paper.
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8. Select the Layout/Output tab, then select the Autorotate option. Autorotation can help to avoid 
wasting paper.

9. Click the OK button and save your configuration changes to a PC3 file.

10. When you have clicked the OK button in the Plot window, the printer will construct a print preview.

Using Adobe Photoshop
The following steps provide the complete procedure for this topic.

1. In Photoshop, click File > Print and then select your printer.

2. Click Print settings, then select the Paper/quality tab.
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3. Choose from the available paper sizes.

If you do not find the paper size that you intend to use, click the Custom button. Enter the width, the 
length and the name of your custom paper size. Click the Save and OK buttons.

4. Select Show preview before printing. You may also wish to change the default paper source, paper 
type and print quality.

5. In the Color tab, the default color management option is Printer managed colors, and this is the 
correct option because you have already selected Printer Manages Colors in Photoshop.

Print and scale from Microsoft Office
This section demonstrates how to print and scale from Microsoft Office 2013.

Using Microsoft PowerPoint
The following steps provide the complete procedure for this topic.
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1. Click File > Print, and select the name of your printer.

2. Click Printer properties > Layout/Output > Resizing options to scale the document to a particular 
size.

3. Select the Paper/Quality tab, then select Paper Source and Paper Type.

4. Depending on your driver version:

● With the Windows V3 driver: Select the Paper/Quality tab, then click the Margins/Cutter 
Settings button, then Clip content by margins.

● With the Windows V4 driver: Select the Layout tab, then in the Layout Mode area click With 
margins > Clip content by margins.

If you have a Z6dr or Z9+dr, you can enable the vertical trimmer and cut the left and right edges of 
the paper.
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Using Microsoft Project
The following steps provide the complete procedure for this topic.

1. Click File > Print.

2. Select your printer's name.

3. In the Settings section, you can choose the pages to print, the orientation, and the paper size.
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4. Click Page Setup to choose the Paper Size you want.

5. Select Options to go to the printer driver.

The default options in the Paper/Quality tab are probably suitable: Paper source: Use printer 
settings and Paper Type: Use Printer Settings.

6. Click Layout/Output > Resizing options to scale the document to a particular size. Alternatively, you 
can scale the document in Project.

Using Microsoft Excel
The following steps provide the complete procedure for this topic.
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1. Click File > Print. Select your printer's name, then click the back arrow to leave the File menu.

2. Select the Page Layout tab, then Size, and choose the paper size you want.

3. Click File > Print > Printer properties to go to the printer driver. In the Paper/Quality tab, select Paper 
source, Paper Type and Print Quality.

4. Click Layout/Output > Resizing options to scale the document to a particular size. Alternatively, you 
can scale the document in Excel.

Print a borderless job using the vertical trimmer
The following sections provide details for this topic.

NOTE: This combination of settings can be used for all paper types except for self-adhesive 
materials, which cannot be cut by the vertical trimmer.
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Print settings with a V3 driver
The following steps provide the complete procedure for this topic.

1. Open a file.

2. Click File > Print.

3. Select the printer and driver.

4. Select the original paper size of the document. If is not a standard paper size, create a custom 
paper size.

5. Click the Margins/Cutter Settings button to go to the Layout and cutter options window.

6. Select Borderless, and check the Vertical trimmer box.
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Print settings with a V4 driver
The following steps provide the complete procedure for this topic.

1. Open a file.

2. Click File > Print.

3. Select the printer and driver.

4. Select the original paper size of the document. If is not a standard paper size, create a custom 
paper size.

If you are not printing with a PDF driver and not using Adobe Acrobat, select the original paper size 
of the document.

5. Select the Output tab, and check the Vertical trimmer box.
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6. Select the Layout tab, then select Borderless.
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Retrieving printer usage information10

Get printer accounting information
This topic explains the concepts involved in this subject.

There are different ways of getting accounting information from your printer.

● View printer usage statistics for the whole lifetime of the printer, see Check usage statistics on page 
132.

● View ink and paper usage for each of your recent jobs, see Check usage statistics for a job on page 
135.

● Use a third-party application to request printer status, printer usage or job accounting data from the 
printer through the Internet. The printer provides data in XML to the application whenever requested. 
HP provides a Software Development Kit to facilitate the development of such applications.

Check usage statistics

Check usage from the front panel

Tap  on the front panel to display the usage information.

The following information can be retrieved:

● In the tab Print categories usage, you can see the ink, paper area, and paper length usage divided 
into categories:

– Mono lines: Between 0% and 10% of non-white pixel coverage, printed on standard paper, with 
less than 1% of color pixel coverage

– Color lines: Between 0% and 10% of non-white pixel coverage, printed on standard paper, with 
more than 1% of color pixel coverage

– Low density image: Between 10% and 50% of non-white pixel coverage printed on standard 
paper

– High density image: Over 50% of non-white pixel coverage printed on standard paper
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– Blueprint: Any content type printed on blueprint paper

– Premium quality image: Any content type printed on premium paper

● Ink usage displays the ink consumed in milliliters, by category, and the total amount.

● Paper area usage displays the paper area usage in English or metric units of area, by category, and 
the total amount.

● Paper length usage displays the paper usage in English or metric units of length, by category, and 
the total amount.

● The Ink tab displays the ink consumed by each cartridge in milliliters, and the total amount of ink 
consumed.
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● The Paper tab displays the amount of paper used and the total at the top, divided into paper 
categories or families.

Usage can be seen at each level.

When you tap , a message is displayed: The usage report was sent to the job queue and will be 

printed soon.

All the values can be displayed in English or metric units.

Print the usage information

There are two different ways to print the usage information from the front panel’s home screen:

● Tap  to launch the usage information screen, then tap the Print usage report button.

● Tap , then Internal prints > User information prints > Print usage report.

Check usage from the Embedded Web Server
The same information can be retrieved from the Embedded Web Server as from the front panel.

1. Access the Embedded Web Server, see Embedded Web Server on page 16.

2. In the menu at the side, click Usage.

The usage page shows all the printer usage information separated into various tables:

● Summary: The total ink usage and the total paper usage (in units of area and length).

● Print categories usage: The ink and paper usage and the number or pages printed for the different 
print categories (content type, such as mono lines, color lines, premium quality image, blueprint 
paper). This table information is shown only if the Show application categories printer setting is 
enabled. There are further conditions depending on the following settings:

– The paper printed usage is shown if the Paper area used and paper area printed setting is 
enabled.

– The blueprint category is shown if the Enable the blueprint category setting is enabled.

– The premium quality image category is only shown if the Enable the premium quality image 
category setting is enabled.

134 Chapter 10  Retrieving printer usage information



– If the printed-paper column information is shown, the paper area used field changes the string 
to "Paper area (m² used)". Otherwise, the string shown is "Paper area (m²)".

● Ink usage: The ink usage for the whole life of the printer (with approximate values). The ink 
consumption table lists the ink consumed in each color, ignoring the product number of the 
cartridge.

● Paper usage: All the papers that have been used throughout the life of the printer.

Check usage statistics for a job
The following steps provide the complete procedure for this topic.

NOTE: The accuracy of the usage statistics is not guaranteed.

1. Access the Embedded Web Server, see Embedded Web Server on page 16.

2. In the menu at the side, click Usage > Accounting.

The accounting page shows a table of the latest printed jobs, with the following information per job (not 
per page):

● Name: The name of the job

The job name is shown only if the Show user name and job name in job accounting setting is 
available to users under Security > Security settings.

● Number: The number of the job

● Time: The date and time when the job was completed

● User: The name entered by the person who submitted the job (this item is present only if the 
corresponding security setting is enabled)

The user name is shown only if the Show user name and job name in job accounting setting is 
available to users under Security > Security settings.

● Type: The type of job

● Source: The source of the job: USB, network, and so on

● Print quality: The print quality used to print the job
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● Copies: The number of copies requested (cumulative after reprints)

● Pages: The number of pages completed

● Status: The status of the job: printed, canceled by user, and so on

● Total cost: The total cost of the job (visible if cost assignment is enabled)

● Paper type: The paper type used for the job

● Paper area: The used paper area of the job

● Paper length: The used paper length of the job

● Ink used: The volume of ink consumed by the job

A job is considered completed when all its pages have been printed, or canceled by the user, or 
canceled by the printer itself. An ongoing job (waiting for printing, being printed, being canceled, on hold 
for preview, and so on) will not appear on this list.

You can filter the jobs shown on the accounting page by using a drop-down control available on the 
same page. This control just changes the view, the job accounting information is not deleted in the 
printer. Essentially, this page will report the last N jobs (or fewer if there are not enough completed jobs), 
where N is the value of this configuration parameter. By default, N is 10.

Two buttons appear in the accounting table:

● Help: This button opens a window displaying help information. The information depends on the 
printer’s capabilities: for example, if the printer has no scanner, scanner help is not shown.

● Export to CSV: This button opens a window with a progress bar, and generates and downloads a 
CSV file. The downloaded file contains similar information to the accounting page, in CSV format. If 
the cost assignment is enabled, the CSV displays more detailed information about the cost of the 
job.

Check cost assignment
The following steps provide the complete procedure for this topic.

NOTE: The accuracy of the usage statistics is not guaranteed.

1. Access the Embedded Web Server, see Embedded Web Server on page 16.

2. Go to the Main tab.

3. Select Usage > Cost assignment configuration.

The cost assignment page allows you to enable or disable the cost assignment setting, using the 
checkbox next to Enable accounting assignment configuration at the top of the page. If the setting is 
enabled, you can insert or modify the cost of the following sections.

NOTE: At least one of these sections must be enabled in order to save the configuration.

● Units

– Currency: Enter any three-letter currency code.

– Paper usage: Select the units, English or metric.
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● Print categories cost: Can be enabled or disabled. When enabled, you can assign a cost to each 
category, and select the units of the cost (per millimeter, or the option selected in the previous 
Units section). The cost is a number with two decimal digits of precision. Disabled categories are 
displayed grayed out.

● Ink usage cost: Can be enabled or disabled. Allows you to apply a cost to ink usage, and displays the 
available inks with a field to indicate the cost.

● Paper usage cost: Can be enabled or disabled. Allows you to apply a cost to the papers displayed. 
You can add papers from the list of supported papers. The costs can be removed or edited; they 
cannot be empty, but may be 0 (zero). The units selection is the same as for print categories.

● Fixed cost: Can be enabled or disabled. Allows you to add a fixed cost to all jobs.

Enabling the cost assignment setting causes the total cost column to appear in the accounting 
information, and detailed information is added to the exported CSV.
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Handling ink cartridges and printheads11

The following sections provide details for this topic.

About the ink cartridges
Ink cartridges store the ink and are connected to the printheads, which distribute the ink on the paper.

To purchase additional cartridges, see .

CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive 
devices (see the Glossary on page 215). Avoid touching pins, leads and circuitry.

NOTE: Dynamic security enabled printer. Only intended to be used with cartridges using an HP 
original chip. Cartridges using a non-HP chip may not work, and those that work today may not work in 
the future. More at: http://www.hp.com/go/learnaboutsupplies.

NOTE: This printer is not designed to use continuous ink systems. To resume printing, remove any 
continuous ink system and install genuine HP (or compatible) ink cartridges.

NOTE: This printer is designed for ink cartridges to be used until they are empty. Refilling cartridges 
prior to depletion might cause your printer to fail. If this happens, insert a new cartridge (either genuine 
HP or compatible) to continue printing.

Check the ink cartridges status
There are several ways of checking the status of the ink cartridges:

● On the front panel’s All Apps page, swipe left with your finger. You will see the widget page with the 
status of ink and paper supplies. You can tap a particular ink cartridge for more information on it.

● Tap  on the front panel, then tap the cartridge on which you want information. There is a 

Replace ink cartridges option on the ink information page in case you want to do that (see also ).

● You can also get this information from the HP DesignJet Utility.

For an explanation of the ink cartridge status messages, see .

HP DesignJet Utility procedures
This topic explains the concepts involved in this subject.

● In the HP DesignJet Utility for Windows, select the Overview tab, then the Supplies tab, then 
Cartridges.

● In the HP Utility for macOS, select Supplies Status in the Information group.
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Remove an ink cartridge
The following steps provide the complete procedure for this topic.

There are two occasions when you need to remove an ink cartridge.

● The ink cartridge is very low and you want to replace it with a full cartridge for unattended printing 
(you can use up the remaining ink in the first cartridge at a more convenient time).

● The ink cartridge is empty or faulty, and you must replace it to continue printing.

CAUTION: Do not try to remove an ink cartridge while printing.

CAUTION: Remove an ink cartridge only if you are ready to insert another one.

CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the 
printer from moving.

NOTE: When a cartridge runs out of ink, the current job is not automatically canceled: unless you 
cancel it manually, it will resume printing when the empty cartridge has been replaced. If there is a 
delay in replacing the cartridge, you may see some banding effect on the print.

1. From the front panel, tap , then , then Replace ink cartridges.

2. If you have a Z6 printer, open the ink cartridge cover on the right of the printer.

If you have a Z9+ printer, open the ink cartridge covers on both sides of the printer.

3. Grip the cartridge you wish to remove.

4. Pull the cartridge straight up.

NOTE: Avoid touching the end of the cartridge that is inserted into the printer, as there may be ink 
on the connection.
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NOTE: Avoid storing partially used ink cartridges.

5. The front-panel display identifies the missing ink cartridge.

Insert an ink cartridge
The following sections provide details for this topic.

Insert an ink cartridge
The following steps provide the complete procedure for this topic.

1. Before removing the cartridge from its wrapping, shake it vigorously.

2. Unwrap the new ink cartridge, find the label identifying the ink color. Check that the letter or letters 
(for example, M for magenta) marking the empty slot, matches the letter or letters on the cartridge 
label.

3. Insert the ink cartridge into its slot.

4. Push the cartridge into the slot until it snaps into position.

If you have difficulty, see .
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5. When all cartridges have been inserted, close the cover(s).

6. The front-panel display confirms that all cartridges have been correctly inserted.

Use of refilled or altered cartridges
The following steps provide the complete procedure for this topic.

HP recommends that you replace the empty cartridge with a new HP cartridge. See , , and .

The use of refilled or altered ink cartridges has several serious disadvantages:

● There is some risk of damaging the printer. In this case the printer warranty will not be valid for any 
printer repairs that are related to the cartridge, nor for any problems due to ink contamination.

● You will invalidate the warranty of all printheads of the same color used in the printer subsequently.

● Print quality may be impaired.

● The printer will be unable to estimate the ink level in the cartridge, and will not report it.

To force the printer to accept a cartridge, you can tap , , ,  on the front panel.

1. Install the cartridge in the printer (see ).

2. The front panel notifies you that the cartridge is altered, and the cartridge removal 
process will start. If you believe that you purchased a non-Original HP cartridge, HP 
recommends that you abort the process. To check the authenticity of your cartridges, see 
http://www.hp.com/go/anticounterfeit.

3. If you proceed, the front panel displays a series of warning messages.

NOTE: The printer detects cartridges that are non-Original HP. The printer is only intended to be used 
with cartridges using an HP original chip. Cartridges using a non-HP chip may not work, and those that 
work today may not work in the future. More at: http://www.hp.com/go/learnaboutsupplies.

When the process is finished, the front panel will give the usual ink cartridge display but the cartridge 
will not report the ink level.

About the printheads
The printheads are connected to the ink cartridges and jet ink onto the paper.

CAUTION: Observe precautions when handling printheads because they are ESD-sensitive devices 
(see the Glossary on page 215). Avoid touching pins, leads and circuitry.
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Check the printhead status
The following steps provide the complete procedure for this topic.

The printer automatically checks and services the printheads after each print. Follow the steps below to 
get more information on your printheads.

1. From the front panel, tap , then tap the printhead on which you want information.

2. The front panel displays:

● Colors

● Product name

● Product number

● Serial number

● Status, see 

● Volume of ink it has used

● Warranty status

You can also get most of this information from the HP DesignJet Utility. In the HP DesignJet Utility for 
Windows, select the Overview tab, then the Supplies tab.

For an explanation of the printhead status messages, see .

If the warranty status is See warranty notes, this indicates that non-HP ink is being used. See the Legal 
Information  document provided with your printer for details of the warranty implications.

Remove a printhead
The following steps provide the complete procedure for this topic.

CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the 
printer from moving.

CAUTION: Printhead replacement must be performed with the printer powered on.
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1. From the front panel, tap , then Printheads , then , then Replace.

2. The printer moves the carriage into the correct position.

CAUTION: If the carriage is left in the removal position for more than three minutes without 
inserting or removing any printheads, it tries to move back to its normal position in the right-hand 
end.

3. When the carriage has stopped moving, the front-panel display asks you to open the window.

4. Locate the carriage on the right side of the printer.

5. Pull the handle up and toward you to release the wire loop.

NOTE: The illustrations below are for a Z9+ printer; the procedure is similar if you have a Z6 printer.

6. Push the handle back to raise the lid.
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7. This gives you access to the printheads.

8. To remove a printhead, lift up the blue handle.

9. Using the blue handle, use steady force to disengage the printhead.

10. Pull the blue handle upward until the printhead is released from the carriage.

CAUTION: Do not pull abruptly because this can damage the printhead.

11. The front-panel display identifies the missing printhead.

144 Chapter 11  Handling ink cartridges and printheads



Insert a printhead
The following steps provide the complete procedure for this topic.

NOTE: You cannot insert a new printhead successfully if either of the connected ink cartridges is 
empty, or nearly empty. In this case, you should replace the ink cartridge before inserting the new 
printhead.

1. Remove the orange protective caps by pulling them down.

2. The printhead is designed to be inserted into any of the available slots. Once the printhead is 
inserted into a specific slot, it will be set up to work only with that combination of colors. For this 
reason, it is important to mark the printhead with its specific color, on the label that comes with it, 
matching the color of the carriage slot into which the printhead is to be inserted.

3. Insert the new printhead into its correct slot in the carriage.

CAUTION: Insert the printhead slowly and vertically, straight down. It may be damaged if you 
insert it too fast, or at an angle, or if you rotate it as you insert it.
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CAUTION: When installing the new printhead there may be some resistance, so you need to press 
it down firmly but smoothly. You should hear a beep and see confirmation on the front-panel display 
that the printhead has been inserted. If you have difficulty, see .

4. Insert all other printheads that need to be installed, and close the carriage lid.

5. Ensure that the end of the blue handle catches the wire loop on the near side of the carriage.
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6. Lower the handle to rest on the carriage cover.

When all the printheads have been inserted correctly and are accepted by the printer, the printer 
beeps.

NOTE: If the printer does not beep when you insert the printhead and the Replace message 
appears on the front-panel display, the printhead may need to be reinserted.

7. Close the window.

8. The front-panel display confirms that all printheads are correctly inserted. The printer starts 
checking and preparing the printheads. The default routine process, when all printheads are 
changed, takes 10 minutes. If the printer finds problems in preparing the printheads, it takes longer, 
up to 45 minutes. For a single printhead insertion, the times vary between 2 and 45 minutes. After 
all printheads are checked and prepared, the printhead realignment procedure runs automatically 
if paper is loaded, see .

9. You are recommended to perform a color calibration after inserting a new printhead. See .

Safe mode
Under certain conditions, including printer operation outside of environmental specifications, and when 
a used, refilled, or counterfeit ink cartridge has been detected, the printer will operate in safe mode. HP 
is unable to warrant the performance of the printing system when operated outside of environmental 
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specifications or when a used, refilled, or counterfeit ink cartridge is installed. Safe mode is designed to 
protect the printer and the printheads from damage due to unexpected conditions, and is in operation 
when the icon is displayed on the printer’s front panel and by the Embedded Web Server and HP Utility.

For optimal performance, use original HP ink cartridges. HP DesignJet printing systems, including 
original HP inks and printheads, are designed and engineered together to provide uncompromising print 
quality, consistency, performance, durability, and value—with every print.

NOTE: This printer is not designed to use continuous ink systems. To resume printing, remove the 
continuous ink system and install genuine HP (or compatible) cartridges.

NOTE: This printer is designed for ink cartridges to be used until they are empty. Refilling cartridges 
prior to depletion might cause your printer to fail. If this happens, insert a new cartridge (either genuine 
HP or compatible) to continue printing.

NOTE: Dynamic security enabled printer. Only intended to be used with cartridges using an HP 
original chip. Cartridges using a non-HP chip may not work, and those that work today may not work in 
the future. More at: http://www.hp.com/go/learnaboutsupplies.
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Maintaining the printer12

The following sections provide details for this topic.

Check printer status
You can check the current status of the printer in the following ways:

● If you access the Embedded Web Server, you see information about the general status of the 
printer.

● At the front panel, you can see information about paper, ink levels, ink cartridges, and printheads by 
tapping the corresponding icon.

If there are any current alerts, the upper row of the home page shows the top-priority alert. Tap the 
alert message to see a list of all current alerts, with an icon indicating the severity of each alert. You 
can tap an individual alert to get help in solving the problem.

Clean the exterior of the printer
Clean the outside of the printer and all other parts of the printer that you regularly touch as part 
of normal operation with a damp sponge or a soft cloth and a mild household cleaner such as non-
abrasive liquid soap.

WARNING! To avoid an electric shock, make sure that the printer is turned off and unplugged before 
you clean it. Do not let water get inside the printer.

CAUTION: Do not use abrasive cleaners on the printer.

Maintain the ink cartridges
During the normal lifetime of a cartridge, no specific maintenance is required. However, in order to 
maintain the best print quality, replace a cartridge when it reaches its expiration date. The printer's front 
panel notifies you when any cartridge reaches its expiration date.

You can also check a cartridge's expiration date at any time: see Check printer status on page 149.

See also Handling ink cartridges and printheads on page 138.

Move or store the printer
If you need to move the printer, prepare it correctly to avoid possible damage to it.

To prepare the printer, follow the instructions below.

1. Do not remove the ink cartridges or printheads.

2. Make sure that no paper is loaded.

3. Make sure that the printer is idle.
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4. Disconnect any cables connecting the printer to a network or computer.

Moving the printer
CAUTION: Before moving the printer through a doorway, remove the foot extensions if necessary, and 
make sure to reassemble them before you set up the printer.

If you need to leave the printer turned off for a long time, follow the additional steps below:

1. Turn off the power using the power key on the front panel.

2. Disconnect the printer's power cable.

CAUTION: Do not turn the printer upside down: ink could escape from the service station and 
damage the printer.

When reconnecting the power cable, remember to route the cable tidily along the back gutter. When the 
printer is turned back on, it takes about three minutes to initialize itself and to check and prepare the 
printheads. Preparing the printheads normally takes just over a minute. However, if the printer has been 
off for a six weeks or more, preparing the printheads could take up to 45 minutes.

CAUTION: If the printer remains off for a long period of time, the printheads may become unusable. In 
this case, you need to replace the printheads with new ones.

TIP: Because preparing and purging the printheads uses both time and ink, you are strongly 
recommended to leave the printer always on or in sleep mode, whenever possible, to maintain the 
health of the printheads. In both cases, the printer wakes up from time to time to maintain the 
printheads. Thus you can avoid going through lengthy preparation processes before using your printer.

Update the firmware
The printer's various functions are controlled by firmware that resides in the printer.

From time to time firmware updates will be available from HP. These updates increase the printer's 
functionality, enhance its features, and may correct minor problems.

IMPORTANT: You are strongly recommended to update the firmware periodically in order to take 
advantage of the latest improvements.

There are various ways of downloading and installing firmware updates; you can choose whichever you 
find most convenient. They can be divided into two categories: automatic and manual updates.

NOTE: The firmware includes a set of the most commonly used paper presets. Extra paper presets 
can be downloaded separately; see .
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Automatic firmware updates
Automatic firmware updates are a convenience that is possible with Web-connected printers. Your 
printer can automatically download the latest firmware release, store it in the printer, and install it for 
you.

Important notes

● Your printer must be connected to the Internet; see .

● To configure automatic firmware updates, you can use the front panel or the Embedded Web Server; 
see .

● If an administrator password has been set, it will be required to change these settings.

● A firmware update package can be large; you may want to consider whether there are any 
implications for your network or Internet connection.

● A firmware update is downloaded in the background: the printer can be printing at the same time. 
However, it cannot be installed in the background: printing must stop, and installation is always a 
manual process. You can install firmware at any time after the download has completed.

Manual firmware updates
This topic explains the concepts involved in this subject.

Manual firmware updates can be performed in the following ways:

● Using the Embedded Web Server, click About printer > Firmware update. Click Check now to check 
whether new firmware is available. If new firmware is available, some information about the new 
firmware is displayed, and you are given the opportunity to download and install it.

● Using the HP DesignJet Utility under Windows, select your printer, the Support tab and then 
Firmware Update.

● Using the HP DesignJet Utility under macOS, select Firmware Update in the Support group.

● Using HP Web Jetadmin, with which you can make manual firmware updates or request automatic 
updates.

● Using a USB flash drive, which should be formatted as FAT32 and should be able to 
store at least 4 GB. Download the firmware file from http://www.hp.com/go/Z6/firmware or 
http://www.hp.com/go/Z9/firmware into the USB flash drive and insert it into the Hi-Speed USB host 
port beside the front panel. A firmware-update assistant will appear on the front panel to guide you 
through the update process.

Update the software
To update printer drivers and other software for your printer, go to www.hp.com/go/Z6/drivers (if you 
have a Z6) or www.hp.com/go/Z9/drivers (if you have a Z9+).

● Under Windows, HP Software Update regularly offers to update your software automatically.

● To enjoy all printing features, download the macOS drivers from http://www.hp.com/go/Z6/drivers (if 
you have a Z6) or http://www.hp.com/go/Z9/drivers (if you have a Z9+).
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Printer maintenance kits
Three maintenance kits are available for your printer, containing components that may need to be 
replaced after long use. When one of them is needed, a message is displayed on the front panel and by 
the HP DesignJet Utility.

When you see the message, you should contact HP Support (see Contact HP Support on page 209) and 
request the maintenance kit. The kits are installed by service engineers only.

Secure File Erase
The printer's hard disk is used as a temporary storage area for print jobs.

The Secure File Erase facility can completely erase your information from the hard disk to protect it 
from unauthorized access. It begins to do so as soon as you turn it on, but old temporary files that were 
already on the hard disk are not erased retroactively. If you want to erase the old files too, see Disk Wipe 
on page 152.

Secure File Erase provides three different levels of security:

● Non-Secure Mode: all pointers to the information are erased. The information itself remains on the 
hard disk until the disk space it occupies is needed for other purposes, and it is then overwritten. 
While it remains on the disk, it is difficult for most people to access, but may be accessed using 
software designed for the purpose. This is the normal method in which files are erased on most 
computer systems; it is the fastest method but the least secure.

● Secure Fast Erase: all pointers to the information are erased, and the information itself is also 
overwritten with a fixed character pattern. This method is slower than Non-Secure Mode, but more 
secure. It may still be possible to access fragments of the erased information by using special tools 
to detect residual magnetic traces.

● Secure Sanitizing Erase: all pointers to the information are erased, and the information itself is 
repetitively overwritten using an algorithm designed to eliminate any residual traces. This is the 
slowest method, but the most secure. Secure Sanitizing Erase meets the US Department of Defense 
5220-22.m requirements for clearing and sanitization of disk media. This is the default security level 
when using Secure File Erase.

These settings can be changed from the Embedded Web Server (Security > Security settings). Secure 
File Erase is one of the facilities provided by Web JetAdmin, which is HP's free Web-based print 
management software: see http://www.hp.com/go/webjetadmin.

If you have difficulty in using Secure File Erase from Web JetAdmin, contact HP Support: see Contact 
HP Support on page 209.

Disk Wipe
The Disk Wipe configuration can be changed from Web JetAdmin or the Embedded Web Server.

Disk Wipe is the same as Secure File Erase (see Secure File Erase on page 152), except that it erases all 
temporary files, including old ones.

NOTE: If you choose to erase the whole hard disk, you may be asked to restart the printer several 
times during the process, which will take about 6 hours with Secure Fast Erase or 24 hours with Secure 
Sanitizing Erase.
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Accessories - HP DesignJet Z6/Z9+13

The following sections provide details for this topic.

How to order supplies and accessories
The following sections provide details for this topic.

There are two alternative ways to order supplies or accessories for your printer:

● Visit http://www.hplfmedia.com on the Web.

● Contact HP Support (see ).

The rest of this chapter lists the available supplies and accessories, and their part numbers.

Order ink supplies
The following ink supplies can be ordered for your printer.

Table 13-1 Ink cartridges

Ink cartridge Product number

HP 746 300-ml Magenta DesignJet Ink Cartridge P2V78A

HP 746 300-ml Yellow DesignJet Ink Cartridge P2V79A

HP 746 300-ml Cyan DesignJet Ink Cartridge P2V80A

HP 746 300-ml Chromatic Red DesignJet Ink Cartridge P2V81A

HP 746 300-ml Photo Black DesignJet Ink Cartridge P2V82A

HP 746 300-ml Matte Black DesignJet Ink Cartridge P2V83A

HP 747 300-ml Chromatic Green DesignJet Ink Cartridge 1 P2V84A

HP 747 300-ml Chromatic Blue DesignJet Ink Cartridge 1 P2V85A

HP 747 300-ml Gray DesignJet Ink Cartridge 1 P2V86A

HP 747 300-ml Gloss Enhancer DesignJet Ink Cartridge 12 P2V87A

1 HP DesignJet Z9+ Printer Series only.
2 To use this cartridge, you need to have installed the HP Gloss Enhancer Upgrade Kit.

Table 13-2 Printhead

Printhead Product number

HP 746 DesignJet Printhead P2V25A
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Order paper
The following paper types are currently provided for use with your printer.

NOTE: This list is likely to change over the course of time. For the latest information, see 
http://www.hplfmedia.com.

NOTE: Paper types that HP does not support may nevertheless be compatible with your printer.

Key to availability:

● (A) indicates papers available in Asia (excluding Japan)

● (C) indicates papers available in China

● (E) indicates papers available in Europe, the Middle East and Africa

● (J) indicates papers available in Japan

● (L) indicates papers available in Latin America

● (N) indicates papers available in North America

If the part number is not followed by parentheses, the paper is available in all regions.

Table 13-3 Roll paper

Paper type g/m2 Length Width Product number

HP Bond and Coated Paper

HP Super Heavyweight Plus Matte 
Paper

200 30.5 m (100 ft) 610 mm (24 in) Q6626B (ELN)

914 mm (36 in) Q6627B (AELN)

1066 mm (42 in) Q6628B (ELN)

HP Universal Bond Paper 80 45.7 m (150 ft) 594 mm (23.39 in) (A1) Q8003A (AJ)

SA089A (2 Pack) (J)

610 mm (24 in) Q1396A

SA025A (2 Pack) (J)

914 mm (36 in) Q1397A

1066 mm (42 in) Q1398A

1117 mm (44 in) 2NC45A

91.4 m (300 ft) 594 mm (23.39 in) (A1) Q8004A (EAJ)

840 mm (33.11 in) (A0) Q8005A (EAJ)

174.9 m (574 ft) 914 mm (36 in) Q8751A (ELN)
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Table 13-3 Roll paper (continued)

Paper type g/m2 Length Width Product number

HP Bright White Inkjet Paper 90 45.7 m (150 ft) 421 mm (16.57 in) Q1446A (EJ)

594 mm (23.4 in) (A1) Q1445A (EJ)

610 mm (24 in) C1860A (LN)

610 mm (24 in) C6035A (EAJ)

841 mm (33.11 in) (A0) Q1444A (EAJ)

914 mm (36 in) C6036A (EAJ)

914 mm (36 in) C1861A (LN)

91.4 m (300 ft) 914 mm (36 in) C6810A

HP Heavyweight Coated Paper 131 30.5 m (100 ft) 610 mm (24 in) C6029C

914 mm (36 in) C6030C

1066 mm (42 in) C6569C

68.5 m (225 ft) 1066 mm (42 in) Q1956A (ELN)

HP Coated Paper 90 45.7 m (150 ft) 420 mm (16.54 in) (A2) Q1443A (J)

594 mm (23.4 in) (A1) Q1442A (AEJ)

610 mm (24 in) C6019B

841 mm (33.11 in) (A0) Q1441A (EJ)

914 mm (36 in) C6020B

1066 mm (42 in) C6567B

91.4 m (300 ft) 914 mm (36 in) C6980A

HP Universal Coated Paper 90 45.7 m (150 ft) 610 mm (24 in) Q1404B

914 mm (36 in) Q1405B

1066 mm (42 in) Q1406B

HP Universal Heavyweight Coated 
Paper

131 30.5 m (100 ft) 610 mm (24 in) Q1412B

914 mm (36 in) Q1413B

1066 mm (42 in) Q1414B

HP Film (Technical and Graphic)

HP Clear Film 174 22.9 m (75 ft) 610 mm (24 in) C3876A

914 mm (36 in) C3875A

HP Matte Film 160 38.1 m (125 ft) 610 mm (24 in) 51642A

914 mm (36 in) 51642B

HP Photographic Paper
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Table 13-3 Roll paper (continued)

Paper type g/m2 Length Width Product number

HP Universal Instant-dry Gloss 
Photo Paper

200 30.5 m (100 ft) 610 mm (24 in) Q6574A

914 mm (36 in) Q6575A

1066 mm (42 in) Q6576A

61.0 m (200 ft) 1066 mm (42 in) Q8754A (ELN)

HP Universal Instant-dry Satin Photo 
Paper

200 30.5 m (100 ft) 610 mm (24 in) Q6579A

914 mm (36 in) Q6580A

1066 mm (42 in) Q6581A

61.0 m (200 ft) 1066 mm (42 in) Q8755A (AELN)

HP Everyday Instant-dry Gloss Photo 
Paper

235 30.5 m (100 ft) 610 mm (24 in) Q8916A

SD709A (2 Pack) (J)

914 mm (36 in) Q8917A

1066 mm (42 in) Q8918A

HP Everyday Instant-dry Satin Photo 
Paper

235 30.5 m (100 ft) 610 mm (24 in) Q8920A

914 mm (36 in) Q8921A

1066 mm (42 in) Q8922A

HP Premium Instant-dry Gloss Photo 
Paper

260 22.9 m (75 ft) 610 mm (24 in) Q7991A (AELN)

30.5 m (100 ft) 914 mm (36 in) Q7993A (AELN)

1066 mm (42 in) Q7995A (AELN)

HP Premium Instant-dry Satin Photo 
Paper

260 22.9 m (75 ft) 610 mm (24 in) Q7992A (AELN)

30.5 m (100 ft) 914 mm (36 in) Q7994A (AELN)

1066 mm (42 in) Q7996A

HP Premium Matte Photo Paper 210 30.5 m (100 ft) 610 mm (24 in) CG459B

914 mm (36 in) CG460B

HP Backlit Material

HP Premium Vivid Color Backlit Film 285 30.5 m (100 ft) 594 mm (23.4 in) (A1) Y3N93A (E)

914 mm (36 in) Q8747A (AELN)

1066 mm (42 in) Q8748A (AELN)

HP Self-Adhesive Material

HP Everyday Adhesive Matte 
Polypropylene

120

168 with 
liner

22.9 m (75 ft) 610 mm (24 in) C0F18A (AELN)

914 mm (36 in) C0F19A (AELN)

1066 mm (42 in) C0F20A (AELN)

HP Everyday Adhesive Gloss 
Polypropylene

140

190 with 
liner

22.9 m (75 ft) 914 mm (36 in) C0F28A (AELN)

1066 mm (42 in) C0F29A (AELN)
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Table 13-3 Roll paper (continued)

Paper type g/m2 Length Width Product number

HP Universal Adhesive Vinyl 160

300 with 
liner

20 m (65 ft) 610 mm (24 in) W4Y93A (ELN)

914 mm (36 in) C2T51A (2 Pack) (AELN)

1066 mm (42 in) C2T52A (2 Pack) (ELN)

HP Banner and Sign Material

HP Everyday Matte Polypropylene, 2 
Pack

120 30.5 m (100 ft) 610 mm (24 in) CH022A

914 mm (36 in) CH023A

1066 mm (42 in) CH025A

61.0 m (200 ft) 914 mm (36 in) CH024A

HP Premium Matte Polypropylene, 2 
Pack

140 22.9 m (75 ft) 914 mm (36 in) C2T53A (ELN)

1066 mm (42 in) C2T54A (ELN)

HP Durable Semi-gloss Display Film 265 15.2 m (50 ft) 914 mm (36 in) Q6620B (ELN)

HP Opaque Scrim 495 15.2 m (50 ft) 914 mm (36 in) Q1898C (AELN)

1066 mm (42 in) Q1899C (AELN)

HP Everyday Blockout Display Film 265 15.2 m (50 ft) 914 mm (36 in) Q6620B (ELN)

HP Durable Banner with DuPont 
Tyvek, 2 Pack

133 22.9 m (75 ft) 914 mm (36 in) C0F12A

1066 mm (42 in) C0F13A

HP Fine Art Material

HP Professional Matte Canvas 392 15.2 m (50 ft) 610 mm (24 in) E4J59C (AELN)

914 mm (36 in) E4J60B (AELN)

1066 mm (42 in) J3E86A (AELN)

1117 mm (44 in) J3E86A (AELN)

HP Artist Matte Canvas 390 15.2 m (50 ft) 610 mm (24 in) E4J54B

914 mm (36 in) E4J55B

1066 mm (42 in) E4J56B

1117 mm (44 in) E4J57A

HP Matte Litho-realistic Paper, 3-in 
Core

269 30.5 m (100 ft) 610 mm (24 in) K6B77A

914 mm (36 in) K6B78A

1117 mm (44 in) K6B80A
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Table 13-4 Other accessories

Name Product number

HP DesignJet 24-in Roll Feed Spindle CQ783A

HP DesignJet 44-inch Roll Feed Spindle Q6709B

HP DesignJet 3-in Core Adapter CN538A

HP SD Pro 44-in Scanner C6H50B

HP HD Pro 42-in Scanner G6H51B

HP USB 3.0 to Gigabit LAN Adapter N7P47AA

HP DesignJet 44-inch Take-up Reel 1QF38A

HP Gloss Enhancer Upgrade Kit 2QX55A

Introduction to the accessories
The following sections provide details for this topic.

Spindle
With extra spindles you can change rapidly from one paper type to another.

HP DesignJet 3-in Core Adapter
With this adapter you can use paper rolls with 3-inch cores, provided that the diameter of the roll is 
within printer specifications.

HP Gloss Enhancer Upgrade Kit (Z9+ only)
With this kit you can produce images with uniform gloss from highlights to shadows, and minimize 
bronzing on most photo papers (except matte-finish papers).

The Gloss Enhancer Upgrade Kit has been designed to be used with an HP DesignJet Z9+ series printer 
only.

HP DesignJet 44-inch Take-up Reel
This accessory is available for 44-inch printers only.

Disposal instructions
HP provides many free and convenient ways to recycle your used original HP ink supplies. Additionally, 
HP provides a free program for business customers to return signage printed using selected recyclable 
HP large-format papers.

For more information about these HP programs, see http://www.hp.com/recycle.

For your printer, the following items can be recycled by the HP supplies recycling program:

● HP 746 Series 300ml DesignJet Ink Cartridges

● HP 747 Series 300ml DesignJet Ink Cartridges

158 Chapter 13  Accessories - HP DesignJet Z6/Z9+

http://www.hp.com/recycle


● HP 747 Series DesignJet Printheads

● HP Gloss Enhancer Upgrade Kit

● HP recyclable large-format papers

HP recommends that you wear gloves when handling ink-system components.
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Troubleshooting paper issues14

The following sections provide details for this topic.

Paper cannot be loaded successfully
The following sections provide details for this topic.

● Ensure that no paper is already loaded.

● Ensure that the paper is far enough inside the printer: you should feel the printer grab the paper.

● Do not attempt to straighten the paper during the aligning process, unless instructed to do so by the 
front-panel display. The printer automatically attempts to straighten the paper.

● The paper may be crumpled, or warped, or may have irregular edges.

● It can be difficult to insert a particularly stiff paper from the upper roll. Try moving it to the lower roll.

General unsuccessful roll load issues
This topic explains the concepts involved in this subject.

● If the paper does not load, the leading edge of the paper may not be straight or clean and needs to 
be trimmed. Remove the initial 2 cm (1 in) from the roll and try again. This may be necessary even 
with a new roll of paper.

● Ensure the roll ends are tight against the spindle ends.

● Check that the spindle is correctly inserted.

● Check that the paper is correctly loaded on the spindle. See Load a roll onto the spindle on page 28.

● Check that all roll end plugs have been removed.

● Check that the paper is wound tightly on the roll.

● Do not touch the roll or paper at during the alignment process.

● When loading a roll, the roll cover must remain open until the front panel prompts you to close it.

● When loading the upper roll, avoid inserting the paper into the cut sheet slot.
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Unsuccessful roll load
If the paper has not been inserted straight, the printer attempts to straighten the roll.

If you would like to start the load process again, cancel the process on the front panel and rewind the roll 
from the end of the spindle until the edge is removed from the printer.

NOTE: If the roll has become loose around the core, the printer cannot load the paper.

Unsuccessful sheet load
This topic explains the concepts involved in this subject.

● Guide the sheet, especially thick papers, when the printer initially feeds the sheet.

● Ensure that the sheet is aligned with the reference line on the roll cover.

● Do not attempt to straighten the sheet during the loading process, unless instructed to by the 
front-panel display.

● Do not use hand-cut sheets, which may be of irregular shapes. Use only purchased sheets.

In case of any problem, follow the instructions given on the front-panel display.

If you would like to start the load process again, cancel the process on the front panel; the printer ejects 
the sheet.

Paper loading error messages
Here is a list of front-panel messages related to paper loading, with the suggested corrective action.

Table 14-1 Paper loading error messages

Front-panel message Suggested action

Paper incorrectly loaded The paper has not been loaded correctly. Remove the paper.

Paper loaded with too much skew During the paper load process the printer detected that the paper had too much 
skew. Follow the instructions on the front-panel display.

Paper loose around core The end of the roll has become loose around the core. Tighten the paper to the core 
or insert a new roll.
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Table 14-1 Paper loading error messages (continued)

Front-panel message Suggested action

Paper not detected During the paper load process the printer did not detect any paper. Ensure the 
paper is inserted fully and is not transparent.

Roll cover closed during paper load 
process

Do not close the roll cover until you are prompted to do so by the front panel.

Sheet too big During the load process the printer has detected that the sheet of paper is either 
too wide or too long to be loaded correctly. Follow the instructions on the front-
panel display.

Sheet too small During the load process the printer detected that the sheet of paper is too narrow 
or too short to be loaded in the printer. Follow the instructions on the front-panel 
display.

Upper roll load and paper is inserted 
through the single sheet path

Avoid inserting roll paper into the cut sheet slot.

Paper type is not in the driver, HP Utility, or front panel
The following sections provide details for this topic.

If your paper type does not appear in the list (in the driver, HP Utility, or front panel), you can select one of 
the paper types that does appear in the list, by referring to the table below. To use the table, you should 
first identity the following attributes of your paper type:

● Whether your paper requires a high or low carriage position. Most papers require a high carriage 
position. Only thin, cockle-free papers such as films or photo paper should use a low position. For 
those papers, a low carriage position may help to eliminate print defects such as grain or banding.

● The ink quantity supported by your paper. This depends mostly on the grammage, but also on 
the type of the coating. HP recommends choosing a starting point in the table, then adjusting it 
according to the results.

● Whether your paper is glossy, matte, or transparent.

NOTE: If your paper type is glossy, it is important to choose a glossy paper from the list, as matte 
black ink does not usually print well on glossy paper. If you are unsure whether your paper supports 
matte black ink, try selecting Super Heavyweight Coated Paper and Fine Art Pearl (more ink), and 
choose the one that gives the best result. If your paper is incompatible with matte black ink, you will 
find that the ink easily comes off the paper when touched.

Further notes

● For thin papers (< 90 g/m2) uncoated papers (for example, plain paper or bright white paper) select 
paper type Bond and Coated Paper > Plain Paper.

● For light coated papers (< 110 g/m2), select paper type Bond and Coated Paper > HP Coated Paper.

● For heavyweight coated papers (< 200 g/m2), select paper type Bond and Coated Paper > 
Heavyweight Coated Paper.

● For cockle-free very thick coated papers (> 200 g/m 2), select paper type Bond and Coated Paper > 
Super Heavyweight Coated Paper.
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Table 14-2 Paper selection table

Carriage position Ink quantity Paper finish

Matte finish (uses matte black) Glossy/satin/pearl finish (uses 
photo black)

High (specialty papers 
above 260 g/m², or fiber-
based paper of any 
grammage)

High Photo Matte Paper

Super Heavyweight Coated Paper

Fine Art Paper

Canvas

Fine Art Pearl (more ink) (Z9+ only)

Scrim Banner

Medium Heavyweight Coated Paper

Canvas (less ink)

Clear Film (transparent)

Fine Art Pearl (less ink) (Z9+ only)

Photo Baryte generic (Z9+ only)

Polypropylene

Adhesive Polypropylene Matte

Low Coated Paper

Plain Paper

Matte Film (transparent)

Low (thin, cockle-free 
papers below 260 g/m²)

High Backlit material Photo Gloss/Semi-Gloss/Satin 
Paper

Medium Photo Gloss/Semi-Gloss/Satin 
Paper (less ink)

NOTE: Some photo black ink may be used intentionally even on matte papers.

After printing, the paper has wrinkles or there is too much ink
This happens when too much ink is used. To use less ink, select a category with less ink from the table. 
Ensure that carriage position and paper finish remain the same.

After printing, there is banding or coalescence grain in dark, saturated colors 
such as yellowish or reddish browns

This happens when too much ink is used. To use less ink, select a category with less ink from the table. 
Ensure that carriage position and paper finish remain the same.

After printing, the paper shows carriage scratches
If the problem is caused by excessive wrinkles in the paper, see After printing, the paper has wrinkles or 
there is too much ink on page 163.

Otherwise, select a category with high carriage position. Ensure that ink quantity and paper finish 
remain the same.

After printing, colors are not saturated enough
This may happens when too little ink is used. To use more ink, select a category with more ink from the 
table. Ensure that carriage position and paper finish remain the same.
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Printer printed on the wrong paper type
If the printer prints your job before you were able to load your desired paper, you may have Use Printer 
Settings or Any selected for the Paper Type in the printer driver.

When either of these is selected, the printer will print immediately on whichever paper is loaded. Load 
your desired paper, see Paper handling on page 27, and select your paper type specifically in the driver.

● In the Windows driver dialog: select the Paper/Quality or Paper tab (depending on the driver version), 
then select your paper type from the Paper Type list.

● In the macOS Print dialog: select the Paper/Quality panel, then select your paper type from the 
Paper Type list.

NOTE: Use Printer Settings (Windows) or Any (macOS) is the driver default.

Automatic cut not available
Some paper types cannot be cut by the automatic cutter. When such a paper type is loaded and active, 
the printer cannot switch automatically to the other roll: the active roll must first be unloaded manually.

On hold for paper
Based on a set of conditions that you can set when sending a job, the printer will decide which of the 
loaded rolls of paper is more suitable to print the job. If there is no roll of paper available that meets all 
the conditions, the printer will put the job on hold for paper.

You can manually resume the job, forcing it to print on a paper other than the one originally specified, 
otherwise it will stay on hold. See Solve paper mismatch on page 89.

NOTE: When an uncuttable roll is active, every job sent to any other paper source is put on hold until 
you manually unload the uncuttable roll.

Which criteria are used to decide on which roll a job will be printed?
When a user sends a job, the desired paper type can be set in the driver.

The printer will print the job on a roll of paper of the chosen paper type that is large enough to print the 
drawing without clipping. If there is more than one roll on which the job could be printed meeting all the 
criteria, the roll will be chosen according to your preferences. These can be set from the front panel: see 
Roll policies on page 89.

When is a job put on hold for paper?
If the paper mismatch action is set to put job on hold (see Solve paper mismatch on page 89), a job is put 
on hold for paper in the following cases:

● The paper type that has been selected by the user is not currently loaded on the specified roll—or on 
either of the rolls, if no roll has been specified.

● The paper type that has been selected by the user is loaded on the specified roll, but the drawing is 
too large to fit on the roll—or on either of the rolls, if no roll has been specified.
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If I load a new roll of paper, will jobs that were on hold for paper be automatically 
printed?

Yes. Every time a new roll of paper is loaded, the printer will check if there are any jobs on hold for paper 
that could be printed on the loaded roll.

I don’t like jobs being put on hold for paper. Can I prevent it?
Yes, this can be done from the front panel.

See Solve paper mismatch on page 89.

My job is exactly as wide as the roll of paper that is loaded on the printer, but is put 
on hold for paper

This topic explains the concepts involved in this subject.

Margins are managed in different ways depending on the file type:

● For HP-GL/2 and HP RTL files, by default, margins are included inside the drawing, so a 914 mm (36 in) 
HP-GL/2 and HP RTL file can be printed on a 914 mm (36 in) roll of paper and will not be put on hold for 
paper.

● For other file formats, such as PostScript, PDF, TIFF, or JPEG, the printer assumes that margins need 
to be added outside the drawing (as, in many cases, these formats are used for photographs and 
other images that do not include margins). This means that, to print a 914 mm (36 in) TIFF, the printer 
needs to add margins, and the drawing needs 925 mm (36.4 in) of paper to be printed; this would 
cause the job to be put on hold if the paper that is loaded on the printer is only 914 mm (36 in) wide.

If you wish to print these file formats without adding extra margins outside of the drawing, the Clip 
contents by margins option can be used. This option will force the margins to be set inside of the 
drawing, so a 914 mm (36 in) TIFF can be printed on a 914 mm (36 in) roll of paper without being put 
on hold. However, if there is no white space already included in the drawing’s borders, some contents 
could be clipped because of the margins.

Roll paper will not advance
If you have pushed the printer up against a wall, the roll may be touching the wall at the rear of the 
printer.

Increase the space between the printer and the wall, or use the wall spacers to ensure a minimum 
distance between printer and wall. See Wall spacers (some models only) on page 9.

Paper has jammed
When a paper jam occurs, you normally see the Possible paper jam message in the front-panel display.
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1. Turn off the printer at the front panel.

2. Open the window.

3. Try to move the printhead carriage out of the way.

4. Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.

CAUTION: Do not move the paper sideways, as it could damage the printer.
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5. Rewind the roll.

6. If the paper is stuck and cannot be rewound further, cut it from the roll.

7. Remove all pieces of paper from the rear of the printer.
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8. Close the window.

9. Turn on the printer.

10. Reload the roll, or load a new sheet see .

NOTE: If you find that there is still some paper causing an obstruction within the printer, restart the 
procedure and carefully remove all pieces of paper.

Strip stays on the output tray and generates jams
If a small piece of paper (200 mm or smaller) has been cut, such as before (if new roll) and after a 
full-bleed print or after the front-panel option Form feed and cut has been used, the cut strip remains in 
the output tray. Only when the printer is not printing, reach into the tray and remove the strip.
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Strip stays in the output area and cutter rail area and generates 
jams (Z6dr and Z9+dr only)

The following steps provide the complete procedure for this topic.

1. Turn off the printer.

2. Open the printer window and vertical trimmer window, and remove the strips of paper.

Printer displays out of paper when paper is available
If the roll has become loose from its core, it will not feed correctly and the printer will not load the paper. 
If possible, tighten the paper to its core or load a new roll.

Prints do not fall neatly into the basket
This topic explains the concepts involved in this subject.

● Ensure that the basket is correctly installed.

● Ensure that the basket is open.

● Ensure that the basket is not full.

● Paper often tends to curl near the end of a roll, which can cause output problems. Load a new roll, or 
remove prints manually as they are completed.

Sheet stays in the printer when the print has been completed
The printer holds the paper to allow the print to dry after printing.

See Change the drying time on page 43. If the paper is only partially ejected after the drying time, gently 
pull the sheet out of the printer. If the automatic cutter is disabled, use the Form feed and cut option in 
the front panel, see Feed and cut the paper on page 42.

Paper is cut when the print has been completed
By default the printer cuts the paper after the drying time has been completed.

See Change the drying time on page 43. You can disable the cutter, see Turn the automatic horizontal 
cutter on and off on page 44.

Horizontal cutter does not cut well
By default, the printer is set to cut the paper automatically after the drying time has been completed. 
If the cutter is turned on but not cutting correctly, check that the cutter rail is clean and clear of any 
obstacles.

Strip stays in the output area and cutter rail area and generates jams (Z6dr and Z9+dr only) 169



If the cutter is turned off, Form feed and cut only advances the paper. Use it to move the print far enough 
out of the front of the printer, until it is convenient to cut manually with a straight edge or scissors.

NOTE: The horizontal cutter is a Customer Self-Repair part. If the blade has had too much use, you 
can order a replacement. Contact HP Support for more information: see Contact HP Support on page 
209.

Vertical trimmer does not cut (Z6dr and Z9+dr only)
If the vertical trimmer is turned on but not cutting, try these suggestions:

1. Turn off the printer at the front panel.

2. If there is a jam, open the vertical trimmer window and remove the pieces of paper from the platen.

3. If necessary, you can remove the modules from the bar and check that they are clean. To remove a 
module, pinch the latch and slide it out.
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4. Remove any dust and pieces of paper from the modules with a small brush.

5. To put a module back in place, pinch the latch and insert it into the cutter support.

NOTE: There is only one way to insert the modules.

NOTE: The cut-away blue part connects to the black plastic support in only one way.
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6. Confirm that the modules are positioned correctly, then close the window.

7. Turn on the printer

The vertical trimmer is a Customer Self-Repair part. If the blade has had too much use, you can order a 
replacement. Contact HP Support for more information: see Contact HP Support on page 209.

Vertical trimmer does not cut accurately (Z6dr and Z9+dr only)
If the vertical trimmer does not cut the right and left edges of the paper accurately, you may need to 
calibrate the cutter.

To check the status of the vertical trimmer modules, go to the front panel, tap , then Output 

options, then click the vertical trimmer card. The global status of the cutter and modules is displayed. If 
the status is Calibration pending, you should recalibrate the cutters.

Automatic calibration
The following steps provide the complete procedure for this topic.

1. From the front panel, tap , then Output options , then click the vertical trimmer card; 

tap , and then Calibrate automatically.

2. The printer automatically recalibrates the vertical trimmer modules, advances the paper, and cuts 
the paper several times. Follow the instructions on the front panel. The printer may prompt you to 
remove the paper from the platen.

WARNING! Do not insert your hands inside the print and cutting area.
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If you are satisfied with the calibration, you can reprint your print.

Manual calibration
If you would like to fine-tune the calibration of the modules, you can calibrate the left and right modules 
manually.

1. From the front panel, tap , then Output options , then click the vertical trimmer card; 

tap , and then Adjust trimmer modules manually.

2. Use the buttons to move the left and right modules.

3. If you are satisfied with the recalibration, tap  to return to the home page, and reprint your job.

If you are not satisfied with the manual calibration, tap  at the top of the window, then Restore 
values. Returning to the default calibration sets all the corrections made by the manual calibration 
to zero.

Vertical trimmer: printer reports missing modules (Z6dr and 
Z9+dr only)

If the printer reports that there are missing modules, try the following steps.

1. At the front panel, tap , then Output options, then on the Vertical trimmer card tap Replace.

2. When prompted by the front panel, open the vertical trimmer window.

WARNING! Do not insert your hands into the carriage.
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3. To put a module back in place, pinch the latch and insert it into the cutter support.

NOTE: There is only one way to insert the modules.

NOTE: The cut-away blue part connects to the black plastic support in only one way.
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4. Make sure the modules are correctly attached to the bar.

5. Close the vertical trimmer window.

Vertical trimmer leaves marks on waste paper
In early use, the vertical trimmer may leave small marks on the pieces of paper that are cut off (to be 
discarded). This is not a malfunction, but it is something that you may happen to notice.

Roll is loose on the spindle
The roll may need to be replaced or reloaded.

Ensure that you are using the right core, and use the HP DesignJet 3-in Core Adapter when needed.

Recalibrate the paper advance
Accurate paper advance is important to print quality because it is part of controlling the proper 
placement of dots on the paper. If the paper is not advanced the proper distance between printhead 
passes, light or dark bands appear in the print and image grain may increase.

The printer is calibrated to advance correctly with all the papers appearing in the front panel. When you 
select the type of loaded paper, the printer adjusts the rate at which to advance the paper while printing. 
However, if you are not satisfied with the default calibration of your paper, you may need to recalibrate 
the rate at which the paper advances. See Troubleshooting print-quality issues on page 178 for steps to 
determine if paper advance calibration will solve your issue.

You can check the paper advance calibration status of the currently loaded paper from the front panel 

at any time by tapping , then , then Calibration status. The status may be one of the following:

● DEFAULT: This status appears when loading any paper that has not been calibrated. HP papers in 
the Front Panel have been optimized by default and unless you experience image quality problems 
in your printed image such as banding or graininess it is not recommended to recalibrate the paper 
advance.

● OK: This status indicates that the loaded paper has been calibrated before. However you may need 
to repeat the calibration if you experience print-quality problems such as banding or graininess in 
your printed image.

NOTE: Whenever you update the printer’s firmware, the paper advance calibration values are 
reset to factory default, see Update the firmware on page 150.

Recalibrating the paper advance procedure
The following steps provide the complete procedure for this topic.

CAUTION: If you are using a transparent paper or film, go directly to step 3 of this procedure.

1. From the front panel, tap , then Paper advance calibration > Paper advance calibration. 

The printer automatically recalibrates the paper advance and prints a paper advance calibration 
image.
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2. Wait until the front panel displays the status page, and reprint your print.

NOTE: The recalibration procedure takes approximately three minutes. Do not worry about the 
paper advance calibration image. The front-panel display shows any errors in the process.

If you are satisfied with your print continue using this calibration for your paper type. If you see 
improvement in your print, continue with step three. If you are dissatisfied with the recalibration, 
return to the default calibration, see Return to default calibration on page 177.

3. If you would like to fine-tune the calibration or are using a transparent paper, tap , then Paper 

advance calibration > Adjust paper advance.

4. Select the percentage of change from –100% to +100%. To correct light banding, decrease the 
percentage.

To correct dark banding, increase the percentage.

5. Tap  on the front panel to return to the all-apps page.
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Return to default calibration
The following steps provide the complete procedure for this topic.

Returning to the default calibration sets all the corrections made by the paper advance calibration to 
zero. To return to the default paper advance calibration value, you must reset the calibration.

1. From the front panel, tap , then , then Reset calibration.

2. Wait until the front panel displays the operation has completed successfully.
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Troubleshooting print-quality issues15

The following sections provide details for this topic.

General advice
This topic explains the concepts involved in this subject.

When you have any print-quality problem:

● To achieve the best performance from your printer, use only genuine manufacturer's supplies and 
accessories, whose reliability and performance have been thoroughly tested to give trouble-free 
performance and best-quality prints. For details of recommended papers, see .

● Make sure that the paper type selected in the front panel is the same as the paper type loaded into 
the printer (see ). At the same time, check that the paper type has been calibrated. Also make sure 
that the paper type selected in your software is the same as the paper type loaded into the printer.

CAUTION: If you have the wrong paper type selected, you could experience poor print quality and 
incorrect colors, and perhaps even damage to the printheads.

● Check that you are using the most appropriate print-quality settings for your purposes (see ). You 
are likely to see lower print quality if you have moved the print-quality slider to the 'Speed' end of the 
scale, or set the custom quality level to Fast.

● Check that your environmental conditions (temperature, humidity) are in the recommended range. 
See .

● Check that your ink cartridges and printheads have not passed their expiration dates: see .

Horizontal lines across the image (banding)
The following steps provide the complete procedure for this topic.

If your printed image suffers from added horizontal lines as shown (the color may vary):
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1. Check that the paper type you have loaded corresponds to the paper type selected in the front 
panel and in your software. See .

2. Check that you are using appropriate print-quality settings for your purposes (see ). In some 
cases, you can overcome a print-quality problem merely by selecting a higher print-quality level. For 
instance, if you have set the Print Quality slider to Speed, try setting it to Quality. If you change the 
print-quality settings, you may wish to reprint your job at this point in case the problem has been 
solved.

3. Print the Image Diagnostics Print and follow the instructions in , including printhead cleaning if 
recommended.

4. If the printheads are working correctly, go to the front panel and tap , then Paper advance 

calibration. Choose the paper source and then Paper advance calibration. See .

If the problem persists despite all the above actions, contact HP Support: see .

Banding appears as irregular watermarks
If banding appears as irregular watermarks, change to a higher-quality print mode or try reseating the 
printheads.

See .

Whole image is blurry or grainy
The following steps provide the complete procedure for this topic.
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1. Check that the paper type you have loaded corresponds to the paper type selected in the front 
panel and in your software. See .

2. Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings (see ). In some cases, you can overcome 
a print-quality problem merely by selecting a higher print-quality level. For instance, if you have set 
the Print Quality slider to Speed, try setting it to Quality. If you change the print-quality settings, you 
may wish to reprint your job at this point in case the problem has been solved.

4. Realign the printheads. See . After alignment, you may wish to reprint your job in case the problem 
has been solved.

5. Clean the printhead drop detector. See .

6. Go to the front panel and tap , then Paper advance calibration. Choose the paper source 

and then Paper advance calibration. See .

If the problem persists despite all the above actions, contact HP Support: see .

Paper is not flat
The following steps provide the complete procedure for this topic.

If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely to 
see defects in the printed image, such as vertical stripes. This can happen when you use thin paper that 
becomes saturated with ink.
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1. Check that the paper type you have loaded corresponds to the paper type selected in the front 
panel and in your software. See .

2. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper or HP Super 
Heavyweight Plus Matte Paper.

3. Select a paper type that is slightly thinner than the paper you have loaded; this will cause the 
printer to use less ink. Here are some example paper types in ascending order of thickness: Plain 
Paper, Coated Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

Print is scuffed or scratched
The black ink pigment can be scuffed or scratched when touched by a finger, a pen or some other 
object. This is particularly noticeable on coated paper.

Glossy paper may be extremely sensitive to the basket or to anything else that it contacts soon after 
printing, depending on the amount of ink used and the environmental conditions at the time of printing.

To reduce the risk of scuffs and scratches:

● Handle prints carefully.

● Avoid stacking prints on top of each other.

● Catch your prints as they are cut from the roll and do not let them fall into the basket. Alternatively, 
leave a sheet of paper in the basket so that freshly printed sheets do not make direct contact with 
the basket.

● Try loading the paper in sensitive-paper mode: see .
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● If you have a Z9+ (single roll) and are trying to load a sheet, try loading the paper using the input tray 
at the rear of the printer: see .

Ink marks on the paper
This problem can occur for several different reasons.

Horizontal smears on the front of coated paper
The following steps provide the complete procedure for this topic.

If a lot of ink is used on plain or coated paper, the paper absorbs the ink quickly and expands. As the 
printheads move over the paper, the printheads may come into contact with the paper and smear the 
printed image. This problem is normally seen only on cut sheets of paper (not on roll paper).

Whenever you notice this problem, cancel the printing job immediately. Soaked paper can damage the 
printheads.

Try the following suggestions to avoid this problem:

1. Check that the paper type you have loaded corresponds to the paper type selected in the front 
panel and in your software. See .

2. Use a recommended paper type (see ) and the correct print settings.

3. If using sheet paper, try rotating the sheet 90 degrees. The orientation of the paper fibers may 
affect performance.

4. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper and HP Super 
Heavyweight Plus Matte Paper.

5. Select a paper type that is slightly thinner than the paper you have loaded; this will cause the 
printer to use less ink. Here are some example paper types in ascending order of thickness: Plain 
Paper, Coated Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

6. Try to increase the margins by relocating the image to the center of the page using your software 
application.

7. If you have a Z9+ and you are printing on any kind of photographic paper, try loading the paper as 
Photo Baryte, which increases the distance between the printhead and the paper.

Ink marks on the back of the paper
Clean the platen with a soft cloth. Clean each rib separately without touching the foam between the ribs.
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Black ink comes off when you touch the print
This problem may be caused by printing with matte black ink on glossy paper. The printer will not use 
matte black ink if it knows that the paper will not retain it. To be sure of avoiding matte black ink, you can 
select any paper type from the Photo Paper category.

Edges of objects are stepped or not sharp
The following steps provide the complete procedure for this topic.

1. If edges of objects or lines appear to be poorly defined or lighter in density, and you have already 
set the print-quality slider to Quality in the driver dialog, select the custom print-quality options, and 
try setting the quality level to Normal. See .

2. Alternatively, set print quality to Custom options, then Settings: Best and check the More passes 
box. This will cause unidirectional printing, which reduces the severity of the problem.

3. The issue may be related to orientation. Try rotating the image: you may find that the result looks 
better.

Edges of objects are darker than expected
The following steps provide the complete procedure for this topic.

1. If edges of objects seem darker than expected, and you have already set the print-quality slider to 
Quality in the driver dialog, select the custom print-quality options, and try setting the quality level 
to Normal. See .

2. Alternatively, set print quality to Custom options, then Settings: Best and check the More passes 
box. This will cause unidirectional printing, which reduces the severity of the problem.

3. The issue may be related to orientation. Try rotating the image: you may find that the result looks 
better.
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Horizontal lines at the end of a cut sheet print
The following steps provide the complete procedure for this topic.

This type of defect affects only the end of a print, within approximately 30 mm of the trailing edge of the 
paper. You may see some very thin horizontal lines across the print.

To avoid this problem:

1. Consider using larger margins around your image.

2. Print the Image Diagnostics Print. See .

3. Consider printing with roll paper.

Vertical lines of different colors
The following steps provide the complete procedure for this topic.

If your print has vertical bands of different colors along it:

1. Try using thicker paper, choosing from the recommended paper types such as HP Heavyweight 
Coated Paper and HP Super Heavyweight Paper. See .

2. Try using higher print-quality settings (see ). For instance, if you have set the Print Quality slider to 
Speed, try setting it to Quality.

3. Alternatively, set print quality to Custom options, then Settings: Best and check the More passes 
box. This will cause unidirectional printing, which reduces the severity of the problem.

White spots on the print
The following steps provide the complete procedure for this topic.

You may notice white spots on the print. This is probably due to paper fibers, dust or loose coating 
material. To avoid this problem:

1. Try cleaning the paper manually with a brush before printing, to remove any loose fibers or 
particles.

2. Always keep the cover of your printer closed.

3. Avoid actions that may introduce dust into the printer, such as handling or cutting paper on the 
printer cover.

4. Protect your paper rolls and sheets by storing them in bags or boxes.

Colors are inaccurate
If the colors of your print do not match your expectations, try the following.
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1. Check that the paper type you have loaded corresponds to the paper type selected in the front 
panel and in your software. See .

2. Tap , then , then Calibration Status to check the color calibration status. If the status is 

PENDING or OBSOLETE, you should perform color calibration: see . If you have made any changes, 
you may wish to reprint your job in case the problem has been solved.

3. Check that the source color space of the source is correctly tagged. The most common color 

spaces are sRGB and AdobeRGB. If no color space is defined, then the one specified under 

> Default printing configuration > Color options will be applied.

NOTE: The AdobeRGB space covers more colors than sRGB. For that reason, some bright colors 
may be achievable only if the image is tagged as AdobeRGB.

4. Check that the settings under  > Default printing configuration > Color options are correct. 

In particular, test the default configuration, which is: Rendering intent = Perceptual, Black point 
compensation = On, and HP Pantone emulation = On (unless other settings are desired).

5. Check that you are printing on the correct side of the paper.

6. Check that you are using appropriate print-quality settings (see ). If you have selected the Speed or 
Fast options, you may not get the most accurate colors. If you change the print-quality settings, you 
may wish to reprint your job at this point in case the problem has been solved.

7. If you are using Application Color Management, check that the color profile you are using 
corresponds to the selected paper type and print-quality settings. If you have doubts about which 
color settings to use, see .

8. If a grayscale image shows a color cast in some of the gray shadows, select Color > Grayscale in 
the driver.

9. If the problem consists of color differences between your print and your monitor, try calibrating 
your monitor. At this point, you may wish to reprint your job in case the problem has been solved.

10. Print the Image Diagnostics Print. See .

If the problem persists despite all the above actions, contact HP Support: see .
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My print does not have gloss uniformity (Z9+ only)
The following steps provide the complete procedure for this topic.

1. Check that you have installed the HP Gloss Enhancer Upgrade Kit (see ).

2. Check that you are using a paper that permits gloss enhancer.

3. At the front panel, tap , then Default printing configuration > Gloss enhancer, and check that 

the setting is On.

NOTE: This setting is available only if you have installed the HP Gloss Enhancer Upgrade Kit.

4. If you are using the printer driver, check that you enabled the setting in the driver before printing.

Image is incomplete (clipped at the bottom)
This topic explains the concepts involved in this subject.

● Did you tap  before all the data were received by the printer? If so, you have ended the data 

transmission and will have to print the page again.

● If a large image is clipped (A1 or larger), go to the Advanced properties in the driver, then set Max 
application resolution to 300.

● The I/O timeout  setting may be too short. This setting determines how long the printer waits for 
the computer to send more data, before deciding that the job is finished. From the front panel, 

increase the I/O timeout  setting to a longer period and then send the print again. Tap , then 

Connectivity > Network > I/O timeout.

● There may be a communications problem between your computer and the printer. Check your USB 
or network cable.

● Check to make sure that your software settings are correct for your current page size (for example, 
long-axis prints).

● If you are using network software, make sure it has not timed out.

Image is clipped
Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and 
the printable area as understood by your software.

You can often identify this kind of problem before printing by previewing your print (see ).

● Check the actual printable area for the paper size you have loaded.

printable area = paper size - margins
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● Check what your software understands to be the printable area (which it may call "printing area" or 
"imageable area"). For example, some software applications assume standard printable areas that 
are larger than those used in this printer.

● If you have defined a custom page size with very narrow margins, the printer may impose its own 
minimal margins, clipping your image slightly. You may want to consider using a larger paper size.

● If your image contains its own margins, you may be able to print it successfully by using the Clip 
Contents by Margins option (see ).

● If you are trying to print a very long image on a roll, check that your software is capable of printing an 
image of that size.

● If you try to print an image larger than your software can handle, the bottom of the image may be 
clipped. To print the whole image, try these suggestions:

– Save the file in another format, such as TIFF or EPS, and open it with another application.

– Use a RIP to print the file.

● You may have asked to rotate the page from portrait to landscape on a paper size that is not wide 
enough.

● If necessary, reduce the size of the image or document in your software application, so it fits 
between the margins.

Some objects are missing from the printed image
This topic explains the concepts involved in this subject.

Large quantities of data may be necessary to print a high-quality large-format print job, and in some 
specific workflows there may be issues that can lead to some objects missing from the output. Here are 
some suggestions to help you to avoid this problem:

● Select a smaller page size and scale to the desired final page size in the driver or in the front panel.

● Save the file in another format, such as TIFF or EPS, and open it with another application.

● Use HP Click software to print the file.

● Use a RIP to print the file.

● Try printing from a USB flash drive.

● Reduce the resolution of bitmap images in your application software.

● Select a lower print quality in order to reduce the resolution of the printed image.

NOTE: If you are working under macOS, not all of these options are available.

These options are suggested for troubleshooting purposes and may adversely affect the final output 
quality or the time necessary to generate the print job. Therefore, they should be canceled if they do not 
help to solve the problem.
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Lines are too thick, too thin or missing
The following steps provide the complete procedure for this topic.

1. Check that the paper type you have loaded corresponds to the paper type selected in the front 
panel and in your software. See .

2. If the resolution of your image is greater than the printing resolution, you may notice a loss of 
line quality. If you are using the PCL3GUI driver for Windows, you can find the Max. application 
resolution option in the driver dialog's Advanced tab, under Document options > Printer features. If 
you change this option, you may wish to reprint your job at this point in case the problem has been 
solved.

3. If lines are too thin or missing, print the Image Diagnostics Print. See .

4. If the problem remains, go to the front panel and tap , then , then Printhead alignment to 

align the printheads. See . After alignment, you may wish to reprint your job in case the problem has 
been solved.

5. Go to the front panel and tap , then , then perform paper advance calibration: see .

6. Check that you are using appropriate print-quality settings for your purposes (see ). Select the 
custom print-quality options in the driver dialog, and try turning on the Maximum detail option (if 
available). You may wish to reprint your job at this point in case the problem has been solved.

If the problem persists despite all the above actions, contact HP Support: see .

Lines appear stepped or jagged
The following steps provide the complete procedure for this topic.

If lines in your image appear stepped or jagged when printed:
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1. The problem may be inherent in the image. Try to improve the image with the application you are 
using to edit it.

2. Check that you are using appropriate print-quality settings. See .

3. Select the custom print-quality options in the driver dialog, and turn on the Maximum detail option 
(if available).

Lines print double or in the wrong colors
The following steps provide the complete procedure for this topic.

This problem can have various visible symptoms:

● Colored lines are printed double, in different colors.

● The borders of colored blocks are wrongly colored.

To correct this kind of problem:

1. Reseat the printheads by removing them and then reinserting them. See and .

2. Align the printheads. See .

Lines are discontinuous
The following steps provide the complete procedure for this topic.

If your lines are broken in the following way:
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1. Check that you are using appropriate print-quality settings. See .

2. Reseat the printheads by removing them and then reinserting them. See and .

3. Align the printheads. See .

Lines are blurred
Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy. Try the following:

1. Check that your environmental conditions (temperature, humidity) are suitable for high-quality 
printing. See .

2. Check that the paper type selected in the front panel is the same as the paper type you are using. 
See .

3. Select the custom print-quality options, then select Best and More passes (if available). See .

4. Try changing to a heavier paper type, such as HP Heavyweight Coated Paper or HP Super 
Heavyweight Plus Matte Paper.

5. Select a paper type that is slightly thinner than the paper you have loaded; this will cause the 
printer to use less ink. Here are some example paper types in ascending order of thickness: Plain 
Paper, Coated Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

6. If you are using glossy paper, try changing to a different type of glossy paper.

7. Align the printheads. See .

Line lengths are inaccurate
If you have measured your printed lines and find that the lengths are not sufficiently accurate for your 
purposes, you can try to improve line length accuracy in the following ways:
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1. Print on HP Matte Film, for which your printer's line length accuracy is specified. See .

Polyester film is about ten times more dimensionally stable than paper. However, using film that is 
thinner or thicker than HP Matte Film will reduce line length accuracy.

2. Set the Print Quality slider to Quality.

3. Maintain the room at a steady temperature between 10 and 30℃ (50 and 86℉).

4. Load the roll of film and let it rest for five minutes before printing.

5. If you are still not satisfied, try recalibrating the paper advance. See .

Image Diagnostics Print
The Image Diagnostics Print consists of patterns designed to highlight printhead reliability problems. It 
helps you to check the performance of the printheads that are currently installed in your printer, and 
whether any printhead suffers from clogging or other problems.

To print the Image Diagnostics Print:

1. Use the same paper type that you were using when you detected a problem.

2. Check that the selected paper type is the same as the paper type loaded into the printer. See .

3. At the printer's front panel, tap , then , then Print diagnostic image.

It takes about two minutes to print the Image Diagnostics Print.

The print is divided into two parts, both of which test printhead performance:

● Part 1 (top) consists of rectangles of pure colors, one for each printhead. This part represents the 
print quality that you will get from each color.

● Part 2 (bottom) consists of small dashes, one for each nozzle on each printhead. This part 
complements the first, and aims more specifically to detect how many faulty nozzles each printhead 
has.

Look carefully at the print. The names of the colors are shown above the rectangles and in the center of 
the patterns of dashes.

Figure 15-1 Z6 Image Diagnostics Print
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Figure 15-2 Z9+ Image Diagnostics Print

NOTE: If you use photographic paper, the matte black ink may come off when you touch the print.

First look at the upper part of the print (part 1). Each colored rectangle should be a uniform color without 
any horizontal lines across it.

Then look at the bottom part of the print (part 2). For each individual colored pattern, check that most of 
the dashes are present.

If you see horizontal lines in part 1 and also missing dashes in part 2 for the same color, the printhead 
responsible needs cleaning. However, if the rectangles look solid, do not worry about just a few missing 
dashes in part 2; these are acceptable because the printer can compensate for a few clogged nozzles.

Here is an example of a photo black printhead in a good state:

And here is an example of the same printhead in a bad state:
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Corrective action
The following steps provide the complete procedure for this topic.

1. Clean any faulty printheads (see ). If you are unsure of which printhead to clean, select Clean all. 
Then reprint the Image Diagnostics Print to see whether the problem has been solved.

2. If the problem remains, clean the printheads again, and reprint the Image Diagnostics Print to see 
whether the problem has been solved.

3. If the problem remains, consider cleaning your printheads manually (see ). You could also try 
reprinting your current print job, in case it now prints satisfactorily.

4. If the problem remains, try cleaning the printhead drop detector. The printer normally notifies you 
when this is necessary, but it may be worth trying even if the printer has not suggested it. See .

5. If the problem still remains, replace any persistently faulty printheads (see ), or contact HP Support 
(see ).

If you still have a problem
This topic explains the concepts involved in this subject.

If you still experience print-quality problems after applying the advice in this chapter, here are some 
further things that you can do:

● Try using a higher print-quality option. See .

● Check the driver you are using to print with. If it is a non-HP driver, consult the driver vendor 
about the problem. You could also try using the correct HP driver, if feasible. The latest 
HP drivers can be downloaded from http://www.hp.com/go/Z6/drivers (if you have a Z6) or 
http://www.hp.com/go/Z9/drivers (if you have a Z9+).

● If you are not sure which printhead to clean, select Clean all.

● If you are using a non-HP RIP, its settings may be incorrect. See the documentation that came with 
the RIP.

● Check that your printer's firmware is up to date. See .
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● Check that you have the right settings in your software application.

194 Chapter 15  Troubleshooting print-quality issues



Troubleshooting ink cartridge and 
printhead issues

16

The following sections provide details for this topic.

Cannot insert an ink cartridge
The following steps provide the complete procedure for this topic.

1. Check that you have the correct type of cartridge (model number).

2. Check that the colored label on the cartridge is the same color as the label on the slot.

3. Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label 
right-side up and readable.

CAUTION: Never clean inside the ink cartridge slots.

Ink cartridge status messages
This topic explains the concepts involved in this subject.

These are the possible ink cartridge status messages:

● OK: The cartridge is working normally, with no known problems.

● Missing: There is no cartridge present, or it is not correctly connected to the printer.

● Low: The ink level is low.

● Very low: The ink level is very low.

● Empty: The cartridge is empty.

● Reseat: You are recommended to remove the cartridge and then reinsert it.

● Replace: You are recommended to replace the cartridge with a new cartridge.

● Expired: It is past the cartridge's expiration date.

● Non-HP: The cartridge contains ink not made by HP.

● Wrong: The cartridge family or model is wrong, or it has been inserted wrongly.

● Altered: The cartridge has been altered (refilled).

Printer does not detect the gloss enhancer cartridge (Z9+ only)
Proceed as in .
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Cannot insert a printhead
The following steps provide the complete procedure for this topic.

1. Check that you have the correct type of printhead (model number).

2. Check that you have removed the two orange protective caps from the printhead.

3. Check that the printhead is correctly oriented (compare with the others).

4. Check that you have correctly closed and latched the printhead cover, see .

Front panel recommends reseating or replacing a printhead
The following steps provide the complete procedure for this topic.

1. From the front panel, turn the power off then on.

2. Check the front-panel display message, if it shows the ready message, the printer is ready to print. 
If the problem remains continue with the next step.

3. Remove the printhead, see .

4. Clean the electrical connections on the backside of the printhead with a lint free cloth. You can 
carefully use a mild rubbing alcohol if moisture is needed to remove residue. Do not use water.

CAUTION: This is a delicate process and may damage the printhead. Do not touch the nozzles on 
the bottom side of the printhead, especially not with any alcohol.

CAUTION: Do not leave the printhead outside the printer for a long time. If this is absolutely 
necessary, cover the printhead with the original orange caps, then store it in a horizontal position.

5. Reinsert the printhead into the same slot from which you removed it, see Insert a printhead on page 
145.

CAUTION: Do not move it to a different position in the carriage. Once a printhead is inserted into a 
specific slot, it is set up to work only with a specific combination of colors and cannot be moved to 
other slots.

6. Check the front-panel display message. If the problem remains, try a new printhead.
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Clean the printheads
As long as the printer is kept turned on, automatic cleaning is performed periodically.

This ensures there is fresh ink in the nozzles and prevents nozzle clogs, which ensures color accuracy. If 
you have not already done so, see before proceeding.

To clean the printheads, go to the front panel and tap , then Clean printheads. If you have gone 

through the Image Quality Diagnostic print process, you know which colors are failing. Select the pair 
of printheads which contain the failing colors. If you are not sure which colors to clean, you can also 
select to clean all printheads. Cleaning all printheads takes about nine minutes. Cleaning a single pair of 
printheads takes about six minutes.

NOTE: Cleaning all printheads uses more ink than cleaning a single pair.

If you have cleaned the printheads using the Clean printheads procedure from the front panel and are 
still experiencing print-quality problems, you can try cleaning the printhead nozzles manually using the 
following procedure.

CAUTION: This is a delicate process, which may damage the printhead. Do not touch the electrical 
connections on the rear of the printhead.

First remove the printhead (see ), then use a lint-free cloth to clean the bottom of the printhead until the 
residue is removed.

Clean the printhead drop detector
The following steps provide the complete procedure for this topic.

The printhead drop detector is a sensor that detects which nozzles on the printheads are not printing in 
order to substitute them for good printing nozzles. If particles, such as fibers, hair or paper pieces, block 
the sensor print-quality is affected.

When the front panel displays a warning message that the clean process is needed, you are 
recommended to clean the printhead drop detector. If you do not clean the printhead drop detector 
immediately, the printer continues working normally, however, the front panel display continues to show 
the warning.

CAUTION: Wear gloves to avoid getting ink on your hands.
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1. Turn off the printer at the front panel.

2. To avoid an electric shock, turn off the printer and unplug it.

3. Open the window.

4. Find the printhead drop detector beside the stored printhead carriage.

5. Remove any debris blocking the printhead drop detector.
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6. With a dry, lint-free cloth, wipe the surface of the drop detector to remove any non-visible debris.

7. Close the window.

8. Plug in and turn on the printer.

9. Power the printer on at the front panel.

Align the printheads
Precise alignment between printheads is essential for accurate colors, smooth color transitions and 
sharp edges in graphical elements. Your printer has an automatic printhead alignment process which 
runs whenever a printhead has been accessed or replaced.
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In cases where the paper has jammed or you are experiencing problems with color accuracy, see ; you 
may need to align the printheads.

NOTE: If the paper has jammed, it is recommended that you reinsert the printheads and initiate the 

realignment procedure by tapping , then Printhead alignment.

NOTE: Best results are obtained when printhead alignment is done on high-quality glossy paper.

CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

Reinsert printheads procedure
The following steps provide the complete procedure for this topic.

1. If the realignment process is running and the wrong paper is loaded, tap  on the front panel.

CAUTION: Do not print if the realignment process has been canceled. You can restart the 

alignment by tapping , then Printhead alignment.

2. Load the paper you wish to use, see . You can use a roll that is at least 610 mm (24 in) wide or a cut 
sheet that is A2 landscape or larger.

CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

3. Remove and re-insert all the printheads, see and . This starts the printhead alignment procedure.

4. Ensure the window is closed, as a strong light source near the printer during printhead realignment 
can affect alignment.

5. The process takes about six minutes. Wait until the front-panel display shows the process complete 
before using the printer.

NOTE: The printer prints a calibration image. Do not worry about the image. The front-panel 
display shows any errors in the process.

Image-quality maintenance menu procedure
The following steps provide the complete procedure for this topic.
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1. Load the paper you wish to use, see . You can use a roll or cut sheet, however, it must be A3 
landscape or larger (420 by 297 mm).

CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

2. From the front panel, tap , then Printhead alignment. The printer checks to see if it has 

enough paper to run the realignment.

3. If the loaded paper is satisfactory, the printer runs the realignment and prints a realignment 
pattern. Ensure the window is closed, as a strong light source near the printer during printhead 
realignment can affect alignment.

4. The process takes about five minutes. Wait until the front-panel display shows the process 
complete before using the printer.

Scanning errors during alignment
This topic explains the concepts involved in this subject.

If the alignment process fails, a Scanning problems message appears on the front panel. This means 
that the alignment has not completed successfully. Therefore the printer is not aligned and the 
alignment should be repeated in order to print with good print quality. The problem may have various 
causes:

● The paper used was not valid, repeat the alignment with valid paper.

● Printhead health problems, clean printheads, see .

● The alignment was done with the window open, repeat the alignment with the window closed.

If the problem persists after using valid paper, cleaning the printheads and keeping the window closed, 
there may be a failure in the scanning system needing repair; or the printheads, although clean, may not 
work and need to be replaced.

Printhead status messages
This topic explains the concepts involved in this subject.

These are the possible printhead status messages:

● OK: the printhead is working normally, with no known problems

● Missing: there is no printhead present, or it is not correctly installed in the printer.
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● Test printhead separately: you are recommended to test the printheads individually to find the failing 
printhead. Remove all the printheads and insert them alone one by one, closing the latch and the 
carriage cover after every insertion. The front-panel display indicates the failing one showing the 
reseat or replace message.

● Reseat: you are recommended to remove the printhead and then reinsert it. If that fails, clean the 
electrical connections, see . If that fails, replace the printhead with a new printhead, see and .

● Replace: the printhead is failing. Replace the printhead with a working printhead, see and .

● Replacement incomplete: a printhead replacement process has not completed successfully, re-
launch the replacement process and let it finish completely (it is not needed to change the 
printheads).

● Remove: the printhead is not a suitable type for use in printing.
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Troubleshooting general printer issues17

The following sections provide details for this topic.

Printer does not print
This topic explains the concepts involved in this subject.

If all is in order (paper loaded, all ink components installed and no file errors), there are still reasons why 
a file you have sent from your computer may not start printing when expected:

● You may have an electrical power problem. If there is no activity at all from the printer, and the front 
panel does not respond, check that the power cable is connected correctly and that there is power 
available at the socket. Press the power key for 5 seconds to reset the printer.

● You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic 
fields or severe electrical disturbances, which can cause the printer to behave strangely or even 
stop working. In this case, turn off the printer using the power key on the front panel and unplug the 
power cord, wait until the electromagnetic environment has returned to normal, then turn it on again. 
If you still experience problems, contact HP Support: see Contact HP Support on page 209.

● Nesting may be on, and the printer is waiting for the specified nest wait time before calculating the 
appropriate nests. In this case, the front panel shows the remaining time needed for nesting.

● You may have the wrong graphic language setting, see Change the graphic language setting on 
page 25.

● You may not have installed in your computer the correct driver for your printer, see the Assembly 
instructions.

● If you are printing on a sheet, you must specify Single sheet as the paper source in your printer 
driver.

● The printer may be holding the job for paper or accounting information, see Job status messages on 
page 93.

● You may have requested a print preview from your printer driver. This is a function you can use to 
check that the image is the one you want. In this case, the preview is displayed on your screen, and 
you must click the Print button to start printing.

Front panel fails to initialize
If the printer will not start (the front panel is blank or the diagnostic LEDs are all off), you are 
recommended to replace the firmware, in the following way:

1. Go to the HP Support Center (see HP Support Center on page 208) and download the firmware.

2. Save the firmware on a USB flash drive. Ideally, the USB flash drive should be empty and formatted 
with the FAT filesystem.

3. Ensure that the printer is turned off. Connect the USB flash drive to the Hi-Speed USB host port 
beside the front panel, then turn the printer on.

Troubleshooting general printer issues 203



4. The printer takes about a minute to read the firmware file, then asks you to remove the USB flash 
drive.

5. The printer automatically installs the new firmware and restarts.

Printer seems slow
This topic explains the concepts involved in this subject.

Here are some possible explanations:

● Did you set the print quality to Best or Maximum detail? Best-quality and maximum detail prints take 
longer.

● Did you specify the correct paper type when loading the paper? Some paper types require more 
time for printing; for example, photo and coated papers require more drying time between passes. To 
find out the printer's current paper type setting, see View information about the paper on page 39.

● If your printer is connected by network, check that all components used in the network (network 
interface cards, hubs, routers, switches, cables) are capable of high-speed operation. Is there a lot of 
traffic from other devices on the network?

● Did you specify Extended drying time in the front panel? Try changing the drying time to Optimal.

Communication failures between computer and printer
This topic explains the concepts involved in this subject.

Some symptoms are:

● The front-panel display does not show the Receiving message when you have sent an image to the 
printer.

● Your computer displays an error message when you are trying to print.

● Your computer or printer hangs (stays idle), while communication is taking place.

● Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)

To solve a communication problem:

● Ensure that you have selected the correct printer in your application, see .

● Ensure that the printer works correctly when printing from other applications.

● Remember that very large prints may take some time to receive, process and print.

● If your printer is connected to your computer through any other intermediate devices, such as 
switch boxes, buffer boxes, cable adapters, cable converters, and so on, try using it when connected 
directly to your computer.

● Try another interface cable.

● Ensure that the graphic language setting is correct, see Change the graphic language setting on 
page 25.
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● If the printer is connected by network, check that your printer has a static IP address. If it is using 
DHCP, the IP address may change every time it is turned on, in which case the driver may not be able 
to find it.

Cannot access the Embedded Web Server

From the front panel, tap , then Security > Embedded Web Server.

If you have not done so already, read .

If you are using a proxy server, try bypassing the server and accessing the Web server directly:

● In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN Settings, and 
check the Bypass proxy server for local addresses box. Alternatively, for more precise control, click 
the Advanced button and add the printer's IP address to the list of exceptions, for which the proxy 
server is not used.

● In Safari for macOS, go to Safari > Preferences > Advanced and click the Proxies: Change Settings 
button. Add the printer's IP address or its domain name to the list of exceptions, for which the proxy 
server is not used, in the Bypass proxy settings for these Hosts & Domains field.

If you still cannot connect, turn the printer off and back on with the power key on the front panel.

Cannot connect to the Internet
If your printer has difficulty in connecting to the Internet, it may start the Connectivity Wizard 
automatically.

The Connectivity Wizard performs a series of tests automatically.

If any test fails, the printer describes the problem and recommends how to solve it. You can modify 
settings and rerun the test, unless the settings are protected.

Web Services issues
For any issues with HP ePrint, see HP Connected.

http://www.hpconnected.com.

Automatic file system check
When you turn on the printer, you will occasionally see a front panel message: File system check.

A file system check is taking place; it can take up to 40 minutes. Please wait until it finishes.

CAUTION: If you turn the printer off before the file system check has finished, the file system could be 
seriously damaged, making the printer's hard disk unusable. In any case, the file system check will 
restart from the beginning whenever you turn the printer on again.

Cannot access the Embedded Web Server 205

http://www.hpconnected.com


A file system check is scheduled every 90 days, in order to maintain the hard disk's file system integrity.

NOTE: When the printer is powered back on, it takes about three minutes to initialize and check and 
prepare the printheads. However, it can take up to 40 under some conditions, for example, when the 
printer has not been used for a long period of time and requires more time to prepare the printheads.

Alerts
This topic explains the concepts involved in this subject.

Your printer can communicate two types of alerts:

● Errors: Mainly alerting you to the fact that the printer is unable to work normally. However, in the 
printer driver, errors can also alert you to conditions that could ruin the print, such as clipping, even 
if the printer is able to print.

● Warnings: Alert you when the printer needs attention either for an adjustment, such as a calibration 
or for a possible unprintable situation, such as a preventive maintenance or low ink.

There are four different alerts communicators within your printer's system:

● Front-panel display: The front panel shows only the most relevant alert at a time. In the case of a 
warning, it disappears after a timeout. There are permanent alerts, such as "ink cartridge low on 
ink", that reappear when the printer becomes idle and there is not another more severe alert.

TIP: From the front panel display you can configure paper mismatch alerts, see Solve paper 
mismatch on page 89.

● Embedded Web Server: The upper-right corner of the Embedded Web Server window shows the 
printer status. If there is an alert in the printer, the status shows the alert text.

● Driver: The driver warns about job configuration settings that may produce a problem in the final 
output. If the printer is not ready to print, it displays a warning.

● HP DesignJet Utility: To see alerts, go to the Overview tab and review the Items needing attention list 
on the right-hand side.

By default, alerts are displayed only when you are printing. If alerts are enabled and there is a 
problem that prevents a job from completing, you see a pop-up window, which explains the reason 
for the problem. Follow the instructions to achieve your required result.
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Front Panel Error Message - HP DesignJet 
Z6/Z9+ and T1700 Series

18

The following sections provide details for this topic.

Front-panel error messages
The printer may occasionally display a system error, consisting of a numerical code of 12 digits followed 
by the recommended action that you should take.

In most cases you will be asked to restart the printer, because when the printer starts it can diagnose 
the issue better and may be able to fix it automatically. If the problem persists after restarting, you 
should contact HP Support and be ready to give the numerical code from the error message. See .

If the error message contains some other recommended action, follow the printer’s instructions.

Using a USB flash drive
The following steps provide the complete procedure for this topic.

1. Take a standard USB flash drive, formatted as FAT32.

2. Create an empty file in the USB flash drive (right-click, New > Text Document), and name it 
pdipu_enable.log.

3. When an error message is displayed on the front panel, insert the USB flash drive into the Hi-Speed 
USB host port at the front of the printer. The log is automatically copied into the drive. You can 
remove the USB flash drive when prompted by the front panel.

4. Contact your support representative (see ) to share the file created in the USB flash drive.

Using the Embedded Web Server
The following steps provide the complete procedure for this topic.

1. In your Web browser, go to https://[printer IP address]/hp/device/support/serviceSupport.

2. Click the Download button to get the Diagnostic package.

3. Save the package in your computer and contact your support representative (see ).
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HP Customer Care19

The following sections provide details for this topic.

Introduction
HP Customer Care offers award-winning support to ensure you get the most from your HP DesignJet, 
providing comprehensive, proven support expertise and new technologies to give you unique end-to-end 
support.

Services include setup and installation, troubleshooting tools, warranty upgrades, repair and exchange 
services, phone and Web support, software updates and self-maintenance services. To find out more 
about HP Customer Care, see Contact HP Support on page 209.

To register your warranty, visit http://register.hp.com/.

HP Professional Services

HP Support Center
Enjoy a world of dedicated services and resources to ensure you always get the best performance from 
your HP DesignJet printers and solutions.

Join the HP community at the HP Support Center, your large-format printing community, for 24×7 access 
to:

● Multimedia tutorials

● Step-by-step how-to guides

● Downloads: the latest printer firmware, drivers, software, paper presets, etc.

● Technical support: online troubleshooting, customer care contacts and more

● Workflows and detailed advice for completing various printing tasks from particular software 
applications

● Forums for direct contact with the experts, both HP and your colleagues

● Warranty tracking online, for your peace of mind

● Latest product information: printers, supplies, accessories, software, etc.

● Supplies Center for all you need to know about ink and paper

The HP Support Center can be found at http://www.hp.com/go/Z6/support for Z6 printers, or 
http://www.hp.com/go/Z9/support for Z9+ printers.

By customizing your registration for the products you have purchased and your type of business, and by 
setting your communication preferences, you decide the information you need.
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Download printer software
Be sure to follow the software installation instructions.

Install the printer software from http://www.hp.com/go/Z6/drivers (if you have a Z6) or 
http://www.hp.com/go/Z9/drivers (if you have a Z9+).

HP Care Packs and Warranty Extensions
HP Care Packs and Warranty Extensions allow you to extend your printer's warranty beyond the 
standard period.

They include remote support. On-site service is also provided if necessary, with two alternative 
response-time options:

● Next business day

● Same business day, within four hours (may not be available in all countries)

There is an HP Installation service that unpacks, sets up, and connects the printer for you.

For more information on HP Care Packs, see http://cpc.ext.hp.com/portal/site/cpc.

Customer Self Repair
HP's Customer Self Repair program offers our customers the fastest service under either warranty or 
contract. It enables HP to ship replacement parts directly to you (the end user) so that you can replace 
them. Using this program, you can replace parts at your own convenience.

Convenient, easy to use

● An HP Support Specialist will diagnose and assess whether a replacement part is required to 
address a defective hardware component.

● Replacement parts are express-shipped; most in-stock parts are shipped the very same day you 
contact HP.

● Available for most HP products currently under warranty or contract.

● Available in most countries.

For more information about Customer Self Repair, see http://www.hp.com/go/selfrepair.

Contact HP Support
HP Support is available to you by telephone. What to do before you call:

● Review the troubleshooting suggestions in this document.

● Review the relevant driver documentation.

● If you have installed third-party software drivers and RIPs, see their documentation.

● If you call your support representative, please have the following information available to help us 
answer your questions more quickly:
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– The product you are using (the product number and the serial number, found on the label at the 
back of the product)

– If there is an error code on the front panel, note it down; see Front-panel error messages on 
page 207

– The computer you are using

– Any special equipment or software you are using (for example, spoolers, networks, switch-boxes, 
modems or special software drivers)

– The type of interface used on your product (USB or network)

– The software and driver name and version number that you are currently using

– The Printer Service information, which you can get from the Embedded Web Server. In a Web 
browser, enter the IP address of your printer to access the Embedded Web Server. Then click 
Support > Service support > Service information > Display. If you need to send the information 
by email, you can download it as a file from your browser, and later send the file.

NOTE: After you click Display, your browser may prevent the pop-up window from opening. In 
this case, you have to find the browser option that allows the window to open.

Alternatively, from your browser you can send the page directly: click File > Send > Page by 
email.

Telephone number
Your HP Support telephone number is available on the Web.

See http://welcome.hp.com/country/us/en/wwcontact_us.html.
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Printer specifications20

The following sections provide details for this topic.

Functional specifications
This topic provides a full set of reference information for this subject.

Table 20-1 HP ink supplies

- -

Printheads Universal printheads, which can be inserted into any of the available slots. Once 
initialized in a particular slot, they cannot be moved to another.

Ink cartridges Cartridges containing 300 ml of ink: matte black, photo black, cyan, magenta, yellow, 
chromatic red, chromatic green (Z9+ only), chromatic blue (Z9+ only), gray (Z9+ only), 
gloss enhancer (Z9+ only)

Table 20-2 Paper sizes

- Minimum Maximum

Roll width 279 mm (11 in) 610 mm (24 in) (24-in printer)

1118 mm (44 in) (44-in printer)

Roll length - 91 m (300 feet)

Roll diameter - 135 mm (5.3 in)

Roll weight - 11.9 kg (26.3 lb)

Sheet width 210 mm (8.26 in) 610 mm (24 in) (24-in printer)

1118 mm (44 in) (44-in printer)

Sheet length 279 mm (11 in) 1676 mm (66 in)

Paper thickness - 0.8 mm (31.5 mil)

Paper weight 80 g/m² 500 g/m²

Table 20-3 Printing resolutions

- Self-adhesive material, banner, backlit, 
glossy paper

Coated, bond, film, technical

Print quality Maximum 
detail

Rendering 
resolution (ppi)

Printing resolution 
(dpi)

Rendering 
resolution (ppi)

Printing resolution 
(dpi)

Best On

Off

1200 × 1200

600 × 600

2400 × 1200

1200 × 1200

600 × 600 1200 × 1200

Normal On/Off 600 × 600 1200 × 1200 600 × 600 1200 × 1200
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Table 20-3 Printing resolutions (continued)

- Self-adhesive material, banner, backlit, 
glossy paper

Coated, bond, film, technical

Print quality Maximum 
detail

Rendering 
resolution (ppi)

Printing resolution 
(dpi)

Rendering 
resolution (ppi)

Printing resolution 
(dpi)

Fast On/Off – – 600 × 600 1200 × 1200

Economode On/Off – – 300 × 300 600 × 1200

Table 20-4 Margins

Margins

Top, right and left margins 5 mm (0.2 in)

Bottom margin (trailing edge) 5 mm (0.2 in) (roll)

17 mm (0.67 in) (sheet)

Table 20-5 Mechanical Accuracy

Mechanical accuracy

±0.1% of the specified vector length or ±0.2 mm (whichever is greater) at 23°C (73°F), 50-60% relative humidity, on E/A0 printing 
material in Best or Normal mode with HP Matte Film roll feed.

Table 20-6 Graphic languages supported

HP DesignJet Languages

Z6 and Z9+ HP-PCL3GUI, HP-GL/2, CALS G4, TIFF, JPEG, Adobe PDF 1.7 ext. 3 and Adobe PostScript 3

Physical specifications
This topic provides a full set of reference information for this subject.

Table 20-7 Physical specifications

Z6 24-in Z6 44-in Z6dr 44-in Z9+ 24-in Z9+ 44-in Z9+dr 44-in

Weight 66 kg (145 lb) 86 kg (189 lb) 96 kg (211 lb) 72 kg (159 lb) 94 kg (207 lb) 98 kg (216 lb)

Width 1293 mm (50.9 in) 1802 mm (70.9 in) 1293 mm (50.9 in) 1802 mm (70.9 in)

Depth 695 mm (27.4 in)

Height 998 mm (39.3 in)

The depth is measured without the upper spindle; wall spacers up; ink cover opened; roll covers and 
basket closed.
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Memory specifications
This topic provides a full set of reference information for this subject.

Table 20-8 Memory specifications

Type Description

Virtual memory 128 GB

Hard disk 500 GB

Power specifications
This topic provides a full set of reference information for this subject.

Table 20-9 Power specifications

Type Description

Input voltage 100–240 V ac Approximately equal to (plus or minus) 10%, auto-
ranging

Frequency 50/60 Hz

Maximum current 2 A

Power 100 W

Ecological specifications
This product complies with the WEEE Directive 2012/19/EU and RoHS Directive 2011/65/EU.

To determine the ENERGY STAR and EPEAT registration status of your product model, see 
http://www.hp.com/go/ecolabels.

Environmental specifications
This topic provides a full set of reference information for this subject.

Table 20-10 Environmental specifications

Type Value

Operating temperature 5 to 40 degree Celsius (41 to 104 degree Fahrenheit)

Recommended operating temperature 15 to 35 degree Celsius (59 to 95 degree Fahrenheit), 
depending on paper type

Storage temperature –25 to 55 degree Celsius (–13 to 131 degree Fahrenheit)

Recommended operating humidity 20 to 80% RH, depending on paper type

Storage humidity 0 to 95% RH
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Acoustic specifications
Printer acoustic specifications (declared according to ISO 9296).

Table 20-11 Acoustic specifications

Type Z6/Z9+ Z6dr/Z9+dr

Idle sound pressure 35 dB (A) 35 dB (A)

Idle sound power ≤ 5.3 B (A) ≤ 5.3 B (A)

Operating sound pressure 42 dB (A) 45 dB (A)

Operating sound power ≤ 6.0 B (A) ≤ 6.3 B (A)
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Glossary

 AirPrint  
A technology used by iPod, iPhone, iPad, and macOS that allows immediate printing to a printer on the 
same network without the need for a printer-specific driver.

AppleTalk  
A suite of protocols that Apple Computer developed in 1984 for computer networking. Apple now 
recommends TCP/IP and Bonjour networking instead. HP DesignJet products no longer support 
AppleTalk.

Bonjour  
Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a 
computer network technology used in Apple's macOS from version 10.2 onwards. It is used to discover 
services available on a local area network. It was originally known as Rendezvous.

Color accuracy  
The ability to print colors that match the original image as closely as possible, bearing in mind that 
all devices have a limited color gamut and may not be physically capable of matching certain colors 
precisely.

Color consistency  
The ability to print the same colors from a particular print job from print to print and from printer to 
printer.

Color model  
A system of representing colors by numbers, such as RGB or CMYK.

Color space  
A color model in which each color is represented by a specific set of numbers. Many different color 
spaces can use the same color model: for instance, monitors generally use the RGB color model, but 
they have different color spaces, because a particular set of RGB numbers results in different colors on 
different monitors.

Cutter  
A printer component that slides back and forth across the platen to cut the paper.

ESD  
ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the 
car door, or the cling of clothing. Although controlled static electricity has some useful applications, 
uncontrolled electrostatic discharges are one of the main hazards to electronic products. Therefore, to 
prevent damage some precautions are needed when setting up the printer, or handling ESD sensitive 
devices. This type of damage may reduce the life expectancy of the device. One way to minimize 
uncontrolled ESDs, and therefore reduce this type of damage is by touching any exposed grounded part 
of the printer (mainly metal parts) before handling ESD sensitive devices (such as the printheads or 
ink cartridges). Additionally, to reduce the generation of electrostatic charge in your body try to avoid 
working in a carpeted area, and keep your body movements to a minimum when handling ESD sensitive 
devices. Also, avoid working in low humidity environments.
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Ethernet  
A popular computer networking technology for local area networks.

Firmware  
Software that controls your printer's functionality and is stored semi-permanently in the printer (it can 
be updated).

Gamut  
The range of colors and density values reproducible on an output device, such as a printer or monitor.

Gigabit Ethernet  
An Ethernet network capable of transferring data at up to 1,000,000,000 bits/second. Gigabit Ethernet 
interfaces are capable of negotiating slower speeds when required for compatibility with older Ethernet 
devices.

HP RTL  
HP Raster Transfer Language: a language defined by HP to describe raster (bitmap) graphics.

HP-GL/2  
HP Graphics Language 2: a language defined by HP to describe vector graphics.

I/O  
Input/Output: this term describes the passing of data between one device and another.

ICC  
The International Color Consortium, a group of companies that have agreed on a common standard for 
color profiles.

Ink cartridge  
A removable printer component that stores ink of a particular color and provides it to the printhead.

IP address  
May mean an IPv4 address (most likely) or an IPv6 address.

IPSec  
A sophisticated mechanism for providing network security by authenticating and encrypting IP packets 
sent between nodes on a network. Each network node (computer or device) has an IPSec configuration. 
Applications are usually unaware whether IPSec is being used or not.

IPv4 address  
A unique identifier that identifies a particular node on an IPv4 network. An IPv4 address consists of four 
integers separated by full stops. Most networks in the world use IPv4 addresses.

IPv6 address  
A unique identifier that identifies a particular node on an IPv6 network. An IPv6 address consists of up 
to 8 groups of hexadecimal digits separated by colons. Each groups contains up to 4 hexadecimal digits. 
Only a few new networks in the world use IPv6 addresses.

Jetdirect  
HP's brand name for its series of print servers that allow a printer to be connected directly to a local 
area network.
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LED  
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

MAC address  
Media Access Control address: a unique identifier used to identify a particular device on a network. It 
is a lower-level identifier than the IP address. Thus, a device may have both a MAC address and an IP 
address.

Network  
A network is a set of connections that pass data between computers and devices. Every device is able 
to communicate with every other device in the same network. This allows data to be moved between 
computers and devices, and allows devices such as printers to be shared between many computers.

Nozzle  
One of many tiny holes in a printhead through which ink is deposited onto the paper.

Paper  
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind 
which are pulped, dried and pressed.

Platen  
The flat surface within the printer over which the paper passes while it is being printed on.

Printer driver  
Software that converts a print job in a generalized format into data suitable for a particular printer.

Printhead  
A removable printer component that takes ink of one or more colors from the corresponding ink 
cartridge(s) and deposits it on the paper, through a cluster of nozzles. In your printer, each printhead 
prints two different colors.

Spindle  
A rod that supports a roll of paper while it is being used for printing.

TCP/IP  
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is 
based.

USB  
Universal Serial Bus: a standard serial bus designed to connect devices to computers.

USB host port  
A rectangular USB socket such as those on found on computers. A printer can control USB devices that 
are connected to such a port. Your printer has two USB host ports, which it uses to control accessories 
and USB flash drives.

Vertical trimmer  
A printer component that cuts the paper in the direction of the paper advance (Y-axis). Used in 
HP DesignJets Z6dr and Z9+dr only.
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